
User Guide

HA260749U005

December 2014 (Issue 7)

LINtools
User Screen Editor



© 2014
All rights are strictly reserved.  No part of this document may be reproduced, modified, or transmitted in any 
form by any means, nor may it be stored in a retrieval system other than for the purpose to act as an aid in 
operating the equipment to which the document relates, without  prior written permission of the 
manufacturer.

The manufacturer pursues a policy of continuous development and product improvement.  The specifications 
in this document may therefore be changed without notice.  The information in this document is given in good 
faith, but is intended for guidance only.  The manufacturer will not accept responsibility for any losses arising 
from errors in this document.



USER SCREEN EDITOR HELP MANUAL 

USER SCREEN EDITOR HELP MANUAL 

Table of Contents 
1 USER SCREEN EDITOR ................................................................................................................................................................. 15 

1.1 RELATED DOCUMENTS .................................................................................................................................................. 15 
1.1.1 LINtools Online Help ................................................................................................................................................. 15 
1.1.2 LIN Blocks Reference Manual ................................................................................................................................. 15 
1.1.3 Application And Control Modules Operator Manual ....................................................................................... 15 

1.2 USER SCREEN EDITOR - OVERVIEW ........................................................................................................................... 16 
1.2.1 Page Sets, Pages, and Targets ................................................................................................................................. 16 
1.2.2 Panes ............................................................................................................................................................................. 16 
1.2.3 Page Items.................................................................................................................................................................... 17 
1.2.4 Page Item Properties dialogue ............................................................................................................................... 17 

2 GETTING STARTED ....................................................................................................................................................................... 18 
2.1 DESIGNING A USER SCREEN ......................................................................................................................................... 18 
2.2 OPEN THE USER SCREEN EDITOR ............................................................................................................................... 18 

2.2.1 To open the User Screen Editor: ........................................................................................................................... 18 
2.3 USE THE USER SCREEN EDITOR ................................................................................................................................... 19 

2.3.1 To use the User Screen Editor: ............................................................................................................................... 19 
3 MAIN DISPLAY REGIONS ............................................................................................................................................................ 20 

3.1 MAIN DISPLAY ................................................................................................................................................................. 20 
3.1.1 Page set ........................................................................................................................................................................ 20 
3.1.2 Pages and Panes ......................................................................................................................................................... 21 
3.1.3 Page items .................................................................................................................................................................... 23 
3.1.4 To Define customised colours ................................................................................................................................ 24 

3.2 REPORT WINDOW ........................................................................................................................................................... 25 
3.3 LIN DATABASE BROWSER ............................................................................................................................................. 26 

3.3.1 Associating a LIN Database with the Page Set ................................................................................................... 26 
3.3.2 Instrument browser ................................................................................................................................................... 27 

4 TARGET DEFINITION .................................................................................................................................................................... 28 
4.1 HOW TO CREATE A TARGET SCREEN TYPE .............................................................................................................. 28 
4.2 HOW TO EDIT THE TARGET SCREEN TYPE................................................................................................................ 29 

5 MENUS ............................................................................................................................................................................................ 30 
5.1 FILE MENU ........................................................................................................................................................................ 30 
5.2 EDIT MENU ....................................................................................................................................................................... 32 
5.3 VIEW MENU ...................................................................................................................................................................... 34 
5.4 PAGESET MENU ............................................................................................................................................................... 35 
5.5 PAGE MENU ...................................................................................................................................................................... 35 
5.6 WINDOW MENU .............................................................................................................................................................. 36 
5.7 HELP MENU....................................................................................................................................................................... 36 

HA260749U005  Page 3 
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

6 TOOLBARS ...................................................................................................................................................................................... 37 
6.1 MAIN TOOLBAR............................................................................................................................................................... 37 

6.1.1 New Page Set command .......................................................................................................................................... 37 
6.1.2 Open Page Set command ........................................................................................................................................ 37 
6.1.3 Save Page Set command .......................................................................................................................................... 37 
6.1.4 New Page command ................................................................................................................................................. 37 
6.1.5 Open Page command ............................................................................................................................................... 38 
6.1.6 Close Page command ............................................................................................................................................... 38 
6.1.7 Build Output (OIFL) Files command ..................................................................................................................... 38 
6.1.8 Verify Page Set command ....................................................................................................................................... 38 
6.1.9 Find command ............................................................................................................................................................ 38 
6.1.10 Open Database command ....................................................................................................................................... 38 
6.1.11 Back Command .......................................................................................................................................................... 38 
6.1.12 Cut command ............................................................................................................................................................. 38 
6.1.13 Copy command .......................................................................................................................................................... 38 
6.1.14 Paste command .......................................................................................................................................................... 38 
6.1.15 Undo command ......................................................................................................................................................... 39 
6.1.16 Redo command .......................................................................................................................................................... 39 
6.1.17 Zoom Factor command ............................................................................................................................................ 39 
6.1.18 Whats This? command ............................................................................................................................................. 39 

6.2 STATUS BAR ..................................................................................................................................................................... 39 
6.3 TEXT BAR ........................................................................................................................................................................... 40 

6.3.1 Font style command ................................................................................................................................................. 40 
6.3.2 Align Text Left command ........................................................................................................................................ 40 
6.3.3 Align Text Left-biased Centre command ............................................................................................................. 40 
6.3.4 Align Text Right-biased Centre command .......................................................................................................... 40 
6.3.5 Align Text Right command ...................................................................................................................................... 40 

6.4 PLACEMENT BAR ............................................................................................................................................................. 41 
6.4.1 Grid settings dialogue ............................................................................................................................................... 42 

6.5 DRAW BAR ........................................................................................................................................................................ 43 
7 HOW TO... ...................................................................................................................................................................................... 45 

7.1 SPECIFY/CONFIGURE A TARGET SCREEN TYPE ........................................................................................................ 45 
7.2 SPECIFY CHARACTER MAPPINGS ................................................................................................................................ 45 
7.3 ASSOCIATE A LIN DATABASE WITH A PAGE SET .................................................................................................... 46 
7.4 SHOW COLD START VALUES ....................................................................................................................................... 46 
7.5 VERIFY A PAGE SET ......................................................................................................................................................... 46 

7.5.1 To verify a Page Set ................................................................................................................................................... 47 
7.6 USE THE FIND DIALOGUE ............................................................................................................................................. 47 

7.6.1 To find all occurrences of a text string ................................................................................................................ 47 
7.7 SET DEFAULT OFF SCREEN FUNCTION KEY (OSFK) PANE ................................................................................... 48 
7.8 WRITE PAGE ITEM ACTIONS ......................................................................................................................................... 48 

Page 4 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

7.8.1 Example ........................................................................................................................................................................ 48 
7.8.2 Structured Text syntax .............................................................................................................................................. 48 
7.8.3 Action Lists .................................................................................................................................................................. 48 
7.8.4 Actions .......................................................................................................................................................................... 48 
7.8.5 Action qualifiers ......................................................................................................................................................... 49 

7.9 USE THE TEXT BAR COMMANDS TO... ...................................................................................................................... 50 
7.9.1 Edit Text ....................................................................................................................................................................... 50 
7.9.2 Edit the Font Style ..................................................................................................................................................... 50 
7.9.3 Align Text to the left ................................................................................................................................................. 50 
7.9.4 Align Text to the centre with Left-Bias ................................................................................................................ 51 
7.9.5 Align Text to the right .............................................................................................................................................. 51 
7.9.6 Align Text to the centre with Right-Bias .............................................................................................................. 51 

7.10 USE THE DRAW BAR COMMAND TO... ..................................................................................................................... 52 
7.10.1 Select or Edit a Page Item ....................................................................................................................................... 52 
7.10.2 Add a Bar Chart .......................................................................................................................................................... 52 
7.10.3 Add a Bitmap .............................................................................................................................................................. 52 
7.10.4 Add a Button ............................................................................................................................................................... 53 
7.10.5 Add a Text Variable ................................................................................................................................................... 53 
7.10.6 Add a Touch Area ...................................................................................................................................................... 53 
7.10.7 Add a Trend Graph .................................................................................................................................................... 54 
7.10.8 Add a Program Profile .............................................................................................................................................. 54 
7.10.9 Add an OIFL Object ................................................................................................................................................... 54 
7.10.10 Draw a Line ............................................................................................................................................................ 55 
7.10.11 Draw a Rectangle .................................................................................................................................................. 55 
7.10.12 Draw a Rounded Rectangle................................................................................................................................ 55 
7.10.13 Draw a Triangle ..................................................................................................................................................... 55 
7.10.14 Draw an Ellipse or Circle ..................................................................................................................................... 56 
7.10.15 Select a Line/Text Colour ................................................................................................................................... 56 
7.10.16 Select a Fill/Background Colour ....................................................................................................................... 56 

7.11 USE THE PLACEMENT BAR COMMANDS TO... ........................................................................................................ 57 
7.11.1 Activate the Snap object(s) to nearest gridline ................................................................................................. 57 
7.11.2 Align the bottom edges of objects ....................................................................................................................... 57 
7.11.3 Align the left edges of objects ............................................................................................................................... 57 
7.11.4 Align the right edges of objects ............................................................................................................................. 57 
7.11.5 Align the top edges of objects ............................................................................................................................... 57 
7.11.6 Bring an object forward by one layer................................................................................................................... 57 
7.11.7 Bring an object to the front .................................................................................................................................... 57 
7.11.8 Send an object backward by one layer ................................................................................................................ 57 
7.11.9 Send an object to the back ..................................................................................................................................... 57 
7.11.10 Flip object(s) horizontally ................................................................................................................................... 57 
7.11.11 Flip object(s) vertically ........................................................................................................................................ 58 

HA260749U005  Page 5 
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

7.11.12 Group multiple objects ....................................................................................................................................... 58 
7.11.13 Ungroup a grouped object ................................................................................................................................ 58 
7.11.14 Show/Hide the gridlines...................................................................................................................................... 58 

8 CUSTOMISING THE USER SCREEN EDITOR ............................................................................................................................ 59 
8.1 DEFINE CUSTOMISED COLOURS ................................................................................................................................. 59 
8.2 SELECT THE COLOUR OF THE GRIDLINES ................................................................................................................. 59 
8.3 CUSTOMISE THE GRID SETTINGS ................................................................................................................................ 59 
8.4 CUSTOMISE THE USER SCREEN BACKGROUND COLOUR .................................................................................... 59 

9 STRUCTURED TEXT (ST) .............................................................................................................................................................. 60 
9.1 WHAT IS STRUCTURED TEXT? ..................................................................................................................................... 60 

9.1.1 Structured Text - Example ....................................................................................................................................... 60 
9.2 EDITING STRUCTURED TEXT ........................................................................................................................................ 61 
9.3 COMMENTS IN STRUCTURED TEXT (ST)................................................................................................................... 61 
9.4 CONSTANTS IN STRUCTURED TEXT (ST) .................................................................................................................. 61 

9.4.1 Integer constants ....................................................................................................................................................... 61 
9.4.2 Real constants ............................................................................................................................................................. 62 
9.4.3 Time constants ........................................................................................................................................................... 62 
9.4.4 String constant ........................................................................................................................................................... 62 
9.4.5 String constants & T1000/T100 fields ................................................................................................................... 62 

9.5 EXPRESSIONS IN STRUCTURED TEXT (ST) ................................................................................................................ 63 
9.5.1 Arithmetical ................................................................................................................................................................. 63 
9.5.2 Logical ........................................................................................................................................................................... 63 

9.6 IDENTIFIERS IN STRUCTURED TEXT (ST) ................................................................................................................... 63 
9.6.1 Valid Structured Text identifiers ............................................................................................................................ 63 
9.6.2 Invalid Structured Text identifiers ......................................................................................................................... 63 

9.7 OPERATORS AND FUNCTIONS IN STRUCTURED TEXT (ST) ................................................................................ 64 
9.8 SPACES IN STRUCTURED TEXT (ST)............................................................................................................................ 67 

9.8.1 Mandatory spaces ...................................................................................................................................................... 67 
9.8.2 Illegal spaces ............................................................................................................................................................... 67 
9.8.3 Optional spaces .......................................................................................................................................................... 67 

9.9 STATEMENTS IN STRUCTURED TEXT (ST) ................................................................................................................ 67 
9.9.1 Assignment .................................................................................................................................................................. 67 
9.9.2 IF-statement ................................................................................................................................................................ 68 

9.10 TRANSITIONS IN STRUCTURED TEXT (ST) ................................................................................................................ 68 
9.11 VARIABLES IN STRUCTURED TEXT (ST) ..................................................................................................................... 68 
9.12 LIN DATABASE FIELD/SUBFIELD NAMES ................................................................................................................... 69 

9.12.1 Bitfields ......................................................................................................................................................................... 69 
9.12.2 Aliases ........................................................................................................................................................................... 69 
9.12.3 LIN Sequence step variables ................................................................................................................................... 69 

10 GETTING SPECIFIC HELP ........................................................................................................................................................ 70 
10.1 OPEN ONLINE HELP FILE ............................................................................................................................................... 70 

Page 6 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

10.2 SHOW CONTEXT-SENSITIVE HELP .............................................................................................................................. 70 
10.2.1 Dialogue Help ............................................................................................................................................................. 70 
10.2.2 Menu Help ................................................................................................................................................................... 70 
10.2.3 Toolbutton Help ......................................................................................................................................................... 70 

11 TARGET PROPERTIES DIALOGUE ......................................................................................................................................... 71 
11.1 INTRODUCTION .............................................................................................................................................................. 71 
11.2 TARGET PROPERTIES DIALOGUE - BITMAPS PAGE ................................................................................................. 72 

11.2.1 Bitmaps list .................................................................................................................................................................. 72 
11.2.2 Add ................................................................................................................................................................................ 72 
11.2.3 Edit ................................................................................................................................................................................. 72 
11.2.4 Remove ......................................................................................................................................................................... 72 

11.3 TARGET PROPERTIES DIALOGUE - CAPABILITIES PAGE ......................................................................................... 73 
11.3.1 Capabilities .................................................................................................................................................................. 73 

11.4 TARGET PROPERTIES DIALOGUE - COLOURS PAGE ............................................................................................... 74 
11.4.1 Table list ....................................................................................................................................................................... 74 
11.4.2 Setup ............................................................................................................................................................................. 74 
11.4.3 Add ................................................................................................................................................................................ 74 
11.4.4 Edit ................................................................................................................................................................................. 74 
11.4.5 Remove ......................................................................................................................................................................... 74 

11.5 TARGET PROPERTIES DIALOGUE - DRAWING PAGE .............................................................................................. 75 
11.6 TARGET PROPERTIES DIALOGUE - FILENAME PAGE .............................................................................................. 75 

11.6.1 Target filename .......................................................................................................................................................... 75 
11.7 TARGET PROPERTIES DIALOGUE - FONTS PAGE ..................................................................................................... 76 

11.7.1 Table list ....................................................................................................................................................................... 76 
11.7.2 Setup ............................................................................................................................................................................. 76 
11.7.3 Add ................................................................................................................................................................................ 76 
11.7.4 Edit ................................................................................................................................................................................. 76 
11.7.5 Remove ......................................................................................................................................................................... 76 

11.8 TARGET PROPERTIES DIALOGUE - GENERAL PAGE ................................................................................................ 77 
11.8.1 Target Name ............................................................................................................................................................... 77 
11.8.2 Dimensions .................................................................................................................................................................. 77 
11.8.3 Character Dimensions ............................................................................................................................................... 77 

11.9 TARGET PROPERTIES DIALOGUE - GRID PAGE ........................................................................................................ 77 
11.9.1 Default Major Grid Settings .................................................................................................................................... 77 
11.9.2 Default Minor Grid Settings .................................................................................................................................... 77 
11.9.3 Default Zoom .............................................................................................................................................................. 78 

11.10 TARGET PROPERTIES DIALOGUE - INSTRUMENTS PAGE ...................................................................................... 78 
11.10.1 Instruments list ...................................................................................................................................................... 78 
11.10.2 Add ........................................................................................................................................................................... 78 
11.10.3 Edit ........................................................................................................................................................................... 78 
11.10.4 Remove ................................................................................................................................................................... 78 

HA260749U005  Page 7 
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

11.11 TARGET PROPERTIES DIALOGUE - MAPPINGS PAGE ............................................................................................. 79 
11.11.1 Character drawing capabilities .......................................................................................................................... 79 
11.11.2 Graphical symbol-character mappings ............................................................................................................ 79 
11.11.3 Browse… .................................................................................................................................................................. 79 

11.12 TARGET PROPERTIES DIALOGUE - MISCELLANEOUS PAGE ................................................................................. 79 
11.12.1 Miscellaneous features ........................................................................................................................................ 79 
11.12.2 Database ................................................................................................................................................................. 79 

11.13 TARGET PROPERTIES DIALOGUE - OSFK PAGE........................................................................................................ 80 
11.13.1 Off Screen Function Keys ................................................................................................................................... 80 

11.14 TARGET PROPERTIES DIALOGUE - PANES PAGE ..................................................................................................... 81 
11.14.1 Table list .................................................................................................................................................................. 81 
11.14.2 Setup ........................................................................................................................................................................ 81 
11.14.3 Add ........................................................................................................................................................................... 81 
11.14.4 Edit ........................................................................................................................................................................... 81 
11.14.5 Remove ................................................................................................................................................................... 81 

11.15 TARGET PROPERTIES DIALOGUE - UNDERLINES PAGE ......................................................................................... 82 
11.15.1 Special underline characters .............................................................................................................................. 82 
11.15.2 Underline colours ................................................................................................................................................. 82 

11.16 TARGET PROPERTIES DIALOGUE - VARIABLES PAGE ............................................................................................. 83 
11.16.1 Target Specific System Variables list ............................................................................................................... 83 
11.16.2 Add ........................................................................................................................................................................... 83 
11.16.3 Edit ........................................................................................................................................................................... 83 
11.16.4 Delete ...................................................................................................................................................................... 83 
11.16.5 Export ...................................................................................................................................................................... 83 
11.16.6 Import ...................................................................................................................................................................... 83 

12 WHAT IS .................................................................................................................................................................................... 84 
12.1 A LIN DATABASE? ........................................................................................................................................................... 84 
12.2 A LIN FUNCTION BLOCK? ............................................................................................................................................. 84 
12.3 A USER SCREEN EDITOR ACTION? .............................................................................................................................. 84 

12.3.1 Supported Actions ..................................................................................................................................................... 85 
12.4 A VARIABLE? ..................................................................................................................................................................... 87 

12.4.1 LIN Variable ................................................................................................................................................................. 87 
12.4.2 Instrument Variable................................................................................................................................................... 87 

12.5 AN AGENT? ....................................................................................................................................................................... 87 
12.6 AN INSTRUMENT VARIABLE BROWSER? ................................................................................................................... 88 

12.6.1 Using the Instrument Variable Browser window ............................................................................................... 88 
12.7 AN OPERATOR INTERFACE LANGUAGE (OIFL)? ...................................................................................................... 88 
12.8 A LIN DATABASE BROWSER? ....................................................................................................................................... 88 

12.8.1 Using the Browser window ...................................................................................................................................... 88 
12.9 A REPORT WINDOW? ..................................................................................................................................................... 88 

13 OTHER ITEMS ........................................................................................................................................................................... 89 

Page 8 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.1 3D STYLING PROPERTIES PAGE.................................................................................................................................... 89 
13.1.1 Bordering ..................................................................................................................................................................... 89 
13.1.2 OK .................................................................................................................................................................................. 89 
13.1.3 Apply ............................................................................................................................................................................. 89 
13.1.4 Cancel ........................................................................................................................................................................... 89 

13.2 ACCESS PROPERTIES PAGE ............................................................................................................................................ 89 
13.2.1 Visibility ........................................................................................................................................................................ 89 
13.2.2 Writability .................................................................................................................................................................... 90 
13.2.3 OK .................................................................................................................................................................................. 90 
13.2.4 Apply ............................................................................................................................................................................. 90 
13.2.5 Cancel ........................................................................................................................................................................... 90 

13.3 ADD/EDIT BITMAP DIALOGUE ..................................................................................................................................... 90 
13.3.1 Bitmap name ............................................................................................................................................................... 90 
13.3.2 Bitmap filename ......................................................................................................................................................... 90 
13.3.3 Description .................................................................................................................................................................. 90 
13.3.4 Add ................................................................................................................................................................................ 90 
13.3.5 Cancel ........................................................................................................................................................................... 90 

13.4 ADD/EDIT COLOUR DIALOGUE ................................................................................................................................... 91 
13.4.1 Colour details .............................................................................................................................................................. 91 
13.4.2 Colour ........................................................................................................................................................................... 91 
13.4.3 Add ................................................................................................................................................................................ 91 
13.4.4 Cancel ........................................................................................................................................................................... 91 

13.5 ADD/EDIT FONT DIALOGUE ......................................................................................................................................... 91 
13.5.1 Font name .................................................................................................................................................................... 91 
13.5.2 Dimensions .................................................................................................................................................................. 91 
13.5.3 Font properties ........................................................................................................................................................... 91 
13.5.4 Font filename (under Targets Font directory): .................................................................................................. 91 
13.5.5 Add ................................................................................................................................................................................ 91 
13.5.6 Cancel ........................................................................................................................................................................... 91 

13.6 ADD/EDIT PANE DIALOGUE ......................................................................................................................................... 92 
13.6.1 Pane type and name ................................................................................................................................................. 92 
13.6.2 Dimensions .................................................................................................................................................................. 92 
13.6.3 Description .................................................................................................................................................................. 92 
13.6.4 Support Default Pages .............................................................................................................................................. 92 

13.7 ADD/EDIT TARGET VARIABLE DIALOGUE ................................................................................................................. 92 
13.7.1 Target Variable ........................................................................................................................................................... 92 
13.7.2 Add ................................................................................................................................................................................ 92 
13.7.3 Cancel ........................................................................................................................................................................... 92 

13.8 APPEARANCE PROPERTIES PAGE ................................................................................................................................. 93 
13.8.1 Line/Text ...................................................................................................................................................................... 93 
13.8.2 Fill/Background .......................................................................................................................................................... 93 

HA260749U005  Page 9 
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.8.3 OK .................................................................................................................................................................................. 93 
13.8.4 Apply ............................................................................................................................................................................. 93 
13.8.5 Cancel ........................................................................................................................................................................... 93 

13.9 BAR CHART PROPERTIES PAGE .................................................................................................................................... 93 
13.9.1 Fill direction ................................................................................................................................................................ 93 
13.9.2 Underline used for bar chart .................................................................................................................................. 93 
13.9.3 OK .................................................................................................................................................................................. 94 
13.9.4 Apply ............................................................................................................................................................................. 94 
13.9.5 Cancel ........................................................................................................................................................................... 94 

13.10 BITMAP ENUMERATION PROPERTIES PAGE ............................................................................................................. 94 
13.10.1 Enumerated ............................................................................................................................................................ 94 
13.10.2 Variable selection ................................................................................................................................................. 94 
13.10.3 Bitmap selection ................................................................................................................................................... 95 
13.10.4 OK ............................................................................................................................................................................. 95 
13.10.5 Apply ........................................................................................................................................................................ 95 
13.10.6 Cancel ...................................................................................................................................................................... 95 

13.11 BITMAP PROPERTIES PAGE ........................................................................................................................................... 96 
13.11.1 Bitmap ..................................................................................................................................................................... 96 
13.11.2 OK ............................................................................................................................................................................. 96 
13.11.3 Apply ........................................................................................................................................................................ 96 
13.11.4 Cancel ...................................................................................................................................................................... 96 

13.12 BROWSER BLOCK ............................................................................................................................................................ 97 
13.12.1 Browser Field (no subfields) .............................................................................................................................. 97 
13.12.2 Browser Field (with subfields) ........................................................................................................................... 97 
13.12.3 Browser Multi-bit field ........................................................................................................................................ 97 
13.12.4 Browser Selection box ......................................................................................................................................... 97 
13.12.5 Browser Subfield ................................................................................................................................................... 97 
13.12.6 Browser Type box ................................................................................................................................................. 98 

13.13 BUTTON TOOL PROPERTIES PAGE .............................................................................................................................. 98 
13.14 COLOUR PALETTE ........................................................................................................................................................... 98 
13.15 CHARACTER BASED SCREEN TYPES ............................................................................................................................ 99 
13.16 COLOUR ATTRIBUTE PROPERTIES PAGE ................................................................................................................... 99 

13.16.1 Colour Change....................................................................................................................................................... 99 
13.16.2 Variable selection ................................................................................................................................................. 99 
13.16.3 Colour selection .................................................................................................................................................. 100 
13.16.4 OK ........................................................................................................................................................................... 100 
13.16.5 Apply ...................................................................................................................................................................... 100 
13.16.6 Cancel .................................................................................................................................................................... 100 

13.17 COLOUR LIMITS PROPERTIES PAGE .......................................................................................................................... 100 
13.17.1 Colour Limit Minimum ...................................................................................................................................... 100 
13.17.2 Colour Limit Maximum ..................................................................................................................................... 101 

Page 10 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.17.3 OK ........................................................................................................................................................................... 101 
13.17.4 Apply ...................................................................................................................................................................... 101 
13.17.5 Cancel .................................................................................................................................................................... 101 

13.18 COLOUR SETUP DIALOGUE ........................................................................................................................................ 101 
13.18.1 Default colours .................................................................................................................................................... 101 
13.18.2 Colour options .................................................................................................................................................... 101 

13.19 CONFIGURE PAGE ITEM ACTIONS ............................................................................................................................ 101 
13.19.1 Enabling Actions ................................................................................................................................................. 101 

13.20 CONFIRMATION PROPERTIES PAGE ......................................................................................................................... 102 
13.20.1 Required Confirmation Type ........................................................................................................................... 102 
13.20.2 OK ........................................................................................................................................................................... 102 
13.20.3 Apply ...................................................................................................................................................................... 102 
13.20.4 Cancel .................................................................................................................................................................... 102 

13.21 DATA TYPES .................................................................................................................................................................... 103 
13.22 DEFAULT T2900 AGENTS............................................................................................................................................. 104 
13.23 ENUMERATION PROPERTIES PAGE ........................................................................................................................... 105 

13.23.1 OK ........................................................................................................................................................................... 105 
13.23.2 Apply ...................................................................................................................................................................... 105 
13.23.3 Cancel .................................................................................................................................................................... 105 

13.24 FILL STYLE PROPERTIES PAGE..................................................................................................................................... 106 
13.24.1 Fill style ................................................................................................................................................................. 106 
13.24.2 Fill mode ............................................................................................................................................................... 106 
13.24.3 OK ........................................................................................................................................................................... 106 
13.24.4 Apply ...................................................................................................................................................................... 106 
13.24.5 Cancel .................................................................................................................................................................... 106 

13.25 FONT SETUP DIALOGUE .............................................................................................................................................. 106 
13.25.1 Default Font ......................................................................................................................................................... 106 
13.25.2 Font options ......................................................................................................................................................... 106 
13.25.3 Font dialogue ....................................................................................................................................................... 106 

13.26 FORMAT PROPERTIES PAGE ....................................................................................................................................... 107 
13.26.1 Number accuracy ............................................................................................................................................... 107 
13.26.2 Real Number format .......................................................................................................................................... 107 
13.26.3 Integer Number format .................................................................................................................................... 107 
13.26.4 OK ........................................................................................................................................................................... 107 
13.26.5 Apply ...................................................................................................................................................................... 107 
13.26.6 Cancel .................................................................................................................................................................... 107 

13.27 GRID SETTINGS DIALOGUE ......................................................................................................................................... 108 
13.27.1 Major grid settings ............................................................................................................................................. 108 
13.27.2 Minor grid settings ............................................................................................................................................. 108 
13.27.3 General grid settings .......................................................................................................................................... 108 
13.27.4 Configure using default font ........................................................................................................................... 108 

HA260749U005  Page 11 
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.27.5 OK ........................................................................................................................................................................... 108 
13.27.6 Cancel .................................................................................................................................................................... 108 

13.28 LIMITS PROPERTIES PAGE ........................................................................................................................................... 109 
13.28.1 Low Limit .............................................................................................................................................................. 109 
13.28.2 Maximum .............................................................................................................................................................. 109 
13.28.3 OK ........................................................................................................................................................................... 109 
13.28.4 Apply ...................................................................................................................................................................... 109 
13.28.5 Cancel .................................................................................................................................................................... 109 

13.29 MISCELLANEOUS PROPERTIES PAGE ........................................................................................................................ 110 
13.29.1 Miscellaneous ...................................................................................................................................................... 110 
13.29.2 OK ........................................................................................................................................................................... 110 
13.29.3 Apply ...................................................................................................................................................................... 110 
13.29.4 Cancel .................................................................................................................................................................... 110 

13.30 NEW PAGE SET DIALOGUE ......................................................................................................................................... 110 
13.30.1 Name of new Page Set ...................................................................................................................................... 110 
13.30.2 Target panel ......................................................................................................................................................... 110 
13.30.3 Status Pane OIFL file .......................................................................................................................................... 111 
13.30.4 Location of DB file for Page Set ..................................................................................................................... 111 
13.30.5 OK ........................................................................................................................................................................... 111 
13.30.6 Cancel .................................................................................................................................................................... 111 

13.31 OIFL PROPERTIES PAGE................................................................................................................................................ 111 
13.31.1 Display ................................................................................................................................................................... 111 
13.31.2 OIFL ........................................................................................................................................................................ 112 
13.31.3 OK ........................................................................................................................................................................... 112 
13.31.4 Apply ...................................................................................................................................................................... 112 
13.31.5 Cancel .................................................................................................................................................................... 112 

13.32 PAGE ................................................................................................................................................................................. 112 
13.32.1 Page Item Actions - Example ........................................................................................................................... 112 
13.32.2 Page Item Properties dialogue ........................................................................................................................ 113 
13.32.3 Page Properties dialogue - Names page ....................................................................................................... 113 
13.32.4 Page Properties dialogue - OSFK page ......................................................................................................... 114 
13.32.5 OSFK Pane list...................................................................................................................................................... 114 
13.32.6 Page Properties dialogue - Target page ........................................................................................................ 115 

13.33 PAGE SET PROPERTIES DIALOGUE ............................................................................................................................ 115 
13.33.1 Name of Page Set ............................................................................................................................................... 115 
13.33.2 Location of DB file for Page Set ..................................................................................................................... 115 
13.33.3 Status Pane OIFL file .......................................................................................................................................... 115 
13.33.4 Target panel ......................................................................................................................................................... 116 
13.33.5 OK ........................................................................................................................................................................... 116 
13.33.6 Cancel .................................................................................................................................................................... 116 

13.34 PANE SETUP DIALOGUE .............................................................................................................................................. 116 

Page 12 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.34.1 Default Pane ........................................................................................................................................................ 116 
13.35 PASSWORD PROTECTION ........................................................................................................................................... 116 
13.36 PROGRAM PROFILE PROPERTIES PAGE.................................................................................................................... 117 

13.36.1 Program profile ................................................................................................................................................... 117 
13.36.2 Program Profile appearance ............................................................................................................................ 117 

13.37 TARGET INSTRUMENT DIALOGUE ............................................................................................................................ 118 
13.37.1 Instrument ............................................................................................................................................................ 118 

13.38 TARGET PANEL DIALOGUE ......................................................................................................................................... 118 
13.38.1 Currently defined Target Panels ..................................................................................................................... 118 
13.38.2 New ........................................................................................................................................................................ 118 
13.38.3 Edit ......................................................................................................................................................................... 118 
13.38.4 Remove ................................................................................................................................................................. 118 
13.38.5 OK ........................................................................................................................................................................... 118 
13.38.6 Cancel .................................................................................................................................................................... 118 
13.38.7 Set Password ........................................................................................................................................................ 118 

13.39 TEXT PROPERTIES PAGE ............................................................................................................................................... 119 
13.39.1 Font ........................................................................................................................................................................ 119 
13.39.2 Alignment & Underlining .................................................................................................................................. 119 
13.39.3 Text......................................................................................................................................................................... 119 
13.39.4 OK ........................................................................................................................................................................... 119 
13.39.5 Apply ...................................................................................................................................................................... 119 
13.39.6 Cancel .................................................................................................................................................................... 119 

13.40 TEXT VARIABLE PROPERTIES PAGE ........................................................................................................................... 120 
13.40.1 Text Tab ................................................................................................................................................................ 120 
13.40.2 OK ........................................................................................................................................................................... 120 
13.40.3 Apply ...................................................................................................................................................................... 120 
13.40.4 Cancel .................................................................................................................................................................... 120 

13.41 TOUCH AREA PROPERTIES PAGE .............................................................................................................................. 121 
13.41.1 Touch Area Type ................................................................................................................................................. 121 
13.41.2 Destination Page ID & Name ........................................................................................................................... 121 
13.41.3 Action .................................................................................................................................................................... 121 
13.41.4 OK ........................................................................................................................................................................... 121 
13.41.5 Apply ...................................................................................................................................................................... 121 
13.41.6 Cancel .................................................................................................................................................................... 121 

13.42 TREND GRAPH PROPERTIES PAGE ............................................................................................................................ 122 
13.42.1 Growth direction ................................................................................................................................................ 122 
13.42.2 OK ........................................................................................................................................................................... 122 
13.42.3 Apply ...................................................................................................................................................................... 122 
13.42.4 Cancel .................................................................................................................................................................... 122 

13.43 TREND GRAPH VARIABLE PROPERTIES PAGE ........................................................................................................ 122 
13.43.1 Variable ................................................................................................................................................................. 122 

HA260749U005  Page 13 
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.43.2 Channel selection ............................................................................................................................................... 122 
13.43.3 OK ........................................................................................................................................................................... 122 
13.43.4 Apply ...................................................................................................................................................................... 122 
13.43.5 Cancel .................................................................................................................................................................... 123 

13.44 VARIABLE ......................................................................................................................................................................... 123 
13.44.1 Variable Properties page .................................................................................................................................. 123 
13.44.2 Variable Tab ......................................................................................................................................................... 124 
13.44.3 OK ........................................................................................................................................................................... 124 
13.44.4 Apply ...................................................................................................................................................................... 124 
13.44.5 Cancel .................................................................................................................................................................... 124 

14 DEFAULT PASSWORD ........................................................................................................................................................... 125 
15 INDEX ....................................................................................................................................................................................... 126 

Page 14 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

1 USER SCREEN EDITOR 

The purpose of the User Screen Editor Online Help File is to explain the principles required to understand the 
User Screen Editor and its available functions. 

The document describes how the Tools, as part of the Editor, are used to create a pictorial arrangement of 
Screens that represent your plant by dividing it into logical sections that display all appropriate runtime 
information. 

1.1 RELATED DOCUMENTS 

1.1.1 LINtools Online Help 
The LINtools Online Help file describes the use of the LINtools software program. It is a powerful multi-purpose 
Windows-based software package for performing both off- and on-line configuration of a Target Instrument 
control strategy. 
Offline LINtools creates and modifies LIN-based process control strategies, sequences, and actions 

for a range of target instruments. 
Online  it lets you monitor and interact with control and sequence strategies running in remote 

instruments across the LIN, ELIN, or ALIN, providing a versatile commissioning and strategy 
debugging toolkit. 

1.1.2 LIN Blocks Reference Manual 
The LIN Blocks Reference Manual (Part no. HA082375U003) describes the available instruments function blocks 
that can be connected to this manufacturers’ Local Instrument Network (LIN). The purpose and workings of 
each block are explained, specification menu parameters are defined and inputs and outputs indicated giving 
enough detailed information needed to configure the block in a control strategy. 

1.1.3 Application And Control Modules Operator Manual 
This Application And Control Modules Operator Manual (Part no. HA084012U003) describe the application 
(Section 1) and control modules (Section 2) available within the LIN environment. These modules can be used 
in conjunction with existing LIN function blocks to perform a wide range of control tasks. Application modules 
can be utilised for specific activities such as combustion control, load management and pump set control, while 
Control modules consist of common devices such as motors and valves. 

 

NOTE 
Contact your distributor if these documents are unavailable. 
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1.2 USER SCREEN EDITOR - OVERVIEW 
The User Screen Editor is a Windows-style PC standalone graphical Editor that allows the design of custom 
screens for products, otherwise described as Target Instruments, with operator panels (Target Instrument 
Screen types). It outputs the Page designs in the Operator InterFace Language (OIFL) format, ready for 
downloading to defined Target Instruments. 

NOTE 
From Version 1.9, the User Screen Editor is NOT compatible with previous releases of the User Screen 
Editor and will ONLY run on Windows XP and later operating systems. 

The purpose of the User Screen Editor is to simplify the creation of interactive and inactive screens that can be 
displayed on a specific Target Instrument Screen type, Target Panel. Each Target Panel contains a combination 
of Pages (Page Sets), each Page representing a Pane on the Target Panel screen. 

Beware… 
User Screen Editor project files (.uxp) should be edited using the appropriate User Screen Editor version. 

Failure to do so will result in the Page Set becoming incompatible with previous versions of the User 
Screen Editor. To resolve this problem, Open and Save each Page Set in turn using the latest User Screen 
Editor version, available from the manufacturer. 

1.2.1 Page Sets, Pages, and Targets 
Using the User Screen Editor’s comprehensive set of tools, you design the screens as individual Pages in a group 
of pages, called a Page Set. Page Sets must be designed for downloading to a specific Instrument Panel, whose 
capabilities are pre-specified in a Target Definition File, called a Target. 

All Page Sets, Pages, and Targets are configured using the appropriate Properties dialogue. 

See also: 

Page Set Properties dialogue  

Page Properties dialogue - Name page  

Page Properties dialogue - Target page  

1.2.2 Panes 
The Main pane is used to display the most significant information. It occupies most of the Target Instruments 
screen, but other types of smaller pane are also configurable, e.g. 'Pop-up' panes that overlay the Main pane, 
and a permanently visible 'Status' pane, often used as an alarm banner. 
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1.2.3 Page Items 
Graphical objects, Page Items, available for use in the designs include lines, geometric shapes, text, buttons, 
touch-sensitive areas, bitmaps, etc. Three-dimensional relief effects can be applied to some Page Items. 

Page Items may be left static or linked to variables in the associated LIN Database so that they change 
appearance dynamically with changes in the variable's value. These Page Items include dynamic bar charts, 
trend plots, and variable text legends. For Target Instruments supporting colour, dynamic colour-scheme 
changes can also be configured to enhance operator awareness of the state of the LIN Database variables. 

1.2.4 Page Item Properties dialogue  
The properties of each Page Item differ, i.e. the Touch Area Page Item includes an, Access page, Fill Style page, 
Touch Area page, and a Miscellaneous page, whereas the Rectangle Page Item includes the Access page, 
Appearance page, Fill Style page, Colour Attribute page, Colour Limits page, and Miscellaneous page. 

A confirmation page appears where applicable.  
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2 GETTING STARTED 

2.1 DESIGNING A USER SCREEN 
Before starting to use to User Screen Editor to produce the required screens for the Target Instrument, try to 
understand how all the appropriate information can be displayed on each Page, including any specific 
information that is required at all times. 

Start by analysing the process or instrument. To help with the analysis, it is very useful to sub-divide the process 
or instrument into smaller groups of related functionality or equipment. 

NOTE 
These smaller groups are the equivalent to the Pages of the User Screen Editor. 

Information only relevant to a specific process or instrument could be displayed in the Main or User Panes. 

Information that requires immediate attention, and therefore needs to be constantly displayed, such as Alarms, 
could be displayed in a Status Pane. 

Specific function block information could be displayed on both the Point and Faceplate Panes. The Point Pane 
is a full size image, while the Faceplate Pane is a thumbnail version. 

Tip! 

Creating a storybook or description of what is to appear on each of the Pages required is usually of help in 
later stages of generating the User Screens, for the definition of Pop-up Panes, or Point Panes. 

When satisfied with what is required on each Page, open the User Screen Editor and continue to generate the 
required Pages using the Panes. 

2.2 OPEN THE USER SCREEN EDITOR 
The User Screen Editor’s starting window permits Target Instruments to be specified, Page Sets to be created, 
and generally initiate the design process. 

2.2.1 To open the User Screen Editor: 

Press  Start > Programs > LINtools Advanced. This reveals a menu of the installed tools. 

Finally, click on User Screen Editor to launch the application. The blank User Screen Editor window appears. 

NOTE 
If LINtools is currently open, simply select and open the Page Set file (.uxp) using the File > Open 
command or double-click the selected Page Set file (.uxp). Alternatively, create a new Page Set file (.uxp) 
using the File > New command. The Location of DB file for Page Set may still need to be configured. 
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2.3 USE THE USER SCREEN EDITOR 
The User Screen Editor’s starting window permits a Target Instrument and Screen type to be specified, a Page 
Set to be created, and to generally initiate the design process. 

2.3.1 To use the User Screen Editor: 
1. Open the User Screen Editor  

2. Select,  Start > Programs > LINtools Advanced > User Screen Editor. 

3. Create and/or edit a Page Set for the Target Instrument Screen Type  

4. Create Page Sets that associate with a LIN Database, or open an existing Page Set using the command 
and dialogue windows to show Pages applicable to the Target Instrument. 

5. Specify and/or configure Target Screen type. 

6. Create and/or edit a Page for the Target Instrument Screen Type  

7. Create, or open existing Pages using the appropriate command and dialogue windows to show the 
Page Items used, including Touch Areas, Bar Charts and Drawing tools. 

8. Find and replace specific text strings. 

9. Save and verify the Target Instrument User Screen configuration  

10. All edits can now be displayed at the Target Instrument defined in the New Page Set dialogue. 

11. The Error: No Database Defined error message appears if attempting to verify a Page Set before a LIN 
Database has been associated. 

NOTE 
Customised Target Screen types can be created. This is not recommended as each file (.uxt) contains the 
unique pre specified configuration of the selected Target Screen type. 
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3 MAIN DISPLAY REGIONS 

The Main Display region of the Editor can be divided into design, and information regions. 

3.1 MAIN DISPLAY 
Page Set  

Page (Pane)  

Page Item  

3.1.1 Page set 
A Page Set is a group of Pages associated with an application designed to be run in a Target Instrument with a 
particular Target Instrument Screen type. A Page Set is similar to a folder, and only one is required per Target 
Instrument. 

NOTE 
Page Set filenames are assigned a .uxp extension when saved. 

Before generating the individual screens for the Target Instrument, first create an 'empty' Page Set to 
accommodate them. When the Pages are complete and ready to download to the Target Instrument, the whole 
Page Set is downloaded, rather than the individual Pages. 

TO CREATE OR EDIT A PAGE SET 

NOTE 
If LINtools is currently open, simply select the File > New Page Set command to open the User Screen 
Editor and display the New Page Set dialogue. 

With the User Screen Editor open, simply select File > New Page Set command to display the Page Set dialogue.  
Alternatively, click the New Page Set button. 

Enter a name in the Name of new Page Set field that matches the LIN Database (.dbf) filename.  The Target 
Instrument uses the Page Set that matches the LIN Database (.dbf) filename. 

From the Target Panel field, click the drop-down menu and select the required Target Panel type. 

Enter the filename of the OIFL file (.ofl), in the Status Pane OIFL file field, needed for display in the Status Pane. 

NOTE 

This field should remain unchanged unless an alternative Status Pane is required. 

Finally, locate and select the LIN Database file (.dbf) that is to be associated with this Page Set  Use the Browse 
button to display the Open dialogue, which will assist with locating the required LIN Database file. Confirm 
using the OK button. 

NOTE 

New Page Sets created within the Project environment are automatically associated with the default LIN 
Database filename (.dbf) in the same the Instrument folder. 
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3.1.2 Pages and Panes 
Pages are individual WYSIWYG ('What You See Is What You Get') Panes created and edited on the User Screen 
Editor worksheet. Each Page corresponds to each specific Pane used by the Target Instrument. 

Individual Pages, or group of Pages are combined to create a set of screens displayed by the Target Instrument. 

NOTE 
Pages are stored in a Page Set, which is associated with a particular Target Instrument. 

A Page must be configured with a Page Name, ID number, and Page Title, and the particular Pane in the 
associated Target Instrument that the Page will be displayed on. 

NOTE 
After opening the required Page, the colour of the User Screen background can be customised using the 
Page > Panel Colour command. 

 

A Pane is part of the User Screen Editor displaying specific types of information. Each Pane has unique 
dimensions, applicable to the Target Instrument it is configured for, but other types of smaller pane, see below, 
can be included in the Page Set. 

NOTE 
Each Target Panel has a specific default set of Panes. 

Main Pane This Pane occupies most of the Target Instrument screen, except for a narrow strip along the 
top where the Status pane is located. It is used for a specific area of the system. Only one 
Main Pane is configurable for a given target display. (In general, the location of the main 
pane is target-dependent). 

User Pane This is similar to the Main Pane occupies most of the Target Instrument screen. 
Pop-up Pane This Pane will overlay the Main and User panes, but not the Status Pane, until closed by the 

User. Several differently-sized Pop-up Panes can be configured. 
Status Pane This Pane is a narrow strip located at the top of the Target Screen that is permanently visible, 

i.e. 'always on top'. It is often used to show alarm status information. There can only be one 
Status Pane in a display. (In general, the location of the status pane is target-dependent). 

Point Pane This Pane has dimensions of 320  170 (VGA) and 800  450 (SVGA). It  can be  used to  

display a graphical representation for a specific block and its parameters. This is a Panel size 
version of a Faceplate Pane. 

Faceplate Pane This Pane has dimensions of 132  40 (VGA) and  172  80 (SVGA). It can be used to display 
a graphical representation for a specific block and its parameters. This is a thumbnail version 
of a Point Pane, allowing multiple Faceplate Panes to be displayed on one screen. 

Off Screen Function Key (OSFK) Pane 
 This Pane has dimensions that are dependent on the size of the Target Screen. It is used to 

configure the operation of the function keys (Fn) for Target Screen types that support off 
screen keys, and is displayed below the pane when viewing or editing a page. 

Dialogue Box Pane This is similar to a Pop-up pane, but is invoked by the system rather than by the operator. It 
is often used to display warnings and system messages. 
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3.1.2  PAGES AND PANES (Cont.) 

CREATE/EDIT A PAGE 

Pages are the individual displays that correspond to the actual panel screens or part of the panel screen in the 
Target Instrument depending on the Pane selected in the New Page dialogue. 

12. Click the New Page button to display the New Page dialogue.  Alternatively, select the Page Set > New 
Page… command. 

13. Edit the Page Name and ID parameters. 
Enter a concise name in Name field to describe the function of this Page. This Page Name is displayed 
in the Title bar for use in the User Screen Editor only, as the Page icon name.  An ID number entered 
in the ID field to the right must accompany the Name field. Any value between 1 and 999 can be 
used. 

NOTE 

The 'home page' is normally assigned an ID of '1'. This is usually the power-up and timeout page, and is 
accessible from the top-level menu. 'Built-in' pages have IDs > 999. 

14. Edit the Page Title parameters. This is title of the Page as it appears on the instrument display. 
For a fixed title, simply type the required character string into the Title field.  Check the Use 
Dictionary box if you want the title to change if the language is changed. Enter the corresponding 
user-dictionary reference number in the Dictionary Entry No field, e.g. 'U123'. At runtime, the current 
user dictionary is consulted and the string referred to by the specified reference is displayed as the 
title. 

15. Edit the Target field. Only the Pane field can be edited. 
Select the required Pane type from the drop-down list.  All other fields were defined when the Page 
Set was created. 

NOTE 
These fields become Read Only when the New Page dialogue is complete and accepted. 

16. Edit the Legend parameters. 
For a fixed legend, simply type the required character string into the Legend field.  Check the Use 
Dictionary box if you want the legend to change if the language is changed. Enter the corresponding 
user-dictionary reference number in the Dictionary Entry No field, e.g. 'U123'. At runtime, the current 
user dictionary is consulted and the string referred to by the specified reference is displayed as the 
title. 

17. Edit the Access Level parameters. 
Always Accessible is selected by default. It indicates that this Page is unrestricted.  Accessible if the 
Operator Level is >= indicates that only Operators assigned to an Access Level greater than or equal 
to the value specified can interact with this Page. The value can be changed using the up/down 
buttons or simply by typing in the required Access Level number, 1 to 4. 

18. Edit the Description parameter. 
Enter a Page Description. This is user-information only, and is intended as an aid to maintainability, 
and is not transferred to the runtime system. 

19. Press, OK to confirm the Page parameters and close the dialogue, or Cancel to ignore the Page 
parameters and close the dialogue. 

The (blank) Page now appears on the Editor worksheet in its own window, entitled with the Page Set Name, and 
ID and the Page name that was configured in this dialogue. 
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3.1.3 Page items 
A Page Item is defined as any WYSIWYG (What You See Is What You Get) element, textual or pictorial, that can 
be placed on a Page. By WYSIWYG is meant that the Page Item on the Editor worksheet page closely resembles 
the corresponding display in the Target Instrument. 

Page Items have a variety of configurable attributes - 'properties' - associated with them, that determine the 
on-screen appearance and how they behave dynamically in the Target Instrument display. 

Example property types include: appearance (line weight, colour, etc.), text (font, flashing, etc.), variable (linked 
variable name, cold start value, etc.), and format (decimal places, date format, etc.)  

After creating a Page Item, it must be configured using the appropriate values. The subset of properties 
associated with each type of Page Item differs from item to item. Help topics describe the complete set of 
properties currently offered by the User Screen Editor. 

You can create two types of Page Item on a Page: Static and Dynamic. 

STATIC PAGE ITEMS 

A Static Page Item is one that has not been linked to the LIN Database and does not change its appearance in 
the display. Such Page Items usually include text, lines, rectangles, etc. They are used to construct the static 
parts of the screen display. 

NOTE 
These Page Items can be configured to change colour dynamically if required. 

DYNAMIC PAGE ITEMS 

A Dynamic Page Item is a Page Item that is linked to a point in the LIN Database running in the Target 
Instrument, and responds in a specified way to the value of that point. 

Some Dynamic Page Items change appearance continuously with the value of the linked point (e.g. bar graphs, 
text variables) and so can give an indication of its current value at any time. 

Others may alter only when the linked variable moves into or out of default value ranges. 

All Page Items (except OIFLs and Touch Areas) can be configured to change colour or brightness with changes 
in a LIN Database variable. 

CREATE/EDIT A PAGE ITEM 

Page Items are configured using the Page Item Properties dialogue for that particular Page Item type. 

Every Page Item Properties dialogue contains a number of pages, each page applying to one of the properties 
applicable to the Page Item selected. 

NOTE 
After opening the required Page, the colour of the User Screen background can be customised using the 
Page > Panel Colour command. 

CUSTOMISE THE USER SCREEN BACKGROUND COLOUR 

The Panel colour palette permits selection of a colour for the screen of the Target Panel. A range of colours is 
displayed on the ‘Color’ palette dialogue. 
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3.1.3  PAGE ITEMS (Cont.) 

TO SELECT A PANEL COLOUR: 

20. Open the required Page. 

21. Select Page > Panel Colour to reveal the Color dialogue. 

22. Select the colour and confirm using the OK button. 

3.1.4 To Define customised colours 
All colours can be customised using the colour editing palette displayed when the Define Custom Colors button 
is pressed. 

23. Open the Colors palette dialogue. 

24. Select the required colour and confirm using the OK button.  Alternatively, define a customised colour 
palette using the Define Custom Colors button to reveal additional colour editing palette. 

25. Select a vacant custom colour slot, and adjust the colour using the numeric fields or the cross-hair on 
the colour spectrum screen beside. 

26. When satisfied, press the Add to Custom Colors button. 

27. Now, select the required colour and confirm using the OK button. 

NOTE 
Up to sixteen customised colours can be stored using the vacant Custom colors slots. 

TO EDIT PAGE ITEM PROPERTIES: 

28. Double-click the Page Item with the left mouse button to display the Page Item Properties dialogue.  

29. Alternatively, to display the Page Item Properties dialogue, select the Page Item on the worksheet, 
then right-click the Page Item and select Properties from the pop-up menu,  
or click Edit > Properties > Page Item… 

NOTE 
To select a Page Item click anywhere on or within its outline. This applies to unfilled as well as to filled 
shapes. 

30. The Page Item Properties dialogue appears, displaying all the pages applicable to the selected Page 
Item. 

31. Select each page in-turn, editing the parameters as required.  Individual text strings can be found 
and/or replaced using the Search command to reveal the Find dialogue. 

32. Press OK to confirm the parameter changes and close the dialogue, or Cancel to ignore the changes 
and close the dialogue. 
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3.2 REPORT WINDOW 
This window records the operation it attempts and displays any validation warnings or errors it may have found. 
Validation involves checking that the data is complete and that it is consistent with the LIN Database file (.dbf), 
i.e. the referenced LIN fields exist in the LIN Database file (.dbf) and are of the correct type. 

Validation is carried out when, 

the Verify Page Set command is selected 

a Page Set file is loaded 

a Page Set file is saved 

a Page Set file is closed 

Tip! 
Double-click an error or warning record to access the application needed to correct the problem. 
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3.3  LIN DATABASE BROWSER 
Use the LIN Database Browser dialogue to select a Variable or function block in the associated LIN Database, 
for linking to a Dynamic Page Item. 

 

3.3.1 Associating a LIN Database with the Page Set 
The reason for associating a LIN Database with Page Set is to allow Dynamic Page Items to display defined 
points in the LIN Database running in the during runtime. 

NOTE 
LIN Databases are associated with a Page Set using either the New Page Set or the Page Set Properties 
dialogues. 

 

33. A LIN Database can be associated when first creating a Page Set. Select the File > New Page Set 
command to display the New Page Set dialogue.  Alternatively, select File > Properties > Page Set to 
display the Page Set Properties dialogue. 

34. The required LIN Database filename can be entered in the Location of DB file for Page Set field.  If the 
LIN Database filename (. dbf) is unknown, press the Browse… button to reveal the Open dialogue to 
help locate the LIN Database filename. If the LIN Database functions are unavailable because the LIN 
Database file (.dbf) failed to load, the LINDBIF.dll could be missing. 

35. Press OK to confirm LIN Database selection. 
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3.3.1  ASSOCIATING A LIN DATABASE WITH THE PAGE SET (Cont.) 

USING THE BROWSER WINDOW 

The action of the LIN Database Browser is context-sensitive. It displays only the LIN function blocks and fields 
relevant to the current page item property. 

3.3.2 Instrument browser 
This is an example of a partially designed Page Set for a defined Target Screen type. 
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4 TARGET DEFINITION 

A Target is an Instrument manufactured with a specific screen type. The screen type capabilities are pre 
specified in a Target Definition file.  All existing Target Screen type templates can be edited using the Target 
Panels dialogue. 

Each Target Definition file contains all relevant information about the screen type, i.e. overall screen size, what 
Panes, Drawing tools, Capabilities (such as, Signing (21CFRpt11), or Touch Areas) are supported. 

NOTE 
Customised Target Screen types can be created. This is not recommended as each file (.uxt) contains the 
unique default configuration of the selected Target Screen type. 

 

Beware… 
Target Definition (.uxt) files should NOT be created or edited by users who are not fully competent to do 
so. Otherwise, Target Definition files may be created that are NOT compatible with any of the 
manufacturers Target Screen types. In such as case, pages using incompatible Target Definition files will 
have to be redrawn in their entirety using the appropriate Target Definition file. 

4.1 HOW TO CREATE A TARGET SCREEN TYPE 
Select the Target Definitions command, File > Target Definitions, to display the Target Panels dialogue. 
Alternatively, press <Crtl + T>. 

NOTE 
The Target Definition may be password protected. If either the Default Password or changed Password is 
configured any attempt to open this dialogue will request a password to continue. 

Press ‘New’ to initiate the Target Panel wizard. The first dialogue of the Target Panel wizard appears. 
Enter an appropriate template name for the Target Screen type being created.  Select the Target Instrument 
and Target Screen type (Pixel based or character based). 
Select the type of database the Target Instrument uses (LIN Database or SIB, (not supported - greyed out)). 
Press ‘Next’ to continue. 

Enter the required Target Screen type size in pixels.  Enter the width of the Target Screen type.  Enter the 
height of the Target Screen type. 
If the Character based screen type was selected previously, additional width and height characters parameters 
are requested.  Press ‘Next’ to continue. 

Select the colour capabilities of Target Screen type. 
Select a radio button to specify the colour capabilities supported by the Target Screen type. 
Press ‘Next’ to continue. 

Select the interactive capabilities of Target Screen type. 
Select the appropriate checkboxes to specify the interactive capability supported by the Target Screen type. 
Press Next to continue. 
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4.1  HOW TO CREATE A TARGET SCREEN TYPE TEMPLATE (Cont.) 

Select the screen indication capabilities of Target Screen type. 
Select the appropriate checkboxes to specify the indication capability supported by the Target Screen type. 
Press ‘Next’ to continue. 

Select the screen Chart Drawing capabilities of Target Screen type. 
Select the appropriate checkboxes to specify the Chart Drawing capabilities supported by the Target Screen 
type.  Press ‘Next’ to continue. 

Select the General Drawing capabilities of Target Screen type. 
Select the appropriate checkboxes to specify the Drawing capabilities supported by the Target Screen type.  
Press ‘Next’ to continue. 

Select the Object Drawing capabilities of Target Screen type. 
Select the appropriate checkboxes to specify the Object Drawing capabilities supported by the Target Screen 
type.  Press ‘Next’ to continue. 

If the Pixel based display was selected previously in step 2 continue from step 12. 
If the Character based display was selected previously in step 2 the additional parameters must be completed. 

Select the Character Drawing capabilities of. 
Select the appropriate checkboxes to specify the Character Drawing capabilities supported by the Target Screen 
type.  Press ‘Next’ to continue. 

Select the Character Underline capabilities of Target Screen type.   
Select the first checkbox to specify the Character Underline capabilities supported by the Target Screen type. 
Enter the number of special underline sections the Target Screen type has and the height of the character cells 
in pixels. 
Select the last checkbox to permit the use of underline section in Bar Charts. Press ‘Next’ to continue. 

Enter an appropriate filename for the Target Screen type being created. 
Press Finish to save the Target Screen type to the User Screen Editor > Targets directory. 

The Target Screen type is created, however it must now be selected to define the Target Screen type. 

4.2 HOW TO EDIT THE TARGET SCREEN TYPE 
All Target Screen type templates can be edited via the Target Properties dialogue.  Either press the Edit button 
on the Target Panels dialogue or double-click the required Target Screen type. 

Select the Target Definitions command, File > Target Definitions, to display the Target Panels dialogue. 
Alternatively, press <Crtl + T>. 

NOTE 
The Set Password button is used to restrict access to the Target Panels dialogue. If a Password is configured any 
attempt to open this dialogue will request a password to continue. 

Select the Target Screen type. 
Press Edit to display the Target Properties dialogue.  Edit each page in turn as required.  Press the appropriate 
button to continue: OK to accept the changes and close the dialogue,  Cancel to ignore any changes and close 
the dialogue.  Apply to accept the changes, but continue to edit the Target Properties. 
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5 MENUS 

The Menu Bar is a special toolbar at the top of the screen that contains 7 pulldown functions. Each pulldown 
displays a list of commands. 

 

5.1 FILE MENU 

 
The File pulldown enables the User to manage the User Screen Editor by offering the following commands. 

NOTE 
Some commands are only available in certain circumstances. When unavailable, commands are greyed out. 

 
New Page Set Click this to display the New Page Set dialogue allowing the Page Set Properties to be 

configured in readiness for the required Target Instrument Pages. 
Open Page Set Click this to display the Open/Browse dialogue in order to locate an existing Page Set. If 

another instance of the selected file is already open, a message appears asking if a new 
instance of the page set is to be opened, or if the existing instance should be switched to. 
Where several instances are open, ‘Switch to…’ always opens the first instance. 

Close Page set Click to close the selected Page Set window.  A prompt dialogue may appear if there are 
unsaved changes. 

Import Page set Click this to display the ‘Open’ dialogue. This allows a Page Set from another source to be 
included in the current Target Instrument. 

Save Click to save the currently open file with its current file name, location, and file format, 
overwriting the existing file. 

Save As… Saves the active file with a different file name, location, or file format. 

Page 30 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

5.1  FILE MENU (Cont.) 
 
Target definitions… Click this to display the Target Panels dialogue. This allows the Target Panel type to be 

specified. 
Options… Click this to display the Options dialogue. This allows the user to change the destination of 

the Target Panel type files and Portmap files using the Browse button. 
Build Output (OIFL) files 

Click this to open the Report Window and build the current Page Set, listing any errors and 
warnings that may cause the Target Instrument to function incorrectly. 

Configure automatic building of output files 
Click this display the Save OIFL dialogue. This allows the configuration of a default response 
to saving an OIFL to be specified. 

 
Print Setup Click this to display the Print Setup dialogue. This configures the paper source, paper size, 

page orientation, and other layout options for the active file. 
Print Preview Click this to display an impression in the Print Preview window of the selected Page when 

printed. 
Print… Click this to display the Print dialogue. This prints the active file or selected items. 
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5.2 EDIT MENU 
The Edit pulldown enables the User to manipulate the current objects by offering the following commands. 

NOTE 
Some commands are available only in certain circumstances. Unavailable commands are greyed out. 

 
Undo Click this to reverse the last command or deletes the last entry you typed. To reverse more 

than one action at a time, click the arrow next to the Redo tool command, and then click 
the actions you want to undo. 

Redo Click this to reverse the action of the Undo command. To redo more than one action at a 
time, click the arrow next to the Undo tool command, and then click the actions you want 
to redo. 

Cut Click this to remove the selected object from the active document and place it on the 
Clipboard. 

Copy Click this to copy the selected object to the Clipboard. 
Paste  Click this to insert the contents of the Clipboard at the insertion point, and replaces any selection. 

This command is available only if you have cut or copied an object, text, or contents of a 
cell. 

Delete Click to remove the selected object from the currently open window. 
Select All Click to select all objects in the currently open window, either Pages in the Page Set or Page 

Items in the Page 
 

NOTE 

Multiple objects or files can be selected individually while pressing the <Ctrl> key, or a consecutive group of 
files by selecting the first file, then while pressing the <SHIFT> key, click the last file. 

 
Save to Library… Click this to store a copy of the selected object or grouped objects to the User Screen Editor 

library. The Library can store commonly used Page Items. 
Load from Library...Click this to display the library of commonly used Page Items. 
Find… Click this to display the Find and Replace dialogue. This dialogue permits the User to search 

for specific sequence of characters. When located the results can be sorted in alphabetical 
ascending or descending order. 

Properties Click to reveal a further menu, allowing selection of the Page Set, Page or Page Item. 
Selection displays the appropriate Properties dialogue. 
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5.2  EDIT MENU (Cont.) 
 

FIND DIALOGUE 

Use this to search for a specific text string within a Page Set, and if required, to replace it with another defined 
text string. The fields are: 
Find what Enter the text string that is to be searched for. 
Incremental searching  

Indicates that the search for the specific text string will commence immediately, refining the 
search as characters are added to the text string. 

Exact match Indicates that the search for the specific text string will list only those occurrences that 
match the ‘Find what’ text exactly. 

Match case Indicates that the search for the specific text string will list only those occurrences that 
match the case as entered in the Find what field.  For example, Type in AcSource, not 
Acsource to find the LIN Variable, AcSource. 

Replace Enables the Replace with field, and indicates that any occurrence of the specific text string 
being searched for can be replaced with the text string in the Replace with field. 

Replace with This is the LIN Variable, Instrument Variable, or specific text string that will replace the text 
string entered in the Find what field.  Use the Browse button to display the LIN Database or 
the Instrument Browser dialogue, may assist in locating the required Variable. 

LIN Variable Use this radio button to select to search the LIN Database Variable. Use the Browse button 
to display the LIN Database Browser dialogue, to assist with locating the required Variable. 

Instrument Variable  
Use this radio button to select to search the Instrument Variable.  Use the Browse button to 
display the Instrument Browser dialogue, to assist with locating the required Variable. 

Start search Initiates the search for the text string specified in the Find what field. 
Replace Replaces the selected occurrence of the text string specified in the Find what field with the 

text string in the Replace with field. 
Replace all Replaces all occurrences of the text string specified in the Find what field with the text string 

in the Replace with field. 
Done Closes the dialogue. 
Table Lists all occurrences of the text string specified in the Find what field. 
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5.3 VIEW MENU 
The View pulldown enables the User to control the appearance of Pages displayed in the Page Set window, and 
to select and indicate which toolbars are currently displayed. 

 
Toolbar The Toolbar hosts icon buttons that enable quick access to a limited amount of Edit and 

View commands. It is displayed by default and located at the top of the User Screen Editor. 
Drawbar The Drawbar tools allow the user to create new graphical and text items on the active Page.  

The items may be static, or if linked to an instrument or LIN database can be made to 
change colour, to ‘fiil’ or ‘empty’ etc. according to the value of the variable. 

Textbar The Textbar permits quick access to the Text tools provided, which are used to modify the 
attributes and appearance of Text Page Items on the currently open Page. 

Statusbar The Status Bar displays specific User Screen Editor information, such as, current editor action 
or status, and various properties of the Page Item(s) selected on the page. It is displayed by 
default and located along the foot of the User Screen Editor. 

Large Icon Click to show the contents of the selected Page Set in a standard size icon format. 
Small Icons Click to show the contents of the selected Page Set in a small size icon format. 
List Click to show the contents of the selected Page Set in list format, alphabetically and 

numerically. 
Details Click to show the contents of the selected Page Set in list format, but including further 

specific information for each Page. 

Page 34 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

5.4 PAGESET MENU 
The PageSet pulldown enables the User to manage the Page Set. 

 
 
New Page… Click this to display the New Page dialogue allowing the Page Properties to be configured. 
Open Page Click this to open the Page currently selected in the Page Set. 
Close Page Click this to close the currently open Page. 
Verify Page Set Click this to immediately open the Report Window and build the current Page Set, listing any 

errors and warnings that may cause the Target Instrument to function incorrectly. 
On-line to panel Click this to create a communications link from the current Page Set to the Target 

Instrument, defined in the Location of DB for Page Set in the Page Set Properties dialogue, 
in a live system. 

Show Page Set OIFL Strings  
Click this to display all OIFL Strings used in the current Page Set in a Read-Only OIFL Strings 
for… window. 

5.5 PAGE MENU 
The Page menu allows the User to control the Page Items on the Page. 

 
Show OIFL Strings Click to display the OIFL Strings used on the current Page. The OIFL strings are displayed in a 

Read-Only window. 
Show Cold Start Values 

If this item is selected, the User Screen representation shows the Show Cold Start Value if 
possible, or a series of question marks ( ? ) if the value does not fit the graphic. If not 
selected, or if the values are not available for a particular Variable, the value appears as a 
series of asterisks ( * ). The number of asterisks displayed is equivalent to the number of 
display characters allocated to the variable, which can edited on the worksheet. 

Panel Colour... Click to display the Colour palette dialogue. This allows the user to select the required 
colour for the User Screen of the Target Instrument, defined in the Location of DB for Page 
Set field of the Page Set Properties dialogue, in a live system. 
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5.6 WINDOW MENU 
The Window menu allows the User to the Page Set, and Page locations on the pc screen. 

 
Cascade Click this to display the currently open windows one on top of the other, but in such a way 

that title bar for each window remains visible. 
Tile Click this to display the currently open windows equally in the main User Screen Editor, so as 

to display as much of the window as possible. 
Arrange Icon Click this to display all open files in separate windows on the screen. The Arrange Icon 

command makes it easier to drag between files. 
Current Window Click the required entry to display it as the main window. 

5.7 HELP MENU 

 
Help Opens the on-line help file including Contents, Index, and Search facilities.  <F1> help also 

opens this help file, but at a topic appropriate to the cursor position. 
About User Screen Editor… 

This displays the program details including the name, version number, and description. 
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6 TOOLBARS 

6.1 MAIN TOOLBAR 

 

6.1.1 New Page Set command 

 
Click this to display the New Page Set dialogue allowing the Page Set Properties to be configured in readiness 
for the required Target Instrument Pages 

6.1.2 Open Page Set command 

 
Click this to display the Open/Browse dialogue in order to locate an existing Page Set. If another instance of the 
selected file is already open, a message appears asking if a new instance of the page set is to be opened, or if 
the existing instance should be switched to. Where several instances are open, ‘Switch to…’ always opens the 
first instance. 

 

6.1.3 Save Page Set command 

 
Click this to overwrite the current Page Set information with the current changes. 

6.1.4 New Page command 

 
Click this to display the New Page dialogue allowing the Page Properties to be configured. 
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6.1.5 Open Page command 

 
Click this to open the Page currently selected in the Page Set. 

6.1.6 Close Page command 

 
Click this to close the currently open Page. 

6.1.7 Build Output (OIFL) Files command 
Click this to open the Report Window and build the current Page Set, listing any errors and warnings that may 
cause the Target Instrument to function incorrectly. 

6.1.8 Verify Page Set command 

 
Click this to immediately open the Report Window and build the current Page Set, listing any errors and 
warnings that may cause the Target Instrument to function incorrectly. 

6.1.9 Find command 
Click this to display the Find and Replace dialogue. This dialogue permits the User to search for specific 
sequence of characters. When located the results can be sorted in alphabetical ascending or descending order. 

6.1.10 Open Database command 

  Click this to open the associated LIN Database using the LINtools configurator. 

6.1.11 Back Command 

  This command returns the user to the calling application. For example, if this instance of User Screen Editor 
has been launched from LINtools by double-clicking on ‘User Screen Editor’ in the Tools menu, then clicking on 
this icon returns the focus to LINtools.  

6.1.12 Cut command 
Click this to removes the selected object from the active document and place it on the Clipboard. 

6.1.13 Copy command 
Click this to copy the selected object to the Clipboard. 

6.1.14 Paste command 
Click this to insert the contents of the Clipboard at the insertion point, and replaces any selection. This 
command is available only if you have cut or copied an object, text, or contents of a cell. 
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6.1.15 Undo command 
Click this to reverse the last command or deletes the last entry you typed. To reverse more than one action at a 
time, click the arrow next to the Redo tool command, and then click the actions you want to undo 

6.1.16 Redo command 
Click this to reverse the action of the Undo command. To redo more than one action at a time, click the arrow 
next to the Undo tool command, and then click the actions you want to redo. 

6.1.17 Zoom Factor command 
Click this to display the top left corner of the Page at the Zoom Factor indicated. 

6.1.18 Whats This? command 
Click this to display a simple explanation of the next selected User Screen Editor command. 

6.2 STATUS BAR 
The Status Bar displays specific User Screen Editor information, such as, current editor action or status, and 
various properties of the Page Item(s) selected on the page. It is displayed by default and located along the foot 
of the User Screen Editor. 

 
VIS: This field shows the Access State of the selected Page Item as defined in the objects 

Properties dialogue. 
WRI: This field shows the Variable State of the selected Page Item as defined in the Page Item 

Properties dialogue. 
MAX: This field shows the High Limit, if supported by the selected Page Item, as configured in the 

Limit Page of the Page Item Properties dialogue. 
MIN: This field shows the Low Limit, if supported by the selected Page Item, as configured in the 

Limit Page of the Page Item Properties dialogue. 
X: Y: This field shows the page co-ordinates in Pixels of the most upper left point of the selected 

Page Item. 
W: H: This field shows the Width and Height in Pixels of the selected Page Item. 
total items This shows the total number of Page Items used and how many are currently selected on 

this Page. 
Communications Status 

This indicates the communication status of the User Screen Editor, e.g. that it is 
communicating with the Target Instrument in a live system. 

Time This indicates to current time according to the location of the User Screen Editor. 
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6.3 TEXT BAR 
The Text bar permits quick access to the Text tools provided, which are used to modify the attributes and 
appearance of Text Page Items on the currently open Page. 

 

6.3.1 Font style command 

 
Click this to select a font type for the currently selected Text Page Item. 

6.3.2 Align Text Left command 

 
Click to align the selected Text Page Item within the available text frame, to the left. 

6.3.3 Align Text Left-biased Centre command 

 
Click to align the selected Text Page Item, within the available text frame, to the centre with a left-hand bias. 
Text is aligned to the nearest character width. ‘Left-biased Centre’ biases the alignment one character-width to 
the left when the string cannot be positioned in the exact centre. 

6.3.4 Align Text Right-biased Centre command 

 
Click to align the selected Text Page Item within the available text frame to the centre with a right-hand bias.  
Text is aligned to the nearest character width. ‘Right-biased Centre’ biases the alignment one character-width to 
the right when the string cannot be positioned in the exact centre. 

6.3.5 Align Text Right command 

 
Click to align the selected Text Page Item within the available text frame to the right. 
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6.4 PLACEMENT BAR 
The Placement bar tool icons allow the user to manipulate the position and orientation of a selected Page Item.  
The default position for this toolbar is vertically, against the right-hand side of the screen.  For convenience, it 
is shown here detached and horizontal. 

Not all tools are enabled for all page items.  Disabled tools are greyed out. 

 

 Bring to front.  Click to bring the selected Page Item to the front of the page, i.e. to the top layer. 

 Send to back.  Click to send the selected Page item to the back of the page, i.e. to the bottom layer. 

 Bring Forward. Brings the selected item forward (up) one layer. 

 Send backward.  Sends the selected item back (down) one layer. 

 Group. Places all selected items in a group. 

 UnGroup.  Ungroups one level of grouping. 

 Flip horizontal.  Flips item or group left-right. 

 Flip vertical.  Flips item or group up/down 

 Rotate clockwise.  Rotates item 90 degrees clockwise. 

 Custom rotate.  Allows the user to enter an absolute angle for the item.   
Increasing angle rotates clockwise. 

 Align objects left.  Aligns left edges of all selected items.  

  Align objects right.  Aligns right edges of all selected items. 

  Align objects top.  Aligns top edges of all selected item. 

  Align objects bottom.  Aligns bottom edges of all selected item. 

 Toggles gridline visibility on and off.  If enabled, ‘Snap to Gridlines’ still operates when grid lines off.  
Gridlines do not appear at the target screen.  

 Grid Colour.  Allows the user to select a colour for the gridlines. 

 Grid settings. Allows the grid and ‘snap to grid’ characteristics to be edited. See ‘Grid settings’, below, 
for further details. 

 Snap object(s) to grid.  If ‘Snap to grid’ is disabled in ‘Grid settings’, then this button can be used to 
snap individual items to the grid if required.  Aligns the top and left edges to the nearest grid line. 
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6.4.1 Grid settings dialogue 

 

Accessed by clicking on the grid settings icon  in the Placement bar.  The tool is disabled for character-based 
targets, where settings are fixed (based on target character cell size). 

 

Tip! 
Turning the Grid on will help when attempting to align Page Items. 

  

NOTE 
A Grid will have the same effect when displayed or hidden. 

MAJOR GRID SETTINGS 

These fields specify the major grid horizontal and vertical spacing. 

MINOR GRID SETTINGS 

The minor grid settings are relative to the top-left corner of each major grid cell (0, 0). 
General grid settings 
Snap to grid Check this to cause the vertices (or bounding-box corners) of Page Item being drawn to 

snap to the grid (whether hidden or not). 
Use minor grid lines for item alignment 
 Check this to make the ‘snap to grid’ (if selected) and ‘nudge items…’ alignment action work 

on the minor grid lines. If left unchecked, only the major grid lines are used. 
Nudge items to nearest grid line 
 Check this to cause highlighted item(s) to jump one grid spacing in the selected direction 

each time a keyboard cursor key is pressed. If unchecked, they jump one pixel only. This 
works even if ‘snap to grid’ is not selected. 

Use dotted lines for grid lines 
 Check this to make the grid lines appear dashed. If unchecked, the grid lines are solid. 

CONFIGURE USING DEFAULT FONT 

Click this button to set the major grid spacing to match the default font cell size -- convenient for laying out 
text. 
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6.4.1  GRID SETTINGS DIALOGUE (Cont.) 

OK 

Click to close the dialogue and enable the grid settings. 

CANCEL 

Click to close the dialogue without altering the existing grid settings. 

6.5 DRAW BAR 
The Draw bar tool icons allow the user to create new and edit existing Page Items.  Generally items are 
positioned on the page by clicking on the tool icon, clicking on the screen to define the top left-hand corner, 
and then without releasing the left mouse key, dragging the bottom right-hand corner of the item to the 
required position.  The size, and aspect ratio of an item on the screen can subsequently be edited using the 
item's handles. The position on the screen is adjusted by click / dragging on the item outline (or if filled, within 
the item). 

The properties of an item (colours, assignment of variables and so on) are set in the properties page associated 
with the item.  This is most readily accessed by double clicking on the item, but it can also be opened by right 
clicking on the item and selecting 'Properties...' or by using the shortcut <Alt> + <Enter>. 

 

 Selection tool.  Used to select an object, or a group of objects for editing. 

 Text tool.  Allows new text to be entered or existing text to be edited. 

 Line tool.  Allows straight lines to be drawn on the screen. 

 Rectangle tool.  Allows rectangles to be drawn.  Squares are deemed to be rectangle with sides of equal 
length. 

 Rounded Rectangle Tool.   Not applicable with this version of software.  Always 'greyed out' (disabled). 

 Ellipse tool.  Allows ellipses to be drawn.  A circle is an ellipse having minor axes the same length as the 
major axis. 

 Triangle tool.  Triangles are drawn with the base horizontal: the corner positions must be edited if any 
other orientation is required. 

 Bitmap tool.  Allows a bitmap image to be placed on the screen.  Initially, this item is drawn with the text 
'Bitmap undefined' inside its area.  The bitmap is defined, by selecting it using the Browse key, as described in 
the Bitmap Properties page topic. 

 Barchart tool.  Allows the inclusion of a barchart display on the screen.  Initially, this is drawn containing a 
question mark to indicate that there is no source defined for the item.  Once a suitable source has been 
selected the question mark disappears.  One way of doing this is to double click on the bar chart and then to 
use the browse key in the resulting 'Bar Chart Item Properties' page to navigate to a suitable  variable which is 
then clicked-on to select it.  See 'Bar Chart Properties page' for more details. 
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6.5  DRAW BAR (Cont.) 

 Trend Graph tool.  Allows a Trend Graph to be incorporated in the user screen. As described for 'Barchart', 
above, it is initially drawn with a question mark within it, and this remains until a variable has been assigned to 
the trend.  See 'Trend Graph Properties page' for more details. 

 Program Profile tool.  Similar to the Trend Graph tool, this allows a set point programmer profile to be 
added to the screen.  This can either be static or dynamic as selected from the Program Profile properties page. 
 The item is initially drawn containing a question mark which remains until a program block has been assigned 
to it.. 

 Text Variable tool.  This allows a 'dynamic' text string (a process variable value for example) to appear on 
the user screen, by linking the text to a database variable.  Initially the item appears as a string of question 
marks, but once linked to the database, the question marks change to a asterisks (*).  If a suitable variable is 
selected, the Enumerations area of the Text Variable Properties page can be used to change text strings 
according to the value of the variable.  Further, for supporting instruments only, if a suitable variable is 
selected, then the text variable can be configured such that  the actual text string displayed at the instrument's 
operator interface can be selected, by the user, from a drop down (combo) list. 

 Touch Area tool.  This allows an area of the screen to become touch sensitive.  The action(s) to be carried 
out when this area of screen is touched are defined in the Touch Area properties page, described in a separate 
topic.  The touch area is invisible at the Operator interface, but it can be overlaid by another suitable item if 
required,   Alternatively other page items, such as triangles, rectangles etc. can be made touch sensitive by 
configuring the 'Touch Area' tab of their properties page appropriately. 

 Button Tool.  Allows a 'button' to be positioned on the screen.  Buttons are items that are touch sensitive; 
the action(s) to be carried out  being configured in the 'Touch Area' tab of the Button Tool Properties page.  

 OIFL tool.  This allows an area containing Operator Interface Language text to be positioned on the screen. 
 See the 'OIFL properties page' topic for further details.  

Line / Text Colour.  This defines the default colour for Text and Line page items.  Text 
appears on a background colour defined in the Fill / Background, but line items such as rectangles, triangles 
etc. are filled only if 'Object is filled' is enabled in the item's properties.  The required colour is selected from a 
pull down palette which appears when the down arrow is clicked-on. 

 Fill/Background colour.  This defines the default background colour for text (which appears 
in the Foreground colour), and the fill colour for any line item which has 'Object is filled' enabled in its 
properties page.  The required colour is selected from a pull down palette which appears when the down arrow 
is clicked-on 
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7 HOW TO... 

7.1 SPECIFY/CONFIGURE A TARGET SCREEN TYPE 
This indicates the specific Screen type, including the supported capabilities, fitted in the Target Instrument.  To 
configure a target screen: 

Select the Target Definitions command, File > Target Definitions, to display the Target Panels dialogue. 
Alternatively, press <Crtl + T>. 

This dialogue shows a list of pre-defined Target Screen types.  Either: 
Press ‘New’ to initiate the Target Panel wizard and create a Customised Target Screen type template, 
Click a pre-defined Target Screen type and press ‘Edit’ to reveal the Target Properties dialogue allowing these 
properties to be edited, or  
Click a pre-defined Target Screen type and press ‘Remove’ to delete the Target Screen type template after 
confirmation. 

Click a Target Screen type and press ‘OK’ to accept. 

NOTES 

The Target Definition may be password protected. If a Password is configured any attempt to open this dialogue 
will request a password to continue. 

Customised Target Screen types can be created. This is not recommended as each file (.uxt) contains the unique 
default configuration of the selected Target Screen type. 

See also: Create a Target Screen type,  Edit a Target Screen type  

7.2 SPECIFY CHARACTER MAPPINGS 
To allow the User Screen Editor to draw realistic character-based lines in a similar way, the required characters 
must be mapped to each of these special line-segment symbols. The mapping is configured via a graphical 
character-symbol map as follows:. 

Access the Target Properties dialogue for the character-based Target Screen type and click the ‘Mappings’ tab 
to see the Mappings page. 

Click the Character drawing capability checkboxes according to whether the Target Screen type has characters 
for drawing straight lines and/or 45° lines. 

In the Character description field, select a character from the dropdown menu, and type in the corresponding 
ASCII code (0-255). This code maps the particular character to its image in the font bitmap that will be active 
when character lines are drawn on the User Screen Editor worksheet. 

Map the remaining graphics characters to their ASCII codes, then click 'OK' to store your entries and return to 
the Target Panels dialogue. 
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7.3 ASSOCIATE A LIN DATABASE WITH A PAGE SET 
Associating a LIN Database with a Page Set allows Page Items to display LIN database points, dynamically, during 
runtime. 

NOTE 
LIN Databases are associated with a Page Set using either the New Page Set or the Page Set Properties 
dialogues. 

A LIN Database can be associated when first creating a Page Set. Select the File > New Page Set command to 
display the New Page Set dialogue.  Alternatively, select File > Properties > Page Set to display the Page Set 
Properties dialogue. 

The required LIN Database filename can be entered in the Location of DB file for Page Set field. 

If the LIN Database filename (. dbf) is unknown, press the Browse… button to reveal the Open dialogue to help 
locate the LIN Database filename. 

If the LIN Database functions are unavailable because the LIN Database file (.dbf) failed to load, the LINDBIF.dll 
could be missing. 

Press OK to confirm LIN Database selection. 

7.4 SHOW COLD START VALUES 
If the LIN Database for the current Page Set is configured and specified at the Page Set Properties dialogue in 
the ‘Location of DB file for Page Set’ field, selecting Show Cold Start Values command will display actual Cold 
Start Values instead of asterisks ( * ) in screen Page Items incorporating a Variable (e.g. Text Variables). 

With ‘Show Cold Start Values’ selected, the User Screen representation shows the Show Cold Start Value if 
possible, or a series of question marks ( ? ) if the value does not fit the graphic. 

If  ‘Show Cold Start Values’ is not selected, or if the values are not available for a particular Variable, the value 
appears as a series of asterisks ( * ). The number of asterisks displayed is equivalent to the number of display 
characters allocated to the variable, which can edited on the worksheet. 

7.5 VERIFY A PAGE SET 
This command starts the verification process ensuring the currently open Page Set has been correctly 
configured and builds the Target Instrument screens. It can be performed at any time, giving an up to date 
report of the Page Set. 

Beware… 
You MUST verify a Page Set and eliminate all problems before downloading to the Target Instrument. 

Failure to do so will result in downloading Pages (screens) to the instrument, which may be incorrect. 
This could cause problems with the operation of the instrument. 

To resolve this problem, 
Follow the instructions below. 

                                                                 (Continued) 
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7.5.1 To verify a Page Set 
Initiate Page Set verification by clicking the ‘Verify Page Set’ button or by selecting Page Set > Verify Page Set 

The Report Window is revealed and verification of the Page Set is started. This window records the operations it 
attempts and any warnings or errors it may have found. These can be used to help diagnose and correct 
problems. 

 

Tip! 

Double-click an error or warning record to access the application needed to correct the problem. 

EXAMPLES 

“Warning: Database Not Defined. Variable references will not be verified.” 
This indicates that one or more Variables have been specified incorrectly. 

 

“Build finished: no errors and no warnings.” 

This indicates a completely successful result. 

 

7.6 USE THE FIND DIALOGUE 
The Find dialogue permits the User to search for a specific text string within a Page Set, and if required, replace 
with a LIN Variable, Instrument Variable, or another defined text string. 

7.6.1 To find all occurrences of a text string 
Select the Search command, Edit > Search, to display the Find dialogue. 

In the Find what field, enter the text string to be located. 

Tip! 
Use wildcard characters or enter only part of the required sequence of characters to broaden the results. 
By using the ‘%’ wildcard character any single character is found; a search for ‘s?t’ finds ‘sit’ and ‘set’ and 
the ‘*’ wildcard character finds any multiple characters in a string of text, a search for ‘s*t’ finds ‘seat’, 
‘sent’ and ‘settlement’. 

Refine the search criteria, if required. 
Use the Incremental Searching checkbox to start searching the Page Set as the first character is entered. As 
characters are added the occurrences that match the text string appear in the table. 
Use the Exact match checkbox to find only occurrences that are identical to the text string in the Find what 
field. 
Use the Match case checkbox to find only occurrences that are identical to the text string in the Find what 
field. 

NOTE 

Incremental searching can improve response time when searching for a text string across many Pages. 

If the text string in the Find what field must be replaced, select the Replace checkbox to enable Replace with 
field. Use the LIN Variable radio button, Instrument Variable radio button and Browse button to specify what 
the text string in the Find what field must be changed to. 

Press the Start search button to initiate the search for the text string entered in the Find what field. As each 
occurrence is located it is listed in the table below the Replace with field. 
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7.6.1  TO FIND ALL OCCURENCES OF A TEXT STRING (cont.) 

Edit the occurrences as appropriate. 
Move directly to an occurrence by double-clicking the list item. 
Select a single list item and replace the selected text string occurrence with the text string in the ‘Replace with’ 
field by pressing the ‘Replace’ button. 
Replace all occurrences of the selected text string with the text string in the ‘Replace with’ field by pressing the 
‘Replace all’ button. 

Press ‘Done’ to close the Find dialogue. 

7.7 SET DEFAULT OFF SCREEN FUNCTION KEY (OSFK) PANE 
If more than 2 Off Screen Function Key (OSFK) Panes have been configured in the Page Set a default must be 
specified. 

Determine which Off Screen Function Key (OSFK) Pane is required. 

Select the required OSFK Pane to reveal the context-sensitive menu and select the Set As Default command. 
This is now the default OSFK pane, with a page ID of 998. 

7.8 WRITE PAGE ITEM ACTIONS 
Structured Text (ST) strings are limited to the form "<name>:=<value>;", where <name> is the name of a LIN 
Database field or subfield enclosed in square brackets, and <value> is a string representing the value to be 
assigned. 

The value string may be enclosed in single quotes, and may then make use of standard Structured Text (ST) ‘$’ 
escape sequences. 

Alternatively, it may be unquoted, in which case it is terminated by ‘;’ or a space. 

Space characters are permitted either side of ":=" and before the ‘;’. The effect of the assignment will be the 
same as if the value string had been typed in via LINtools. 

For numeric or Boolean variables, <value> may also be a limited form of Structured Text (ST) expression, 
involving only fields within the function block being assigned. 

7.8.1 Example 
ST:"[PID1.SL]:=SL+10.0;" (increments SL when button pressed). 

7.8.2 Structured Text syntax 
Page Item Actions are written using Structured Text. When writing Page Item Actions the following Structured 
Text syntax must be used. 

[...] indicates ‘optional’, 

{...} indicates ‘one or more’, 

‘|’ indicates alternatives. 

7.8.3 Action Lists 
<Action List> ::= <Action> [{ ‘,’ <Action> }] 

7.8.4 Actions 
<Action> ::= <Action Mnemonic> [{ ‘:’ <Action Qualifier> }] 
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7.8.5 Action qualifiers 
The following syntax is generic, and depends on specific User Screen Editor action type: 

<Action Qualifier> ::= <Decimal Number> | <String> 

<Decimal Number> ::= [‘-‘] { <Digit> } 

<Digit> ::= ‘0’ | ‘1’ | . . . | ‘9’ 

<String> ::= ‘ " ’ [{<Character>}] ‘ " ’ 

The possible values of <Character> are context specific. The character ‘ " ’ is obtained using repeated double 
quotes, e.g.: 

ST:"[TimeDate.Date1]:=""18-07-05"";" 

The permitted number and type(s) of qualifiers are action-specific. 
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7.9 USE THE TEXT BAR COMMANDS TO... 

7.9.1 Edit Text 

TO ADD A TEXT ITEM: 

Click the Text Tool. 

Position the text-cursor at the start of the proposed text item. 

Type in the required text characters. 

TO EDIT EXISTING TEXT ITEMS: 

Click the Text Tool. 

Click the existing text item at the required position to insert a text cursor. 

Type in or delete (backspace) characters as required. 

NOTE 

The Text tool is disabled if the target has no Fonts specified. 

 

7.9.2 Edit the Font Style 
Click the Text Tool. 

Select all the required text in the Text Frame. 

Pull down the menu of fonts (from those configured for the target) and click your selection. 

NOTE 

A font can also be selected from the Page Item’s Text Properties page, or Text Variable Properties page. 

 

7.9.3 Align Text to the left 
This command is useful when attempting to align text that may vary in length, such as Variable value or 
Language variant legends. 

Click the Text Tool. 

Select all text in the Text Frame. 

Then, click the Align Text Left tool command. 

NOTE 
Text can also be aligned using the item’s Text Properties page, or Text Variable Properties page. 
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7.9.4 Align Text to the centre with Left-Bias 
Useful when attempting to align text that may vary in length, such as Variable value or Language variant 
legends.  Text is aligned one character to the left if it cannot be centred exactly. 

Click the Text Tool to load the cursor with the Text Page Item. 

Select all text in the Text Frame. 

Then, click the Align Text Left-Bias tool command. 

NOTE 

Text can also be aligned using the item’s Text Properties page, or Text Variable Properties page. 

 

7.9.5 Align Text to the right 
This command is useful when attempting to align text that may vary in length, such as Variable value or 
Language variant legends. 

Click the Text Tool to load the cursor with the Text Page Item. 

Select all text in the Text Frame. 

Then, click the Align Text Right tool command. 

NOTE 

Text can also be aligned using the item’s Text Properties page, or Text Variable Properties page. 

 

7.9.6 Align Text to the centre with Right-Bias 
This command is useful when attempting to align text that may vary in length, such as Variable value or 
Language variant legends. Text is aligned one character to the right if it cannot be centred exactly. 

Click the Text Tool to load the cursor with the Text Page Item. 

Select all text in the Text Frame. 

Then, click the Align Text Right-Bias tool command. 

NOTE 

Text can also be aligned using the item’s Text Properties page, or Text Variable Properties page. 
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7.10 USE THE DRAW BAR COMMAND TO... 

7.10.1 Select or Edit a Page Item 
This allows the User to select a Page Item or group of Page Items before editing to achieve the required effect. 

Click the Selection tool, then 

To select a Page Item: left-click on or within a Page Item. 

To extend the selection: click more Page Items whilst holding <Ctrl> down. 

To reduce the selection; click previously selected Page Items while holding <Ctrl> down. Each previously 
selected Page Items Page Item is deselected. 

To multiple-select: click the page background (not an item), drag out a box to surround the Page Items, then 
release the mouse button.  Surrounded Page items are selected. 

To move selected Page Items: drag the selected Page Items to the new location. 

To reshape a selected Page Item: drag a handle. 

7.10.2 Add a Bar Chart 
This allows the User to include a Bar Chart on the current Page in order to display a specific point in the LIN 
Database and dynamically change its appearance to indicate varying point values. 

Click the Bar Chart tool to load the cursor with the Bar Chart object. 

Position the cross-cursor at a corner of the proposed Bar Chart. 

Hold down the left mouse button and drag to define the size and shape of the Bar Chart. 

Release to fix the opposite corner. 

The bar chart appears by default as a ‘left-to-right’ fill Bar Chart labelled with ‘?’. 

NOTE 

The Bar Chart tool is disabled for targets not supporting bar charts. Character targets using underline 
characters for Bar Charts can draw them only within the underline character areas. 

 

7.10.3 Add a Bitmap 
This allows the User to include a Bitmap Page Item on the current Page to display a specific Bitmap graphic. 

Click the Bitmap tool to load the cursor with the Bitmap object. 

Position the cross-cursor at a corner of the proposed bitmap. 

Hold down the left mouse button and drag to define the size and shape of the bitmap. 

The bitmap appears as a shaded area labelled <’Bitmap Undefined’>. 

NOTE 

The Bitmap tool is disabled for all character targets, and pixel targets not supporting bitmaps. 

 

Page 52 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

7.10.4 Add a Button 
This allows the User to include a Button Page Item on the current Page. This Page Item can be configured in 
conjunction with Structured Text and/or the Touch Area Page Item in order to initiate a specified activity, e.g. 
go to another display page, or execute an ‘action’. 

Click the Button tool to load the cursor with the Button object. 

Position the cross-cursor at a corner of the proposed Button. 

Hold down the left mouse button and drag to define the size and shape of the Button. 

Release to fix the opposite corner. 

NOTE 

The Button tool is disabled if the target has no Fonts specified. 

 

7.10.5 Add a Text Variable 
This allows the User to include a Text Variable Page Items on the current Page to display a specific LIN Database 
value. 

Click the Text Variable tool to load the cursor with the Text Variable object. 

Position the cross-cursor at the start of the proposed text variable. 

Hold down the left mouse button and drag rightwards. 

Release to fix the length of the Text Variable. 

The Text Variable appears as a row of ‘?’ characters. 

NOTE 

The Text Variable tool is disabled if the target has no Fonts specified. 

 

7.10.6 Add a Touch Area 
This allows the User to include a Touch Area Page Items on the current Page for the purpose of navigation 
between Target Instrument Pages and/or Panes. 

Click the Touch Area tool to load the cursor with the Touch Area object. 

Position the cross-cursor at a corner of the proposed Touch Area. 

Hold down the left mouse button and drag to define the size and shape of the Touch Area. 

Release to fix the opposite corner. 

The Touch Area appears as a shaded box labelled ‘Touch Area’. 

NOTE 

The Touch Area tool is disabled for targets not supporting touch areas. 
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7.10.7 Add a Trend Graph 
This allows the User to include a Trend Graph Page Item on the current Page to display variable point values in 
the LIN Database against time. 

Click the Trend Graph tool to load the cursor with the Trend Graph object. 

Position the cross-cursor at a corner of the proposed Trend Graph. 

Hold down the left mouse button and drag to define the size and shape of the trend. 

Release to fix the opposite corner. 

The Trend Graph appears by default as a ‘horizontal scroll’ trend labelled with ‘?’. 

NOTE 

The Trend Graph tool is disabled for targets not supporting Trend Graphs. 

 

7.10.8 Add a Program Profile 
This allows the User to include a Program Profile Item on the current Page. 

Click the Program profile tool (enabled only for instruments which support Program Profiles). . 

Position the cross-cursor at the top left-hand corner of the proposed position. 

Hold down the left mouse button and drag to define the size and shape of the item. 

Release to fix the opposite corner. 

The Profile appears by default labelled with ‘?’.  Once a variable has been assigned, the question mark 
disappears. 

7.10.9 Add an OIFL Object 
This allows the User to include a OIFL Page Item for the purpose of adding specified OIFL code, generated from 
other objects on the page. It allows any advanced or new features to be driven from a Page Set. 

To add an OIFL object: 

Click the OIFL tool to load the cursor with the OIFL object. 

Position the cross-cursor at a corner of the proposed OIFL object. 

Hold down the left mouse button and drag to define the size and shape of the object. 

Release to fix the opposite corner. 

The OIFL object appears as a shaded box labelled ‘OIFL’. 
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7.10.10   Draw a Line 
This allows the User to draw a Line Page Item between two points on the current Page. 

Click the Line tool to load the cursor with the Line object. 

Position the cross-cursor at the start of the proposed line. 

Hold down the left mouse button and drag the cursor to size the line. 

Release the mouse button to fix the line endpoint. 

NOTE 

The Line tool is disabled for character targets not supporting angled line draw characters. Character-based 
targets approximate to the ideal line, in a rectangular bounding-box. 

 

7.10.11   Draw a Rectangle 
This allows the User to draw a Rectangle Page Item between a top-left point and a second bottom-right point 
on the current Page. 

Click the Rectangle tool to load the cursor with the Rectangle object. 

Position the cross-cursor at a corner of the proposed rectangle. 

Hold down the left mouse button and drag the cursor to size the rectangle. 

Release the mouse button to fix the opposite corner. 

NOTE 

The Rectangle tool is disabled for character targets not supporting straight line draw characters. 

 

7.10.12   Draw a Rounded Rectangle 
Not used with this issue of software 

7.10.13   Draw a Triangle 
This allows the User to draw a Triangle Page Item between a top-left point and a second bottom-right point on 
the current Page. The dimensions of the Triangle Page Item can also be changed. 

Click the Triangle tool to load the cursor with the Triangle object. 

Position the cross-cursor at a corner of the proposed triangle’s bounding-box. 

Hold down the left mouse button and drag the cursor to size the triangle. Release the mouse button. 

The result is an upright isosceles triangle with base defined by the base of the box, and peak located at the top-
centre of the box. The shape and orientation of the triangle can be edited. 

To edit a Triangle’s shape and orientation: 

Click the Selection tool. 

Click anywhere on or inside the triangle to be edited and use the cursor to drag corners of the triangle to new 
positions as required. 
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7.10.14   Draw an Ellipse or Circle 
This allows the User to draw an Ellipse or Circle Page Item between a top-left point and a second bottom-right 
point on the current Page. 

Click the ellipse tool to load the cursor with the Ellipse/Circle object. 

Position the cross-cursor at a corner of the proposed ellipse’s bounding-box. 

Hold down the left mouse button and drag the cursor to size the ellipse/circle. 

Release the mouse button to fix the size and shape of the ellipse/circle. 

NOTE 

The Ellipse tool is disabled for all character targets, and pixel targets not supporting ellipses. 

 

7.10.15   Select a Line/Text Colour 
This Line/Text colour palette lets you select outline colours for line items (line, rectangle, ellipse, etc.), and for 
the characters in text items. 

Select the line or text object, e.g. using the Selection tool  

Click the ‘Foreground’ pulldown to reveal a list of available colours and select the required colour from the 
palette’s pulldown menu.  The Foreground colour palette retains the colour of the last-selected item. 

See also ‘Define Customised colours’.  

 

7.10.16   Select a Fill/Background Colour 
The Fill/Background colour palette lets you select fill colours for geometrical items (rectangles, ellipses, 
triangles, etc.), and background colours for text items. 

Select the item, e.g. using the Selection tool  

Click on a ‘background/fill’ colour from the palette’s pulldown menu. The palette retains the background/fill 
colour of the last-selected item. 

See also ‘Define Customised colours’.  
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7.11 USE THE PLACEMENT BAR COMMANDS TO... 

7.11.1 Activate the Snap object(s) to nearest gridline 
Select the object(s), using the Selection tool. 

Click the ‘Snap Object(s) to Grid’ tool.  Each object snaps independently to the nearest gridline. 

7.11.2 Align the bottom edges of objects 
Select the objects, using the Selection tool. 

Click the Align Objects Bottom tool. 

7.11.3 Align the left edges of objects 
Select the objects, using the Selection tool. 

Click the Align Objects Left tool. 

7.11.4 Align the right edges of objects 
Select the objects, using the Selection tool. 

Click the Align Objects Right tool. 

7.11.5 Align the top edges of objects 
Select the objects, using the Selection tool. 

Click the Align Objects Top tool. 

7.11.6 Bring an object forward by one layer 
Select the Page Item using the Selection tool. 

Click the Bring Forward tool. 

7.11.7 Bring an object to the front 
Select the Page Item using the Selection tool. 

Click the Bring to Front tool. 

7.11.8 Send an object backward by one layer 
Select the Page Item using the Selection tool. 

Click the Send Backward tool. 

7.11.9 Send an object to the back 
Select the Page Item using the Selection tool. 

Click the Send to Back tool. 

7.11.10   Flip object(s) horizontally 
Select the object(s), using the Selection tool. 

Click the Flip Horizontal tool. 
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7.11.11   Flip object(s) vertically 
Select the object(s), using the Selection tool. 

Click the Flip Vertical tool. 

7.11.12   Group multiple objects 
Select the required Page Items, using the Selection tool. 

Use the <Ctrl> key to select multiple Page Items on a worksheet. 

Click the `Group' tool. 

7.11.13   Ungroup a grouped object 

Select the grouped Page Item, using the Selection tool. 

Click the Ungroup tool. 

7.11.14   Show/Hide the gridlines 

Click the Toggle Gridlines tool change the current Grid state. 

Repeat to revert to previous Grid state. 

Page 58 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

8 CUSTOMISING THE USER SCREEN EDITOR 

8.1 DEFINE CUSTOMISED COLOURS 
Up to 16 custom colours can be stored in the ‘Custom colors’ slots in the colour palette.  To define a custom 
colour: 

Open the Colors palette dialogue. 

Use the ‘Define Custom Colors’ button to reveal the colour editing palette. 

Select a vacant custom colour slot, and adjust the colour using the numeric fields or the cross-hair on the 
colour spectrum screen beside. 
When satisfied, press the ‘Add to Custom Colors’ button. 

To use a colour, click on it and confirm using the OK button. 

 

8.2 SELECT THE COLOUR OF THE GRIDLINES 
Click the Grid Colour toolbutton to display the Color dialogue. 

Select  the required colour and confirm using the ‘OK’ button. 

See also ‘Define Customised colours’  

 

8.3 CUSTOMISE THE GRID SETTINGS 
Click the ‘Grid Settings’ tool to display the Grid Settings dialogue. 

Configure the required grid settings in the dialogue. 

Click ‘OK’ to apply the settings. 

NOTE 

The ‘Configure using default font’ button changes the Grid Settings to fit the Font Style selected in the Text 
Bar. 

 

8.4 CUSTOMISE THE USER SCREEN BACKGROUND COLOUR 
Allows the background colour for the target screen to be selected. 

Open the required Page. 

Select Page > Panel Colour to reveal the Color dialogue. 

Select the colour and confirm using the OK button. 

See also ‘Define Customised colours’  
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9 STRUCTURED TEXT (ST) 

9.1 WHAT IS STRUCTURED TEXT? 
Structured Text (ST) is the language used to write the statements and expressions that specify Actions in the 
User Screen Editor. 

NOTE 

An Action is a set of instructions written in Structured Text (ST), specifying direct operations on the LIN 
Database of the running control strategy. 

Structured Text (ST) strings are limited to the form "<name>:=<value>;", where <name> is the name of a LIN 
Database field or subfield enclosed in square brackets, and <value> is a string representing the value to be 
assigned. 

The value string may be enclosed in single quotes, and may then make use of standard Structured Text (ST) ‘$’ 
escape sequences.  Alternatively, it may be unquoted, in which case it is terminated by ‘;’ or a space. 

Space characters are permitted either side of ":=" and before the ‘;’. The effect of the assignment will be the 
same as if the value string had been typed in via LINtools. 

For numeric or Boolean variables, <value> may also be a limited form of Structured Text (ST) expression, 
involving only fields within the function block being assigned. 

Example: 

ST:"[PID1.SL]:=SL+10.0;" (increments SL when button pressed). 

With the use of the instruction categories below, the User Screen Editor can achieve a specific response to a 
User Screen action, or changes of a value at a specified point. 

 (*ADJUST TEMP SETPOINT*) TIC_100.SL:= REC1.A4;(*A statement*) 

Dig_A.Out AND 64 (*An expression*) 

9.1.1 Structured Text - Example 
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9.2 EDITING STRUCTURED TEXT 
Structured Text can be edited only in the Action field of a Page Item Properties dialogue. It allows a structured 
string of text consisting of a sequence of paragraphs to achieve a specific response to a User Screen action, or 
to changes of a value at a specified point. 
Variable… In a LIN Database Variable, a list of LIN Database blocks, including fields and subfields, 

derived from the current target LIN Database (.dbf).  In an Instrument Variable, a list of 
System blocks derived from the current (validated) Target Instrument. 

Operator This is a list of mathematical and logical operators. 
Outline This is a list of ready-made formats, e.g. time, hex, and ‘comment’. 
Function This is a list of mathematical functions. 
If… Statements These three items insert the corresponding multi-line 'If' statement structures, with dummy 

Variables for subsequent editing. 

9.3 COMMENTS IN STRUCTURED TEXT (ST) 
Example: (*character string*)  

Non-executing character strings can be added as 'comments' in the Structured Text of an Action or Transition, 
e.g. to clarify its purpose. Comments can occupy separate lines, or precede or follow a statement/expression on 
the same line, or be inserted anywhere that an optional space can go. 

Example: (*ADJUST TEMP SETPOINT*) TIC_100.SL:= REC1.A4;(*RECIPE #5*) 

See also ‘Notation Formats’.  

9.4 CONSTANTS IN STRUCTURED TEXT (ST) 
Structured Text (ST) supports four types of constant: Integer. Real. Time. String. 

9.4.1 Integer constants 
Decimal constants have the format:  {sign} digit {digit}… 

Example: 45 

Example: -12345  

Hexadecimal constants have the format: 16#hexdigit {hexdigit}… 

Example: 16#FF (represents 255 decimal)  

Example: 16#00ff (represents 255 decimal - padding zeroes OK) 

Example: 16#03e8 (represents 1000 decimal) 

NOTE 
Hexadecimal digits are not case-sensitive. 

Binary constants have the format: 2# binarydigit { binarydigit }… 

Example: 2#1100 (represents 12 decimal) 

Example: 2#0010 (represents 2 decimal) 
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9.4.2 Real constants 
These have the format:  {sign} integer.integer 

Example: 3.6 

Example: -0.0033 

9.4.3 Time constants 
These have the format:  T# {integer unit} real unit 

Units are d (days) h (hours) m (minutes) or s (seconds). Time constants evaluate to seconds if assigned or 
compared with real constants. E.g. In the assignment Recipe.A3:=T#1h; Recipe.A3 takes the value 3600. 

Example: T#3s (3 seconds) 

Example: T#4m13.0s (4 minutes, 13 seconds) 

Example: T#5.6h (5 hours, 36 minutes) 

Example: T#1d12.2h (36 hours, 12 minutes) 

NOTE 
Time units may be input as upper or lower case. 

9.4.4 String constant 
String constants can be up to eight characters long and must be enclosed in double quotation marks. 

Example: "MANUAL"  

Example: "P" 

9.4.5 String constants & T1000/T100 fields 
At software Issue 3/2, certain T1000/T100 block fields can be written to from Structured Text (ST) only by using 
the string constant format, e.g. 

Example: Total.Target:="10230890"; 

Example: TimeDate.Date1:="18-07-04"; 

The table below lists the fields requiring this format: 

 

Block Field(s) 

COUNT SetCount 

TOTAL Target 

TIMEDATE Time_1 … Time_8, Date_1 … Date_4, CurrTime, CurrDate 

  

NOTE 
Any Field that cannot be written to via a screen readout cannot be written to by Structured Text. 
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9.5 EXPRESSIONS IN STRUCTURED TEXT (ST) 
Expressions can contain operators, functions, variables, and constants. Brackets are allowed and can be nested 
to any level. The evaluation order of an expression is shown in the Operators & Functions table. 

9.5.1 Arithmetical 
Example: (Block_5.PV + 3.5) / Const.A7 + Const.A6 
Example: COS(Block_6.PV)**1.5 
Example: Dig_A.Out AND 64 

9.5.2 Logical 
Example: Recipe.A0 < 4 
Example: Dig_B.Out.Bit5 = Dig_A.Out.Bit3 
vSTEP3.T >= T#4m 

See also ‘Notation Formats’  

9.6 IDENTIFIERS IN STRUCTURED TEXT (ST) 
An identifier is a blockname, fieldname, or stepname. A valid identifier must have the format:  
letter | _ {letter | digit | _ }...  that is, one letter or underscore, followed by any number (including zero) of 
letters, digits or underscores, up to a maximum of eight characters. 

NOTE 

'_' is the underscore (underline) character, not the hyphen or minus sign. 

9.6.1 Valid Structured Text identifiers 
A1  
act_4  
FlowMetr  
_Pump  
X__3Y (consecutive underscores) 
z567931 

9.6.2 Invalid Structured Text identifiers 
1A (digit first) 
Pump 3 (space) 
Flow-Mtr (minus sign) 
x*y*z (multiply sign) 
6366 (digit first) 
T1.2 (dot) 
Pulserate (too long) 

NOTE 
Variable names containing bad Identifiers can be made recognisable as Variables by enclosing the whole 
Variable name in square brackets: 
Example: [6366.MN] 
Example: [DG_CONN3.W Field2.Bit6] 
Example: [x*y*z.OP] 
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9.7 OPERATORS AND FUNCTIONS IN STRUCTURED TEXT (ST) 
In the table below, A, B, C etc., are appropriate operands or arguments. Use the correct number format in 
Structured Text (ST) expressions, and the correct trigonometric Trigonometric units. 

NOTE 

In an Expression, the evaluation order of operators follows the table, with the earliest-evaluated operators at 
the top. 

Some operators are effective only with the appropriate operand types. E.g. the power operator (**) requires A 
to be positive; the MOD operator must have positive integer operands, etc. 
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9.7  OPERATORS AND FUNCTIONS IS ST (Cont.) 

Operator Purpose Format 

( ) Brackets (alter precedence) (A+B)*(C+D) 

- Negate -A 

NOT Logical invert NOT(A) 

TRUNC Truncate (to an integer) TRUNC(A) 

FLOAT Convert to Floating Point FLOAT(A) 

ROUND Round (up or down) ROUND(A) 

ABS Absolute ABS(A) 

DEG Degrees (from Radians) DEG(A) 

RAD Radians (from degrees) RAD(A) 

SIN Sine (Radians) SIN(A) 

COS Cosine (Radians) COS(A) 

TAN Tangent (Radians) TAN(A) 

ASIN Arc Sine (Radians) ASIN(A) 

ACOS Arc Cosine (Radians) ACOS(A) 

ATAN2 Arc Tangent (Radians) ATAN2(A,B) [Tangent=A/B] 

SQRT Square Root SQRT(A) 

LN Natural Logarithm (base e) LN(A) 

LOG Logarithm (base 10) LOG(A) 

EXP Exponentiation (eA) EXP(A) 

MIN Minimum value MIN(A,B,C,...) 

MAX Maximum value MAX(A,B,C,...) 

AVG Average (arithmetic mean) AVG(A,B,C,...) 

RANDOM Random value  RANDOM(A) [A=max modulus] 

SWITCH Selects A (integer C<1) else B SWITCH(A,B,C) 

** Exponentiate (Power AB) A**B[1] 

* Multiply () A*B 

/ Divide () A/B 

MOD  Modulo (remainder of A/B) TRUNC(A) MOD TRUNC(B)[2] 

+ Add A+B 

- Subtract A-B 

= Equals A=B 

< Less Than A<B 

HA260749U005  Page  65  
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

> Greater Than A>B 

<= Less Than Or Equal To A<=B 

>= Greater Than Or Equal To A>=B 

<> Not Equals A<>B 

AND Logical AND A AND B 

XOR Logical XOR (exclusive OR) A XOR B 

OR Logical OR A OR B 

[1] ‘A’ must exceed zero. [2] ‘A’ and ‘B’ must be integers. 
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9.8 SPACES IN STRUCTURED TEXT (ST) 

9.8.1 Mandatory spaces 
Space characters must separate logical operators from their operands. 

Example: LEV.OP>15 AND TEMP.OP<55.5 is correct. 

9.8.2 Illegal spaces 
Spaces must not be left anywhere inside operators, database names, identifiers, or constants. 

Example: HEAT_PID. SL:=REC1. A3; is incorrect. 

9.8.3 Optional spaces 
Spaces other than mandatory or illegal spaces may be inserted at will to improve the clarity of the expression 
or statement. 

Example: TIC_100.PV := 45.5; needs no spaces but may be clearer with the two shown. 

NOTE 

Space characters occupy the same amount of memory as other characters. 

9.9 STATEMENTS IN STRUCTURED TEXT (ST) 
A statement can be an Assignment or an IF-statement. 

NOTE 
Statements must be terminated by a semicolon. 

9.9.1 Assignment 
variable := expression; 

Various types of assignment are possible, including the following examples: 

Assign a constant to a real variable. 
Example: PIC_004.PV:=35.5; 

Assign a calculation to a real variable. 
Example: ANOP_3.PV:=Const.A6 + (Block_5.PV+3.5) / Const.A7; 

Assign a constant to a digital variable. Example:  Dig_B.Out.Bit0:=1; 

Assign a calculation to a digital variable.  Example: SEQ4.Hold:=(PIC_005.PV > 30) AND Dig_B.Out.Bit5; 

Assign a string to a mode.  Example: PIC_004.Mode:="CASCADE"; 

Assign an integer to a bitfield.  Example: Dig_A.Out:=96; 

Assign a bitwise calculation to a bitfield.  Example: Dig_A.Out:=Dig_B.Out XOR 96; 
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9.9.2 IF-statement 
IF expression THEN statement-list 

{ELSIF expression THEN statement-list} 

{ELSE statement-list} 

END_IF; 

NOTE 

The IF-statement allows zero or more ELSIF clauses, and zero or one ELSE clause. IF-statements can be nested. 

Example:  
IF PIC_004.PV < 10 THEN 
Dig_B.Out.Bit0 := 1;  
RECORD.A4 := ANIN_004.HR;  
ELSE  
Dig_B.Out.Bit1 := 1;  
END_IF;  

Example: 
IF LEVEL.OP < REC1.A0  
THEN Dig_B.Out.Bit1 := 0;  
END_IF; 

See also ‘Notation Formats’  

9.10 TRANSITIONS IN STRUCTURED TEXT (ST) 
Transitions are Structured Text (ST) expressions that may be either TRUE (evaluate to logic or integer 1) or 
FALSE (evaluate to logic or integer 0). 

A Transition is used in an Sequence Action to test for a condition in the control strategy. A TRUE Transition 
following an active step (or parallel steps) causes the Sequence to move on to the next step(s). That is, the 
active step(s) preceding the Transition de-activate(s), and the step(s) following the Transition activate(s). 

Test a real variable against a constant.  Example: Recipe.a0 < 4 

Test a digital for TRUE.  Example: Dig_B.Out.Bit5 

Test a digital for FALSE.  Example: NOT Dig_B.Out.Bit5 

Test a step time.  Example: STEP6.T >= T#2m 

Test a step time in seconds.  Example: waitstep.t > 95 

Test if an SFC Action end-step reached.  Example: Act4_end.X 

Logical combination of tests.  Example: Dig_B.Out.Bit5 AND (Rec.A0<4 OR Rec.A0>5) OR step6.T>=T#4s 

See also ‘Notation Formats’.  

9.11 VARIABLES IN STRUCTURED TEXT (ST) 
The source of a Variable can be from either the LIN Instrument via the Instrument Variable Browser or the LIN 
Database via the LIN Database Browser. 

Page 68 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

9.12 LIN DATABASE FIELD/SUBFIELD NAMES 
These can take the following formats: 

blockname.fieldname Example:   PIC_004.PV 

blockname.bitfield.bit Example:  Dig_A.Out.Bit3 

blockname.bitfield Example:   TIC_100.Options 

blockname.Alarms.alarmname  Example:   ANIN_005.Alarms.HiLevel 

NOTE 

Database names are not case-sensitive, i.e. capital or small letters may be freely used or mixed in the names. 
Example: Dig_A.OUT.BIT3 is equivalent to Dig_A.Out. 

9.12.1 Bitfields 
8-bit bitfields may be referred to as decimal integers in the range 0 to 255 (i.e. binary 00000000 to 11111111). 

Example: Dig_A.Out:=96; assigns the binary value 01100000 to the bitfield. 

16-bit bitfields may be referred to as decimal integers in the range -32768 to +32767 (i.e. binary 1000 0000 
0000 0000 to 0111 1111 1111 1111, in 2's complement format). 

9.12.2 Aliases 
TagName aliases can be used in Structured Text. 

9.12.3 LIN Sequence step variables 
These can take the following formats: 

stepname.X  Example: END_STEP.X 

stepname.T  Example: STEP5.T 

Stepname.X is TRUE when the step called Stepname is active, or when the step timers have been stopped but 
not initialised (Run and Init = FALSE, in the SFC_CON block). Otherwise Stepname.X is FALSE. 

Stepname.T is the elapsed time in the step called Stepname, in seconds. Stepname.T is frozen when Stepname is 
exited, and zeroed when Stepname starts or when the SFC is reset. 

NOTE 

Identifiers contained in a Variable must be valid. 
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10 GETTING SPECIFIC HELP 

10.1 OPEN ONLINE HELP FILE 

 
To access the User Screen Editor’s help file, pull down the Help menu and click Help Topics. The help file opens 
at the ‘Welcome to the User Screen Editor!’ topic. 
If already open, the help topic last accessed is displayed instead. 

Use the help window’s Contents, Index, or Search tabs to get help on any topic. 

 
If you want to step from one topic to the next in a logical order, click the browse buttons in the required 
direction. 

10.2 SHOW CONTEXT-SENSITIVE HELP 

10.2.1 Dialogue Help 
To get help with filling in dialogues, press the PC’s <F1> key while the dialogue is active. This opens up the User 
Screen Editor Help file at the relevant topic. 

The Help file open can remain open, ready to display the relevant topic the next time <F1> is clicked. 

10.2.2 Menu Help 
To get help with menu items, highlight the item and press the PC’s <F1> key. This opens up the User Screen 
Editor Help file at the relevant topic (if available). 

10.2.3 Toolbutton Help 
To get help with using any of the editor’s toolbuttons, first click the Help mode button then locate the Help 
cursor over the toolbutton to be queried. Note that it does not matter if the required toolbutton is inactive 
(‘greyed out’). Click to display the relevant help topic. 

Alternatively, locate the ordinary cursor over the toolbutton and hold down the left mouse button. Click the 
PC’s <F1> key to display the relevant help topic in the Online Help. 
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11 TARGET PROPERTIES DIALOGUE 

11.1 INTRODUCTION 
This dialogue is used to edit either Pixel-based or Character-based Target Screen types.  

To access the dialogue, either, press the Edit button on the Target Panels dialogue, or double-click the required 
Target Screen type 

To simplify editing Target Screen type properties, this dialogue is divided in pages. Each page displays the 
properties of a selection of the pre-specified parameters stored in the Target Definitions file. 

The Target Properties dialogue pages are as foillows, 
Bitmaps This page shows the Bitmaps configured for this Target Screen type. It also permits the User 

to configure and edit the User Screen Editor Bitmaps parameters. 
Capabilities If displayed, this page shows the Capabilities configured for this Screen type. It also permits 

the User to configure and edit the Capabilities supported by this Screen type. 
Colours If displayed, this page shows the Colours configured for this Screen type. It also permits the 

User to configure and edit the Colours supported by this Screen type.  
Drawing This page shows the Drawing features configured for this Screen type. It also permits the 

User to configure and edit the Drawing features supported by this Screen type.  
Filename This page shows the Filename (.uxt) configured for this Screen type. It also permits the User 

to edit the Filename of this Screen type.  
Fonts This page shows the Fonts configured for this Screen type. It also permits the User to 

configure and edit the Fonts supported by this Screen type.  
General These are Screen type name and the Screen size parameters. It also permits the User to 

configure and edit the Fonts supported by this Screen type.  
Grid This page shows the Grid parameters of the selected Target Screen type. It also permits the 

User to configure and edit the Grid parameters supported by this Target Screen type.  
Instruments This page shows the Instruments configured for this Target Screen type. It also permits the 

User to configure and edit the User Screen Editor Instruments parameters supported by this 
Target Screen type.  

Mappings If displayed, this page shows the Character Drawing and Symbol Mapping capabilities 
configured for this Target Screen type.  

Miscellaneous If displayed, this page shows the Miscellaneous features configured for this Screen type. It 
also permits the User to configure and edit the Miscellaneous features supported by this 
Screen type.  

OSFK If displayed, this page shows the default capabilities of the Off Screen Function Keys 
configured for this Target Screen type.  

Panes This page shows the Panes configured for this Screen type. It also permits the User to 
configure and edit the Panes supported by this Screen type.  

Underlines If displayed, this page shows the Underlining parameters configured for this Target Screen 
type. It also permits the User to edit the Underlining parameters of this Target Screen type.  

Variables This page shows all specific system Variables associated with the selected Target Screen type. 
It also permits the User to configure and edit other required System Variables supported by 
this Target Screen type.  
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11.2 TARGET PROPERTIES DIALOGUE - BITMAPS PAGE 
This page shows the Bitmaps configured for this Target Screen type. It also permits the User to configure and 
edit the User Screen Editor Bitmaps parameters supported by this Target Screen type. 

11.2.1 Bitmaps list 
The list display the properties of each Bitmap for this Target Screen type as configured via the Add Font 
dialogue displayed when the Add or Edit button is pressed. 
Name Shows the name of the Bitmap, as it will appear on the User Screen Editor worksheet during 

Page configuration. Select a particular Bitmap using this name. 
Filename Shows the Windows bitmap (.bmp) file name for the Bitmap, as stored in the target/bitmaps 

directory. 
Description Use this to enter a concise description of the Bitmap file, as stored in the target/bitmaps 

directory. 

11.2.2 Add 
Use this button to display the Add Bitmap dialogue. The Add Bitmap dialogue allows the configuration of a new 
Bitmap in the list of the required Bitmap properties.  

11.2.3 Edit 
Use this button to display the Edit Bitmap dialogue revealing the properties of the Bitmap selected in the Table 
list. The Edit Bitmap dialogue allows the properties, as displayed in the Table list, of the selected Bitmap to be 
edited.  

11.2.4 Remove 
Use this button to remove the selected Bitmap from the Table list. 

Beware… 
The selected Bitmap is removed without requesting confirmation. This may the cause the User Screen 
page to display incorrectly. 
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11.3 TARGET PROPERTIES DIALOGUE - CAPABILITIES PAGE 
If displayed, this page shows the Capabilities configured for this Screen type. It also permits the User to 
configure and edit the Capabilities supported by this Screen type. 

11.3.1 Capabilities 
This series of checkboxes define the resources supported by the Target Screen type. 
Supports display agent driven sub-panes 
 If enabled, the Target Screen type will display sub-panes requested from an Agent. 
Supports flashing If enabled, a configured Page Item continuously alternates its appearance, e.g. flashes on and 

off, or switches between two different colours. 
Supports highlighting 

If enabled,, a configured Page Item is displayed differently from non highlighted objects, e.g. 
with increased colour brightness, or with swapped foreground and background colours. 

Supports touch areas 
If If enabled, the Target Screen type will respond to an operation originating from a Touch 
Area. Touch areas are intrinsically invisible, but can be identified to the operator by 
overlapping them with suitable graphics. 

Supports buttons If If enabled, the Target Screen type will respond to an operation originating from a Button. 
Further configuration may be required if a Target Screen type requires a Button to have an 
internal border, see next point. 

Buttons have a VT220-style single character border 
 If enabled, the Target Screen type Button will have an single character internal border.  This 

is disabled if the ‘Supports buttons’ capability is not enabled (not ticked). 
Supports signing (21CFR11) 
 If enabled, the Target Screen type will request Confirmation when the configured Action is 

operates. 
 

NOTE 

The Confirmation Properties page will appear on the appropriate Page Item Properties dialogues to configure 
the required confirmation. 
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11.4 TARGET PROPERTIES DIALOGUE - COLOURS PAGE 
If displayed, this page shows the Colours configured for this Target Screen type. It also permits the User to 
configure and edit the Colours supported by this Screen type. 

11.4.1 Table list 
This list displays the properties of each Pane for this Target Screen type as configured via the Add Colour and 
Edit Colour dialogues displayed when the Add or Edit button, respectively (see below), is pressed. 
Number A User defined numeric reference assigned to the configured Colour. 
Name A User defined name reference assigned to the configured Colour. 
Colour This shows a list of the Target Screen type colours corresponding to the colour's Number. 
 

NOTE 
These colour specifications are not downloadable to the Target Instrument. Their purpose is simply to 
ensure that the colours seen on the User Screen Editor worksheet match as closely as possible those 
appearing on the Target Screen when the configurations are downloaded and run. 

11.4.2 Setup 
Use this button to display the ‘Colour Setup’ dialogue. This allows the default background and foreground 
colours to be defined and to specify that the Target Screen type can support Colour change commands.  

11.4.3 Add 
Use this button to display the Add Colour dialogue. The Add Colour dialogue allows the configuration of a 
new colour in the Table list of the required Colour properties. Customised Colours can also be defined.  

11.4.4 Edit 
Use this button to display the Edit Colour dialogue revealing the properties of the Colour selected in the Table 
list. The Edit Colour dialogue allows the properties, as displayed in the Table list, of the selected Colour to be 
edited and customised Colours to be defined.  

11.4.5 Remove 
Use this button to remove the selected Colour from the Table list. 

Beware… 
The selected Colour is removed without requesting confirmation. This may the cause the User Screen page 
to display incorrectly. 
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11.5 TARGET PROPERTIES DIALOGUE - DRAWING PAGE 
If displayed, this page shows the Drawing features configured for this Target Screen type. It also permits the 
User to configure and edit the Drawing features supported by this Target Screen type. 
Supports bar charts If enabled, the Target Screen type will display bar charts. 
Supports trend graphs If enabled, the Target Screen type will display trend graphs. 
Supports drawing of bitmaps 
 If enabled, the Target Screen type permits new bitmap graphic Page Items to be created 

on a Page. 
Supports drawing of circles 
 If enabled, the Target Screen type permits circle Page Items to be created on a Page. 
Supports drawing of rounded rectangles 
 If enabled, the Target Screen type permits rectangles with filleted corner Page Items to 

be created on a Page. 
Supports drawing of polylines 
 If enabled, the Target Screen type permits multiple segment line Page Items to be 

created on a Page. 

11.6 TARGET PROPERTIES DIALOGUE - FILENAME PAGE 
If displayed, this page shows the Filename (.uxt) configured of this Target Screen type. It also permits the User 
to edit the Filename of this Target Screen type. 

11.6.1 Target filename 
Filename (under Targets directory): 
 A name assigned to the configured Target Screen type file used. 
 

NOTE 
Change the Filename field, and the Target name field on the General page, to create a duplicate set of 
Target Screen type properties. 
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11.7 TARGET PROPERTIES DIALOGUE - FONTS PAGE 
This page shows the Fonts configured for this Target Screen type. It also permits the User to configure and edit 
the Fonts supported by this Target Screen type. 

11.7.1 Table list 
This list displays the properties of each Font for this Target Screen type as configured via the Add Font dialogue 
displayed when the ‘Add’ button (see below) is pressed. 
Number This number corresponds to a particular font resident in the Target Instrument. It must be 

understood by the Target Instrument to represent that font. (There could be only one Font 
resident in the Target Instrument). It is used by the Operator InterFace Language (OIFL) 
output files, downloaded to the Target Instrument, to specify display of that Font at runtime. 

Name This is the name of the Font as it will appear on the User Screen Editor worksheet during 
Page configuration. Select a particular Font using this name. 

Dimensions This shows the width by height dimensions (in pixels) of the configured character cell. 
Proportional This shows that the configured Font is either a Proportional or Fixed width font. Yes 

indicates that the configured Font has characters of differing widths. No shows that the font 
has a fixed width. 

Filename The Windows bitmap (.bmp) file name for the Font, as stored in the target/fonts directory. 

11.7.2 Setup 
Use this button to display the Font Setup dialogue. This allows the default Font to be specified, and indicate 
that the Target Screen type can support Font change configuration.  

11.7.3 Add 
Use this button to display the Add Font dialogue. The Add Font dialogue allows the configuration of a new Font 
in the Table list of the required fonts properties.  

11.7.4 Edit 
Use this button to display the Edit Font dialogue revealing the properties of the Font selected in the Table list. 
The Edit Font dialogue allows the properties, as displayed in the Table list, of the selected Font to be edited.  

11.7.5 Remove 
Use this button to remove the selected Font from the Table list. 

Beware… 
The selected Font is removed without requesting confirmation. This may cause the User Screen page to 
display incorrectly. 
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11.8 TARGET PROPERTIES DIALOGUE - GENERAL PAGE 
These are the Screen type name and the Target Screen size parameters. It also permits the User to configure 
and edit the type of Fonts supported by this Target Screen type.  The fields are: 

11.8.1 Target Name 
Name Use this field to specify an appropriate Target Screen Type name. 

11.8.2 Dimensions 
Width Use this field to specify the width, in pixels, of the designed Target Screen Type. 
Height Use this field to specify the height, in pixels, of the designed Target Screen Type. 

11.8.3 Character Dimensions 
Width Use this field to specify the width, in pixels, of the required characters. 
Height Use this field to specify the height, in pixels, of the required characters. 
Hide target from new Page Set configurations 
 If enabled, the specified Target Screen type will not be available for any future Page Set 

designs. 
 

NOTE 
Height and width fields are omitted for configuration of Pixel-based Target Screen types. 

11.9 TARGET PROPERTIES DIALOGUE - GRID PAGE 
This page shows the default Grid parameters of the selected Target Screen type. It also permits the User to 
configure and edit the Grid parameters supported by this Target Screen type. 

11.9.1 Default Major Grid Settings 
This displays the default intervals of each visible grid line for this Target Screen. 
Horizontal (pixels): Use the spin button to change, increase or decrease the intervals in pixels between each 

visible grid line.  Type in the required value if necessary. 
Vertical (pixels): Use the spin button to change, increase or decrease the intervals in pixels between each 

visible grid line. Type in the required value if necessary. 
 

NOTE 
A maximum of 9999 pixel intervals can be configured. 

11.9.2 Default Minor Grid Settings 
This displays the default intervals between the Major Grid Settings, of each invisible grid line for this Target 

Screen. 
Horizontal (pixels): Use the spin button to change, increase or decrease the intervals in pixels between each 

invisible grid line.  Type in the required value if necessary. 
Vertical (pixels): Use the spin button to change, increase or decrease the intervals in pixels between each 

invisible grid line.  Type in the required value if necessary. 

NOTE 
A maximum of 9999 pixel intervals can be configured. 
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11.9.3 Default Zoom 
Zoom Show the default zoom factor, when using the User Screen Editor. Select the required 

default zoom factor from the list. 

11.10   TARGET PROPERTIES DIALOGUE - INSTRUMENTS PAGE 
This page shows the Instruments configured for this Target Screen type. It also permits the User to configure 
and edit the User Screen Editor Instruments parameters supported by this Target Screen type. 

11.10.1   Instruments list 
This list displays the properties of each Instrument for this Target Screen type as configured via the ‘Add 
Instrument’ dialogue displayed when the ‘Add’ or ‘Edit’ button is pressed. 
Type This is the Type of the Instrument manufactured with this Target Screen type. Select a 

particular Instrument type. 
Version This is the V rsion of the Type of the Instrument manufactured with this Target Screen type. 

11.10.2   Add 
Use this button to display the ‘Add Instrument’ dialogue. The ‘Add Instrument’ dialogue allows the 
configuration of a new Instrument in the list of the required Instrument properties.  

11.10.3   Edit 
Use this button to display the ‘Edit Instrument’ dialogue revealing the properties of the Instrument type 
selected in the Table list. The ‘Edit Instrument’ dialogue allows the properties, as displayed in the Table list, of 
the selected Instrument to be edited.  

11.10.4   Remove 
Use this button to remove the selected Instrument from the Table list. 

Beware… 
The selected Instrument type is removed without requesting confirmation. This may prevent the display of 
the User Screen page. 
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11.11   TARGET PROPERTIES DIALOGUE - MAPPINGS PAGE 
If displayed, this page shows the Character Drawing and Symbol Mapping capabilities configured for this Target 
Screen type. 

11.11.1   Character drawing capabilities 
Has characters for drawing straight lines 
 If enabled, the Target Screen type will permit text to be used to draw straight lines as 

defined in the Graphical symbol-character mappings list and ASCII Key code field. 
Has characters for drawing angled lines 
 If enabled, the Target Screen type will permit text to be used to draw angled lines as defined 

in the Graphical symbol-character mappings list and ASCII Key code field. 

11.11.2   Graphical symbol-character mappings 
Character description 
 Use the list to select the orientation of the line being configured. If a character has already 

been defined, the ASCII key code field will automatically show it. 
ASCII key code This shows the ASCII key code already defined for the selected line type displayed in the 

Character description list. 

11.11.3   Browse… 
Use this button to reveal the ‘Open’ dialogue. This can then be used to locate an existing file containing all 
required ASCII Codes. 

11.12   TARGET PROPERTIES DIALOGUE - MISCELLANEOUS PAGE 
If displayed, this page shows the Miscellaneous features configured for this Target Screen type. It also permits 
the User to configure and edit the Miscellaneous features supported by this Target Screen type. 

11.12.1  Miscellaneous features 
Supports action lists 

If enabled, the Target Screen type will permit Structured Text actions. 
Supports 3D styling  

If enabled, the Target Screen type will permit the drawing of bevelled edges on appropriate 
Page Items. 

Supports different draw modes (e.g. COPY, OR, XOR, etc.) 
 If enabled, the Target Screen type will permit new bitmap graphic Page Items to be created 

on a Page. 
Supports different fill patterns (e.g. chequered, etc.) 
 If enabled, the Target Screen type will permit pattern filled Page Items to be created on a 

Page. This will fill the Page Item with a selected chequered pattern, not a simple solid colour 
fill. 

11.12.2   Database 
LINDB This shows the type of Database used by the Target Screen type. 
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11.13   TARGET PROPERTIES DIALOGUE - OSFK PAGE 
If displayed, this page shows the default capabilities of the Off Screen Function Keys configured for this Target 
Screen type. 

11.13.1   Off Screen Function Keys 
Always display default Off Screen Function Keys image 
 If enabled, the Target Screen type will only display the default Off Screen Function Keys 

Bitmap image, as defined in the Default Off Screen Function Keys image field. 
Default Off Screen Function Keys Image 
 Shows the path and filename of the Bitmap (.bmp) file, required as the default. 
Browse Use this button to reveal the Open dialogue. This can then be used to locate an existing 

Bitmap (.bmp) file for use in the OSFK pane. 
Define Function key image cropping area. 
 Imported bitmaps are scaled according to the setting in the ‘Panes’ dialogueue. The values 

entered in the ‘Top’, ‘Bottom’, ‘Left’ and ‘Right’ fields of the ‘Define Function Key image 
cropping area’ define a rectangle, within this scaled bitmap, to appear in the function keys 
pane. Setting all values to 10, for example, would define a rectangle as follows: the top left-
hand corner would be 10 pixels down from the top of the scaled image and 10 pixels in 
from its left edge; the bottom right-hand corner would be 10 pixels up from the bottom and 
10 pixels in from the right. 

Buttons and Touch areas on OSFK panes… 
 If enabled, all functions from the OSFK Pane will require Confirmation. 
Off Screen Function Keys area cannot… 
 If enabled, configuration of the OSFK Pane is not permitted by the user. 
User configurable area disabled from 
 Shows the highest point of the Target Screen type, in pixels, where configuration is not 

permitted. 
User configurable area disabled to 
 Shows the lowest point of the Target Screen type, in pixels, where configuration is not 

permitted. 
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11.14   TARGET PROPERTIES DIALOGUE - PANES PAGE 
This page shows the Panes configured for this Target Screen type. It also permits the User to configure and edit 
the Panes supported by this Target Screen type. 

11.14.1   Table list 
This list displays the properties of each Pane for this Target Screen type as configured via the ‘Add Pane’ and 
‘Edit Pane ‘dialogues displayed when ‘Add’ or ‘Edit’, respectively, is pressed. 
Pane Type A list of the types of Pane used by this Target Screen type. 
Name A name assigned to the configured Pane type as displayed in the Page Properties and Pane 

Setup dialogues, e.g. the Status Pane might be named 'Status Area'. 
Dimensions This shows the width by height dimensions in characters or pixels according to the 

configured Pane type of the Target Screen type. 
Description This shows information that is relevant to the selected Pane type, e.g. the status pane might 

be described as 'Constant date/time display'. 

11.14.2   Setup 
Use this button to display the ‘Pane Setup’ dialogue. This allows a default Font to be defined.  

11.14.3   Add 
Use this button to display the ‘Add Pane’ dialogue which allows the configuration of a new Pane type in the 
Table list of the required Pane properties.  

11.14.4   Edit 
Use this button to display the ‘Edit Pane’ dialogue revealing the properties of the Pane selected in the Table list. 
The ‘Edit Pane’ dialogue allows the properties, as displayed in the Table list, of the selected Font to be edited. 

11.14.5   Remove 
Use this button to remove the selected Pane from the Table list. 

Beware… 
The selected Pane is removed without requesting confirmation. This may cause prevent the display of a 
User Screen page. 
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11.15   TARGET PROPERTIES DIALOGUE - UNDERLINES PAGE 
If displayed, this page shows the Underlining parameters configured for this Screen type. It also permits the 
User to edit the Underlining parameters of this Screen type. 

11.15.1   Special underline characters 
Special underline characters below character cells 
 If enabled, the Target Screen type will permit text to be used to draw straight lines as 

defined in the Graphical symbol-character mappings list and ASCII Key code field. 
Number Use the spin button to change, increase or decrease User defined number of the intervals in 

pixels between each invisible grid line.  Type in the required value if necessary. 
Height Shows the Height of the specified Font type, in pixels. 
Use underline sections for bar charts 
 If enabled,  the target Screen type will permit text to be used to draw straight lines as 

defined in the Graphical symbol-character mappings list and ASCII Key code field. 

11.15.2   Underline colours 
Number Use the spin button to change, increase or decrease User defined number of the intervals in 

pixels between each invisible grid line.  Type in the required value if necessary. 
Colour swatch Shows a colour sample for the Colour specified by the User defined Name and Number 

fields. 
Edit Use this button to reveal the Colour editing palette. This will allow the User to change the 

colour shown in the colour swatch, that will eventually be defined by the User defined Name 
and Number fields. 
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11.16   TARGET PROPERTIES DIALOGUE - VARIABLES PAGE 
This page shows all specific system Variables associated with the selected Target Screen type. It also permits the 
User to configure and edit other required System Variables supported by this Target Screen type. 

11.16.1   Target Specific System Variables list 
This list displays the System Variables for this Target Screen type. Additional Variables can be configured via the 
‘Target Variable dialogue’ displayed when the ‘Add’ or ‘Edit’ button is pressed. 
Name This is the name of System Variable, as it will appear in the Instrument Browser dialogue 

when attempting to display an Instrument Variable on the User Screen page. 
Mnemonic This is the short sequence of letters used by the software to easily recognise the System 

Variable supported by this Target Screen type. 
Type This is the Variable data type, i.e. String, Boolean, Integer, etc.. 

11.16.2   Add 
Use this button to display the ‘Target Variable’ dialogue. The ‘Target Variable’ dialogue allows the configuration 
of a new Variable in the list.  

11.16.3   Edit 
Use this button to display the ‘Target Variable’ dialogue revealing the properties of the Variable selected in the 
Table list. The ‘Target Variable’ dialogue allows the properties, as displayed in the Table list, of the selected 
Instrument to be edited. 

11.16.4   Delete 
Use this button to remove the selected Variable from the Table list. 

Beware… 
The selected System Variable is removed without requesting confirmation. This may the cause the User 
Screen page to display incorrect information. 

11.16.5   Export 
Use this button to display the ‘Save As’ dialogue and generate a Text file (.txt) of the selected Variable from the 
Table list. 

11.16.6   Import 
Use this button to display the ‘Open’ dialogue and locate a Text file (.txt) of a required Variable instance. 

Tip! 
Use the Import and Export buttons to generate a Text file (.txt) of System Variables that are used 
consistently throughout the System. 
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12 WHAT IS 

12.1 A LIN DATABASE? 
A LIN Database (.dbf) is a software program that runs in a LIN Instrument. The running LIN Database takes in 
signals from sensors in an outside entity (e.g. an industrial plant), processes them in specified ways, and then 
outputs signals to actuators in the entity to control its behaviour in the required manner. 

The cycle of signal input to the LIN Database, signal processing, and signal output to the entity is repeated 
continuously while the LIN Database runs. 

More than one LIN Instrument can be involved in controlling a single entity, but only one LIN Database can run 
in a single LIN Instrument at a time. 

A LIN Database can work in conjunction with one or more LIN Sequences running in the LIN instrument. It can 
also make use of LIN Actions stored in action files in the LIN instrument. 

12.2 A LIN FUNCTION BLOCK? 
LIN Instruments use a block-structured approach to a control strategy, where various Function Block Categories 
of ready-made LIN function blocks perform the processing required. 

A LIN function block is an instance of a reusable module of program code, called a template, dedicated to a 
particular type of processing operation, e.g. the ADD2 template adds two numbers. In general, function blocks 
take in analogue and/or digital signals via their inputs, process them in a variety of methods and then pass the 
results on via their outputs. These function blocks are then ‘wired’ together so that the signals can flow 
between them to execute the control strategy. 

12.3 A USER SCREEN EDITOR ACTION? 
A User Screen Editor action is script (Structured Text) comprising a comma-separated list of one or more User 
Actions, which can be configured to execute when a touch-enabled object is activated. These objects include 
touch areas, rectangles, ellipses, bitmaps, and buttons. 

Typical user actions might include, 

setting a function block field to a specified value 

acknowledging alarms 

changing the programmer state (RUN/HOLD/SKIP/ABORT) 
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12.3.1 Supported Actions 
This table lists the action mnemonics, action qualifiers, and functions of the actions currently supported. 

Mnemonic Qualifier(s) Action 

ABORT None Abort the currently executing SPP program. 

ACK_ALL None Acknowledge all alarms. 

BREAK Boolean Make this the final action in the list, if true. Example: 

ST:"[COND.In_1]:=TRUE;",BREAK:"[COND.In_2]",ST:"[COND.In_3]:=TRUE;" 

means that the "COND.In_3" action is not carried out whilst the break 
condition (IP_2 status) is true. See also ‘CONTINUE’ 

CONTINUE Boolean Go to the next action in the list only if true. Example: 

ST:"[COND.In_1]:=FALSE;",CONTINUE:"[COND.In_2]",ST:"[COND.In_3]:=TRUE;" 

means that the "COND.In_3" action is carried out only whilst the continue 
condition (IP_2 status) is true. See also ‘BREAK’ 

DESC Integer Descend to the Agent with the specified ID number. A subsequent use of the 
‘escape’ key will return to the current Main page. Example: DESC;50 

DICT_ADD String: integer Moves the specified dictionary’s pointer by the value of the integer. Example: 
DICT_ADD:"W":-2 decrements the dictionary W pointer by 2. 
Omission of the integer results in an OIFL error.  

DICT_SET String: integer Sets the specified dictionary’s pointer to the value of the integer. Example: 
DICT_SET:"W":1 sets the dictionary W pointer to location 1. 

DICT_PUT String:[integers] 
String 

Replaces the dictionary entry, or entries, in the location(s) specified by the 
integer(s) with a new value. Example: 
DICT_PUT:"W":1:5:"Help" places the word ‘Help’ into locations 1 to 5 of 
dictionary W. 

DISABLE 
(or DIS) 

Boolean Disable button/area if true. Example: 

DISABLE:"[Door.Status.Intlcked]" See also ‘ENABLE’ 

ENABLE 
(or ENA) 

Boolean Enable button/area if true. Example: 
ENABLE:"[Temp.ModeAct.ManAct]" See also ‘DISABLE’ 

EVENT String:[Integer] Generate an event in the Event Log with string (max 16-characters) and 
priority indicator (default = 1). Example: 
EVENT:"Filling Started":2 

GOTO Integer Go to the Agent with the specified ID number. Example: 
GOTO:50 

HOLD None Hold the currently running SPP program. 

NOTE String:[Integer] Generate a note (max. 24 characters) in the Event log with a priority indicator 
as specified by the integer (default =1). Example: NOTE:"Agitator started":6 

NULL None No Action, always disabled. 

REPEAT None If this action is present in the list, the action is repeated for as long as the 
button or touch area is touched. The repetition rate depends on the screen 
update rate. 

RUN None Run the currently loaded SPP program. 
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SKIP [Integer] Skip the current SPP program segment. If the integer qualifier is included then 
this action will only be enabled for the specified segment number. 

ST String(s) Perform assignment(s) defined in Structured Text. 

 

 

NOTES 

The total length of all text in a list of actions must not exceed 200 Characters. 

The action text specified may be a list of comma-separated variables, with each action being performed in 
sequence starting with the leftmost and proceeding rightwards to the end unless an exit condition such as 
BREAK is detected.  

Within the limit above, there is no restriction on the number of Enables and Disables in a string.  

An action is enabled only when all relevant enables are True and all relevant disables are False.  An action is 
disabled if any relevant enable is false and /or any relevant disable is true.  
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12.4 A VARIABLE? 
A Variable is a list of LIN function block, or System block, fields or subfields currently used in the LIN Database 
(.dbf) (LIN Variable) or in the Target instrument itself (Instrument Variable), respectively. 

12.4.1 LIN Variable 
A LIN Variable is a list of LIN function blocks, including the field/subfields in each block, currently used in the 
LIN Database (.dbf) of a Target Instrument. 

A LIN Variable, (LIN function block field or subfield) can be located and selected via the LIN Database Browser 
dialogue. LIN block field or subfield names, can be inserted into dedicated fields of a Page Item Properties 
dialogue, and used along with Structured Text to achieve a specific response to a User Screen operation or to 
changes of a value at a specified point. The LIN Database Browser dialogue displays a list of those LIN block or 
field names that can be inserted. The LIN block and field names are derived from the target LIN Database. 

NOTE 
Each LIN Block has a specifically associated Data type. 

12.4.2 Instrument Variable 
An Instrument Variable is a list of system blocks used in the Target Instrument. 

An Instrument Variable can be located and selected via the Instrument Variable Browser dialogue. System 
blocks can be inserted into dedicated fields of a Page Item Properties dialogue, and used along with Structured 
Text to achieve a specific response to a User Screen operation or to changes of a value at a specified point. The 
Instrument Variable Browser dialogue displays a list of System blocks that can be inserted. The System blocks 
names are derived from the target Instrument. 

NOTE 
Each System block has a specifically associated Data type. 

12.5 AN AGENT? 
An 'Agent' is a software module that encapsulates User Screen functionality and 'drives' an area of the screen. 
Agents are given names and IDs for reference. 

A user-configured Page is an example of an Agent. 

Target Instruments may have in-built default agents for commonly required displays, e.g. Alarm History, Clock 
Set-up, etc. These have IDs of 1000 and upward. 

IDs 1 - 999 is reserved for user generated Pages created using the User Screen Editor.  

NOTE 
Some instruments may contain built-in Agents (e.g. T2900). These are generally accessible via User Screen 
touch-enabled objects. 
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12.6 AN INSTRUMENT VARIABLE BROWSER? 
Use the Instrument Variable Browser dialogue to select a Variable System function block in the associated LIN 
Instrument, for linking to a Dynamic Page Item.  The dialogue appears when you press the ‘Browse Instrument…’ 
button in Page Item Properties dialogue that let you configure these links, e.g. ‘Colour Attributes’, ‘Colour 
Limits’, ‘Limits’, ‘Trend Graph Variable’, ‘Variable’, etc. 

12.6.1 Using the Instrument Variable Browser window 
The Action of the Instrument Variable Browser is context-sensitive. It displays only the system blocks supported 
by the current Page Item property. 

12.7 AN OPERATOR INTERFACE LANGUAGE (OIFL)? 
Operator InterFace Language (OIFL (.ofl)) is a software language used by the User Screen Editor and is stored 
as an .ofl text file containing instructions for the Target Instrument. The .ofl file indicates what is in the Page Set 
and how to build the runtime User Screens. 

The Operator InterFace Language (OIFL) of a Page Set or an individual Page can be displayed. 

12.8 A LIN DATABASE BROWSER? 
Use the LIN Database Browser dialogue to select a Variable or function block in the associated LIN Database, 
for linking to a Dynamic Page Item.  

The dialogue appears when you press the ‘Browse…’ button in Page Item Properties dialogue that let you 
configure these links, e.g. ‘Colour Attributes’, ‘Colour Limits’, ‘Limit’s, ‘Trend Graph Variable’, ‘Variable’, etc. 

12.8.1 Using the Browser window 
The action of the LIN Database Browser is context-sensitive. It displays only the LIN function blocks and fields 
relevant to the current page item property. 

12.9 A REPORT WINDOW? 
This window records the operation it attempts and displays any validation warnings or errors it may have found. 

Validation involves checking that the data is complete and that it is consistent with the LIN Database file (.dbf), 
i.e. the referenced LIN fields exist in the LIN Database file (.dbf) and are of the correct type. 

Validation is carried out when, 

the Verify Page Set command is selected 

a Page Set file is loaded 

a Page Set file is saved 

a Page Set file is closed 

Tip! 
Double-click an error or warning record to access the application needed to correct the problem. 
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13 OTHER ITEMS 

13.1 3D STYLING PROPERTIES PAGE 
This dialogue applies only to the rectangle page object. Use it to add a 3-dimensional 'bevel' effect at the edges 
of a rectangle drawn with the rectangle tool, making it appear either raised or lowered (recessed). 

This effect is particularly useful if the rectangle is to act as a push-button (via the Touch Area Properties page). 

To access the dialogue, right-click the object and select Properties…, from the context menu to pop up the 
relevant Page Item Properties page. Then click the 3D Styling page. 

The fields are: 

13.1.1 Bordering 
Style Select either the ‘Bevelled, Raised’ or the ‘Bevelled, Lowered’ styling from this list. In these 

effects, the rectangle appears to be lit from the top-left of the display. 
Depth Specify the depth of the bevel in this field, i.e. the amount by which the rectangle appears to 

lie above or below the plane of the screen. Use the scrollable box to select a value from 0 to 
10 (maximum depth). Entering zero, (the default) removes the 3D-bevel effect completely. 

13.1.2 OK 
Accepts the parameter changes and closes the dialogue. 

13.1.3 Apply 
Accepts the changes, and allows further configuration. 

13.1.4 Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.2 ACCESS PROPERTIES PAGE 
This dialogue applies only to Dynamic Page Items. Use this dialogue to specify the visibility of the Page Item, i.e. 
by what criteria, in terms of operator access level you want it to be seen on the display. 

It can also specify the Variable's writability, i.e. the conditions under which the operator is allowed to alter the 
Variable value via the display. 

NOTE 
By default, Variables are 'always visible' and 'never writable'. These settings can be edited via the 
appropriate radio buttons and input fields. 

13.2.1 Visibility 
Always visible Use this radio button to indicate that the Page Item must always visible to any operator. 
Visible if operator level is 
 Use this radio button, in conjunction with the additional fields beside, to indicate that the 

Page Item can only visible to an operator with privileges that correspond to the defined 
parameters. Use the relationship (=, >=, <) from the pull-down menu, and an access level (1-
4) from the spin button. The Page Item will only be visible to operators whose access level 
corresponds to these parameters. 
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13.2.2 Writability 
Never writable Use this radio button to indicate that the Variable linked to the Page Item is Read-Only. 
Always writable but unreadable (Password) 
 Use this radio button to indicate that the Variable linked to the Page Item can be written to 

if visible, but is only displayed as a series of asterisks (*), e.g. for password-entry use. 
Always writable Use this radio button to indicate that the Variable linked to the Page Item can be written to 

if visible. 
Writable if operator level is 
 Use this radio button, in conjunction with the additional fields beside, to specify a minimum 

operator access level for writing to the Variable linked to the Page Item, if visible. The Page 
Item will be writable only by operators whose access level equal or exceed the level 
specified in the field beside. 

13.2.3 OK 
Accepts the parameter changes and closes the dialogue. 

13.2.4 Apply 
Accepts the changes, and allows further configuration. 

13.2.5 Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.3 ADD/EDIT BITMAP DIALOGUE 
This dialogue permits the user to include a defined Bitmap in this Page Set. 

13.3.1 Bitmap name 
Name The User defined name of the Bitmap, as recognised in the list. 

13.3.2 Bitmap filename 
Filename The Bitmap filename, as selected via the Browse… button or, if known, simply typed in. 
Browse… Use the Browse… button to display the Open dialogue allowing selection of the required 

Bitmap. 

13.3.3 Description 
Description A concise description of the Bitmap file, as stored in the target/bitmaps directory. 

13.3.4 Add 
Use this button to accept the changes and close this dialogue. 

13.3.5 Cancel 
Use this button to ignore the changes and close this dialogue. 
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13.4 ADD/EDIT COLOUR DIALOGUE 
This dialogue permits the user to permanently include a defined Colour in this Page Set. 

13.4.1 Colour details 
Number Shows the User defined number of the Colour, as recognised in the list. 
Name Shows the User defined name of the Colour, as recognised in the list. 

13.4.2 Colour 
Colour swatch Shows a colour sample for the Colour specified by the User defined Name and Number 

fields. 
Edit Use this button to reveal the Colour editing palette. This will allow the User to change the 

colour shown in the colour swatch, that will eventually be defined by the User defined Name 
and Number fields. 

13.4.3 Add 
Use this button to accept the changes and close this dialogue. 

13.4.4 Cancel 
Use this button to ignore the changes and close this dialogue. 

13.5 ADD/EDIT FONT DIALOGUE 
This dialogue permits the user to permanently include a defined Font style in this Page Set. 

13.5.1 Font name 
Number The User defined number of the Font, as recognised in the list. 
Name The User defined name of the Font, as recognised in the list. 

13.5.2 Dimensions 
Width Shows the Width of the specified Font type, in pixels. 
Height Shows the Height of the specified Font type, in pixels. 

13.5.3 Font properties 
Is the Font proportional? 
 If enabled, all characters in this configured Font will be of an identical width. 

13.5.4 Font filename (under Targets Font directory): 
Filename Shows the Windows bitmap (.bmp) file name for the Font, as stored in the target/fonts 

directory. 
Browse… Use the ‘Browse…’ button to display the ‘Open’ dialogue allowing selection of the required 

Font. 

13.5.5 Add 
Use this button to accept the changes and close this dialogue. 

13.5.6 Cancel 
Use this button to ignore the changes and close this dialogue. 
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13.6 ADD/EDIT PANE DIALOGUE 
This dialogue permits the user to permanently include a defined Pane in this Page Set. 

13.6.1 Pane type and name 
Pane Type Shows the type of the Pane, as recognised in the list. Use this list to select the required 

default Pane. 
Name Shows the User defined name of the Pane, as recognised in the list. 

13.6.2 Dimensions 
Width Shows the Width of the specified Pane type, in pixels. 
Height Shows the Height of the specified Pane type, in pixels. 

13.6.3 Description 
Description A concise description of the Pane, as stored in the target/bitmaps directory. 

13.6.4 Support Default Pages 
Description If enabled, this Pane allows the default Pages to be displayed. 

13.7 ADD/EDIT TARGET VARIABLE DIALOGUE 
This dialogue permits the user to include a defined Target Instrument Variable in this Page Set. 

13.7.1 Target Variable 
Description A concise description of the Target Variable, as stored in the target/bitmaps directory. 
Mnemonic This is the short sequence of letters used by the software to easily recognise the System 

Variable supported by this Target Screen type. 
Type This is the Variable data type, i.e. String, Boolean, Integer, etc.. 

13.7.2 Add 
Use this button to accept the changes and close this dialogue. 

13.7.3 Cancel 
Use this button to ignore the changes and close this dialogue. 
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13.8 APPEARANCE PROPERTIES PAGE 
Use this dialogue to specify the graphical appearance of the Page Item. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up the 
relevant Page Item Properties dialogue. Then click the ‘Appearance’ tab.  The fields are: 

13.8.1 Line/Text 
Weight Applies only to pixel-based Target Screen types. Used to change the line thickness (in pixels). 
Foreground colour Used to change the line/text colour for the specified Target Screen type. 

13.8.2 Fill/Background 
Object is filled Use this checkbox to specify the fill parameters of the selected Page Item. 
Background/Fill Use this pull-down menu to specify the background colour for the selected Text Page Items 

or a fill colour for the selected geometrical Page Item. 
 

NOTE 
For lines, background colour applies only for character-based Target Screen Type. 

13.8.3 OK 
Accepts the parameter changes and closes the dialogue. 

13.8.4 Apply 
Accepts the changes, and allows further configuration. 

13.8.5 Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.9 BAR CHART PROPERTIES PAGE 
This properties page applies only to Bar Chart Page Items. It lets you specify the fill direction of the chart, and 
for charts drawn with underline cells, whether single or double underline. To access this Properties page, right-
click the object and select ‘Properties…’ from the context menu to display the relevant Page Item Properties 
dialogue. Then click the ‘Bar Chart’ page. The fields are: 

13.9.1 Fill direction 
Set the required radio button to specify the fill direction: 
Left to right Bar Chart fills from left to right as the linked value increases. 
Right to left Bar Chart fills from right to left as the linked value increases. 
Top-down Bar Chart fills from top to bottom as the linked value increases. 
Bottom-up Bar Chart fills from bottom to top as the linked value increases. 

13.9.2 Underline used for bar chart 
Underline number Select the number of underlines required (1 or 2) 
Flash bar when negative  

Check the box to make the Bar Chart flash when the linked value goes out of range. 
 

NOTE 
‘Underline’ Bar Chart types can grow only horizontally. 
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13.9.3 OK 
Accepts the parameter changes and closes the dialogue. 

13.9.4 Apply 
Accepts the changes, and allows further configuration. 

13.9.5 Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.10   BITMAP ENUMERATION PROPERTIES PAGE 
This page applies only to the Bitmap Page Item. Use it to specify up to three bitmaps that will be displayed 
alternately by the bitmap object, depending on the value of the linked LIN Database variable. 

To access the dialogue, right-click the bitmap object and select ‘Properties…’ from the context menu to pop up 
the Bitmap Item Properties dialogue. Then click the ‘Enumeration’ tab.  The fields are: 

13.10.1   Enumerated 
Tick this checkbox to enable the enumeration action of the bitmap object. If left unchecked, the bitmap 
displayed will be the one specified in the Bitmap Properties dialogue. If ticked, the Bitmap Properties dialogue 
is partially disabled to avoid conflicts. 

13.10.2   Variable selection 

LIN VARIABLE  

Click this radio button if you want the bitmap enumeration to be controlled by a LIN Database Variable. Then 
enter the required point name in the Name box, or use the ‘Browse…’ button to find the point. 

INSTRUMENT VARIABLE 

Click this button to link an Instrument Variable to the Page Item. 
Name Type in the name of the variable to be linked (or use ‘Browse…’). The Variable type (e.g. 

Integer) is automatically entered for you from list to the right of the ‘Name’ box. Use the 
standard LIN formats for the variable name, i.e. blockname.fieldname (e.g. TIC001.PV) or 
blockname.bitfield.bit format (e.g. Dig_A.Out.Bit3). 

Browse… Click this button to pop up a LIN Database Browser window. This lets you to select the 
required block and point from the database you associated with the Page Set (via the 
PageSet Properties dialogue), or the New PageSet dialogue.) The variable type is 
automatically entered for you when you use Browse. 

 

NOTE 

The Editor auto-validates entries, a red cross  indicating an invalid field; a green tick  a valid field. 
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13.10.3   Bitmap selection 
Filename Click this button for a fixed bitmap specified by its filename (entered in the Bitmap box). 
Dictionary Click this button if you want the enumerated bitmap to be language-dependent. Use the 

Bitmap box (see below) to enter the relevant dictionary entry. 
Value With floating-point variables, select one of the three conditions from this list, for individual 

configuration. You can configure for when the linked variable is less than ‘lo_limit’, is on or 
between the ‘lo’ and ‘hi’ limits, and when it is greater than the ‘hi_limit’. These low and high 
limits are specified in the item’s Limits Properties page. 

 With Integer or Boolean variables, use the small scroll buttons in the Value box to select one 
of the possible values from the menu for individual configuration. 

Browse… Click this button to search for a suitable bitmap file to enter in the Bitmap box. 
Bitmap Use this box to associate a bitmap with the condition or value you specified in the Value 

box. For language-dependent bitmaps, enter the correct user-dictionary reference number 
in this box, e.g. 'U123'. At runtime, the current user dictionary is consulted and the bitmap 
referred to by the specified reference is displayed. For fixed bitmaps, enter the full path and 
filename of the required bitmap file. 

In-Place Toggle This checkbox is active only if the linked variable is an operator-writeable Integer or 
Boolean. Tick the box if you want to allow the operator to cycle (or toggle, in the case of 
Boolean values) round the possible values by simply touching the bitmap item on-screen. 
Leave it unticked if you instead want a menu of values to pop-up for selection when the 
operator touches the bitmap. 

13.10.4   OK 
Accepts the parameter changes and closes the dialogue. 

13.10.5   Apply 
Accepts the changes, and allows further configuration. 

13.10.6   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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13.11  BITMAP PROPERTIES PAGE 
Use this dialogue to specify the bitmap to be displayed on-screen by the Bitmap page object. 

NOTE 
.bmp, .pcx, .emf, .gif, .png bitmaps can be used. Bitmap filenames must be in standard DOS 8.3 format, 
(i.e. the 8-character filename is restricted to characters ’A’ .. ‘Z’, ‘a’ .. ‘z’, ‘0’ ..’9’, and ‘_’. No other 
characters are permitted as they could cause OIFL (. ofl) file-parsing problems in the target instrument.) 

To access this Properties page, right-click the object and select ‘Properties…’, from the context menu to pop-up 
the relevant Page Item Properties page. Then click the ‘Bitmap’ page. 

NOTE 
If bitmap enumeration has been enabled (in the Bitmap Enumeration Properties dialogue), all fields and 
buttons are disabled except for the ‘Monochrome’ and ‘Transparent’ checkboxes, which remain 
effective. 

The fields are: 

13.11.1   Bitmap 
Dictionary Click this radio button if the bitmap is language-dependent. The correct user-dictionary 

reference number must be entered in the Bitmap field, see below). 
Filename Click this button for a fixed bitmap specified by its filename (entered in the Bitmap field). 
Bitmap For language-dependent bitmaps, enter the correct user-dictionary reference number in this 

field, e.g. 'U123'. At runtime, the current user dictionary is consulted and the bitmap 
referred to by the specified reference is displayed. For fixed bitmaps, enter the full path and 
filename of the required bitmap file. 

Monochrome Tick this checkbox if you want the bitmap to display in ‘black-and-white’ only, even if the 
original bitmap is in colour. 

Transparent Tick this checkbox to make the bitmap appear ‘transparent’, i.e. other page objects overlaid 
by the bitmap will remain partially visible. 

Browse… Click this button to search for a suitable bitmap file to enter in the Bitmap box. 

13.11.2   OK 
Accepts the parameter changes and closes the dialogue. 

13.11.3   Apply 
Accepts the changes, and allows further configuration. 

13.11.4   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

Page 96 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.12   BROWSER BLOCK 
The icon represents the LIN function block category that the block belongs to. 

The block name (e.g. ‘t800’) is shown to the right of the category icon. 

Click the block’s ‘expand’ box on the left of the icon (initially labelled ‘+’) to see the individual block fields 
within as a ‘tree diagram’. 

NOTE 

When only LIN Function Blocks can be selected (e.g. a GROUP block in the Trend Graph Variable properties 
dialogue), ‘expand’ boxes are absent. 

If the browser lets you select a block, click the required block icon or name to select it. The block name and 
block category appear in the ‘Selection’ and ‘Type’ boxes, respectively, at the foot of the Browser window. 

13.12.1   Browser Field (no subfields) 
This icon represents a single block field in the (expanded) LIN function block. 

The absence of an ‘expand’ box next to the field icon means that the field contains no subfields. 

Select the field by clicking on it. Its full LIN name appears in the ‘Selection’ box at the foot of the Browser 
window, in the blockname.fieldname format. Its data type appears in the ‘Type’ box. 

13.12.2   Browser Field (with subfields) 
This icon represents a single block field in the (expanded) LIN function block. The field cannot be selected 
directly, only the expanded contents. (An ‘expand’ box next to the field icon means that the field contains 
subfields. Click the ‘+’ box to see the subfields.) 

13.12.3   Browser Multi-bit field 
A data type enclosed in angle brackets – e.g. <Subfield16> -- represents the entire multi-bit field above it. 

You can select this item if you want to link to the whole field, rather than just an individual bit. 

Click the field icon or name to select it. Its full LIN name appears in the ‘Selection’ box at the foot of the 
browser window, in the blockname.bitfield format. Its data type appears in the ‘Type’ box. 

13.12.4   Browser Selection box 
This shows the full LIN address of the selected block, field, or subfield. 

For a LIN block, the selection is displayed as a block name – e.g. ‘Group1’. 
For a field, the selection is displayed in blockname.fieldname format – e.g. ‘t800.Date’. 
For a whole multi-bit field, the selection is displayed in blockname.bitfield format – e.g. ‘t800.IP_type’. 
For a subfield, the selection is displayed in blockname.bitfield.bit format – e.g. ‘t800.IP_type.Imperial’. 

13.12.5   Browser Subfield 
This icon represents a single subfield in a multi-bit field. 

Click the subfield icon or name to select it. Its full LIN name appears in the ‘Selection’ box at the foot of the 
browser window, in the blockname.bitfield.bit format. Its data type appears in the ‘Type’ box. 

If you want to link to the whole field -- rather than just this individual bit – click the multi-bit field icon or name 
<in angled brackets> instead. 
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13.12.6   Browser Type box 
This shows the variable type or function block category for the selection. 

For a LIN block, the LIN function block category of the selected block is shown. 

For block fields, subfields, and multi-bit fields, the data type is shown. 

13.13 BUTTON TOOL PROPERTIES PAGE 
The button tool properties page is accessed as follows:. 

1. Double clicking on the Button  

2. Right-clicking on the item and selecting 'Properties...' in the resulting pop-up (context) menu, 

3.  Via Properties/Page item... in the Edit menu 

4  Using the shortcut <Alt> + <Enter>. 

The properties page opens: 

 
Access  See separate topic 'Access Properties page'. 

Confirmation.  See separate topic 'Confirmation Properties page'. 

Miscellaneous.  See separate topic 'Miscellaneous Properties page'. 

Text.  See separate topic 'Text Properties page'. 

Touch area.  See separate topic 'Touch Area Properties page'. 

13.14 COLOUR PALETTE 
(Foreground shown - Background similar) 
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13.15   CHARACTER BASED SCREEN TYPES 
In Character based Screen types, straight lines at various angles are drawn on the Target Screen type using 
special graphics characters that fit together to produce a best approximation to what is required. Line-segment 
characters include points, corners, horizontal, vertical, and 45° elements. At runtime these Line-segment 
characters are assembled by the Target Instrument to construct the required lines. 

To allow the editor to draw realistic character-based lines in a similar way, the required ASCII key code 
characters must be mapped to each of these special Line-segment symbols. The mapping is configured via a 
graphical character-symbol map. 

13.16   COLOUR ATTRIBUTE PROPERTIES PAGE 
Use this dialogue to configure the item to change colour as the value of a linked variable in the LIN Database 
changes.  Suitable variable types for linking to colour-change items are shown in the Data Types table. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop up the 
relevant ‘Page Item Properties dialogue’. Then click the ‘Colour Attribute’ tab.  The fields are, 

13.16.1   Colour Change 
Tick this box to enable colour-change for the selected page item. 

13.16.2   Variable selection 
LIN Variable 
Click this radio button if you want a LIN Database variable to control the colour changes. Enter the required 

point name in the ‘Name’ box, or use the ‘Browse…’ button to find the point, see below. 
Instrument Variable 
Click this button if you want an Instrument variable to control the colour changes. 
Name Type in the name of the controlling variable (or use ‘Browse…’, see next). The Variable type 

(e.g. Integer) is automatically entered for you from the list to the right of the ‘Name’ box. 
Use the standard LIN formats for the variable name, i.e. blockname.fieldname (e.g. 
TIC001.PV) or blockname.bitfield.bit format (e.g. Dig_A.Out.Bit3). 

Browse… Click this button to pop up a LIN Database Browser window. This lets you to select the 
required block and point from the database you associated with the Page Set (via the Page 
Set Properties dialogue), or the New Page Set dialogue.) The variable type is automatically 
entered for you when you use Browse. 

 

NOTE 

The Editor auto-validates entries, a red cross  indicating an invalid field; a green tick  a valid field. 
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13.16.3   Colour selection 
Value Select one of the three colour-change conditions from this pulldown menu, for individual 

configuration. You can configure for when the selected variable is less than ‘lo_limit’, is on 
or between the ‘lo’ and ‘hi’ limits, and when it is greater than the ‘hi_limit’. These low and 
high limits are specified in the Colour Limits Properties dialogue. 

Change Foreground  
Tick this box if you want to specify a Foreground colour-change when Value enters the 
selected condition. Click the required colour from the pulldown palette of colours 
configured for this target. 

Change Background/Fill  
Tick this box if you want to specify a Background/Fill colour-change when Value enters the 
selected condition. Click the required colour from the pulldown palette of colours. 

13.16.4   OK 
Accepts the parameter changes and closes the dialogue. 

13.16.5   Apply 
Accepts the changes, and allows further configuration. 

13.16.6   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.17   COLOUR LIMITS PROPERTIES PAGE 
Use this dialogue to define the low and high limits used in the Colour Attributes Properties dialogue. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop up the 
relevant Page Item Properties dialogue. Then click the ‘Colour Limits’ tab.  The fields are: 

13.17.1   Colour Limit Minimum 
None Click this radio button if you do not require a low limit. 
Constant Click if you want the low limit to be a fixed value. Type the required constant in the ‘Value’ 

box. 
LIN Variable Click if you want the low limit to be equal to a LIN Database variable. Type in the name of 

the variable in the ‘Name’ box (or use ‘Browse…’, see next). Use the standard LIN formats for 
the variable name, i.e. blockname.fieldname (e.g. TIC001.PV) or blockname.bitfield.bit 
format (e.g. Dig_A.Out.Bit3). 

 

NOTE 
The variable type must be the same as that of the Colour Attribute controlling variable. 

 

Instrument Variable [Not implemented]. 
Browse… Click this button to pop-up a LIN Database Browser window. This lets you to select the 

required block and point from the Database you associated with the Page Set (via the Page 
Set Properties dialogue), or the New Page Set dialogue). 

NOTE 

The Editor auto-validates entries, a red cross  indicating an invalid field; a green tick  a valid field. 
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13.17.2   Colour Limit Maximum 
Use these fields in the same way as the corresponding ‘Colour Limit Minimum’ fields. 

13.17.3  OK 
Accepts the parameter changes and closes the dialogue. 

13.17.4   Apply 
Accepts the changes, and allows further configuration. 

13.17.5   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.18   COLOUR SETUP DIALOGUE 
This dialogue permits the Colour setup for the current Target Screen type. 

13.18.1   Default colours 
Default foreground colour 
 Use this list to select the required default foreground colour. 
Default background colour 
 Use this list to select the required default background colour. 

13.18.2   Colour options 
Target supports Colour change commands 
 If enabled, the Target Screen type will allow the default Colour to change at the request of a 

configured Action. 

13.19   CONFIGURE PAGE ITEM ACTIONS 
To configure a suitable object to execute a User Screen Editor Action enter the Action script into the specific 
Page Item ‘Action’ edit box. This appears in the Touch Area Properties dialogue. Up to 200 characters can be 
used to specify a comma-separated list of Actions. 

13.19.1   Enabling Actions 
Individual Actions may be 'enabled' or 'disabled' according to the state of the Target Instrument. For example: 

‘ACK_ALL’ is disabled if there are no unacknowledged alarms present. 

‘GOTO:4’ is disabled if there is insufficient Operator Access Level to permit viewing of this particular User 
Screen, etc. 

NOTE 
If one or more Actions in a list is in the disabled state, then none of the actions execute when the object 
is activated, even the enabled ones. For Button Page Items, the 'disabled' state is indicated by the button 
legend being 'greyed out'. 
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13.20   CONFIRMATION PROPERTIES PAGE 
This dialogue is available for non-variable Text-based Page Items (buttons and text). It allows the User to specify 
any confirmation characteristics required. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up the 
relevant Page Item Properties dialogue. Then click the ‘Confirmation’ tab.  The fields are: 

13.20.1   Required Confirmation Type 
No Confirmation Use this radio button to specify that confirmation is not required to initiate the action 

configured for this Page Item. 
Confirmation Only Use this radio button to specify that only confirmation is required to initiate the action 

configured for this Page Item. 
Signature Use this radio button to specify that only one signature is required to initiate the action 

configured for this Page Item. 
Sign and Authorise Use this radio button to specify that two signatures are required to initiate the action 

configured for this Page Item. 

13.20.2   OK 
Accepts the changes and closes the dialogue. 

13.20.3   Apply 
Accepts the changes, and allows further configuration. 

13.20.4   Cancel 
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13.21   DATA TYPES 
When linking a Variable to a Page Item to make it Dynamic, the User Screen Editor displays the relevant data 
type for the Variable. 

NOTE 
If the Variable is not recognised by the User Screen Editor, it may have to be entered manually. 

 

Data Type Description 

CharacterNC Single 8-bit character 

BooleanEN Bit (0 or 1) 

IntegerBC EN Signed 16-bit integer 

LongBC EN Signed 32-bit integer 

SingleBC EN 32-bit floating-point value 

DoubleBC EN 64-bit floating-point value 

StringNC String of 8 characters 

EnumerationEN List of strings representing values 

BlockRefNC LIN Block TagName (8 character max) 

UIntegerBC EN Unsigned 16-bit integer 

UlongBC EN Unsigned 32-bit integer 

Alarm LIN Block Alarm State 
(0=Inactive, 1=Active, 2=Inact Unack, 3=Act Unack) 

TimeNC Time-of-Day 
(hh:mm:ss or hh:mm:am/pm) 

Date Date 
(dd:mm:yyyy) [plus International formats] 

Subfield8 8-bit Subfield 

Subfield16 16-bit Subfield 

Normalised Normalised floating-point value 

NormLow Low value used for normalisation 

NormHigh High value used for normalisation 

  

NOTE 
NC = Not Compatible Colour Change Data Type. 

BC = Compatible Bar Chart Page Item Data Type. 

EN = Enumeration compatible Text Variable Page Item Data 
Type (via the Enumeration Properties dialogue). 
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13.22   DEFAULT T2900 AGENTS 
The table below lists the IDs and names of the default T2900 built-in Agents. 

ID     Agent Name 

1000 Top Level Menu 

2000 System Menu 

2010 System Summary 

2020 Application Summary 

2030 Startup Setup 

2040 Communications Setup 

2050 Clock Setup 

2060 Internationalisation Setup 

2070 Panel Setup 

2080 Cloning 

2200 Application Menu 

2210 Application Manager 

2300 Setup Menu 

3000 Programmer Menu 

3010 Programmer - Monitor 

3011 Programmer - Program Selection 

3012 Programmer - Scheduling 

3013 Programmer - Preplot 

3014 Programmer - Editor 

3015 Programmer - Preview 

3016 Programmer - Run form 

4000 Security Access 

5000 Logging Menu 

5010 Logging - Monitor 

5011 Logging - Offline 

5012 Logging - Archive Management 

5013 Logging - Groups 

9000 Alarm Menu 

9010 Alarm History 
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13.23  ENUMERATION PROPERTIES PAGE 
Use this dialogue to specify what enumeration, i.e. text string, a Text Variable Page Item is to display as the 
value of the linked variable changes. 

A suitable linked Variable must first be specified via the Variable Properties dialogue. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up the 
relevant Page Item Properties dialogue. Then click the ‘Enumeration’ tab.  The fields are: 
No enum Use the radio button if an enumeration is not required, i.e. the actual linked variable value is 

displayed. 
Text Use this radio button in conjunction with the ‘Value’ and ‘Enumeration’ fields to indicate a 

set of text strings are to be displayed, dependent on the value of the linked Variable. 
Dictionary Use this radio button in conjunction with the ‘Value’ and ‘Enumeration’ fields to indicate the 

enumeration strings are language-dependent. 
Value Floating-point Variables 

 These are Variables that can be configured when the linked Variable is less than ‘lo_limit’, 
is on or between the ‘lo’ and ‘hi’ limits, and when it is greater than the ‘hi_limit’. These low 
and high limits are specified in the item’s Limits Properties dialogue. 

 Integer or Boolean Variables 
 Use the ‘Value’ field to specify one of the possible values from the menu for individual 

configuration. 
Enumeration Text 
 Use this field to specify the text string that is to be displayed when the linked Variable 

obeys the condition, or adopts the value selected in the ‘Value’ box. 
 Dictionary 

 Use this field to specify the correct user-dictionary reference number in this field, e.g. 
'U123'. At runtime, the current user dictionary is consulted and the string referred to by 
the specified reference is displayed as the text enumeration. 

In-Place Toggle This checkbox is active only if the linked Variable is an operator-writeable integer or 
Boolean. Use it to allow the operator to cycle (or toggle, in the case of Boolean) round the 
possible values by simply touching the Page Item on-screen. 

 If the check box remains blank, a list of values is revealed in a pop-up when the operator 
touches the Page Item. 

13.23.1   OK 
Accepts the parameter changes and closes the dialogue. 

13.23.2   Apply 
Accepts the changes, and allows further configuration. 

13.23.3   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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13.24  FILL STYLE PROPERTIES PAGE 
This dialogue applies to Page Items that possess a solid border, such as a Rectangle, Ellipse, or Triangle. Use this 
dialogue to specify how the selected Page Item should appear on the Target Screen type.  The fields are: 

13.24.1   Fill style 
Fill style/pattern Use this list to select the fill pattern required for the selected Page Item. 

13.24.2   Fill mode 
Fill mode Use this list to select the how the fill pattern should react.  

13.24.3   OK 
Accepts the parameter changes and closes the dialogue. 

13.24.4   Apply 
Accepts the changes, and allows further configuration. 

13.24.5   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.25   FONT SETUP DIALOGUE 
This dialogue permits the Font setup for the current Target Screen type. 

13.25.1   Default Font 
Default Font Use this list to select the required default Font. 

13.25.2   Font options 
Target supports Font change commands 
 If enabled, the Target Screen type will allow the default Font to change at the request of a 

configured Action. 

13.25.3   Font dialogue 
Use this dialogue to configure the parameters for the selected Font Page Item. This dialogue permits changes to 
the, 
Font Select the Font required. Select from any Windows Font currently installed in the Fonts 

directory. 
Font Style Select the style required, i.e. Regular, Bold, Italic, or Bold Italic. 
Font Size Select the Font Size required. This is generally in the range of 8 to 72, but some Fonts may 

only support limited Font Sizes. 
Effects Select the effects required. This includes Strikeout, a single line through the centre of the 

text, Underline, a single line below the text, and Color, a picklist to specify the colour 
required for the selected Text. 

Script Select the Script required. This is used to assist with the display of Fonts that may be used in 
other regions throughout the world. 

Sample Shows an example of the defined parameters. 
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13.26   FORMAT PROPERTIES PAGE 
Use this dialogue to specify the precision and format of real number Page Item, and the format of integer 
number Page Items. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up the 
relevant Page Item Properties dialogue. Then click the ‘Format’ tab.  The fields are: 

13.26.1   Number accuracy 
Decimal places For real numbers, select the required number of decimal places using the scrollable menu in 

the box. 

13.26.2   Real Number format 
Fixed point Selects decimal format e.g. 123,456,000.00 
Engineering notation 
 Selects an ‘exponent’ format, where the exponent value must be 3, 6, 9, 12 etc (i.e. a 

multiple of three). This is in order that the value be represented in terms of thousands, 
millions, billions, trillions etc. There may be up to three digits before the decimal point, e.g. 
123.456E+6. [Not implemented] 

Scientific notation Selects ‘standard’ exponent format (only one digit before the decimal point, e.g. 1.234E+8. 

13.26.3   Integer Number format 
Decimal Value is displayed as a base 10 value, e.g. 239. 
HEX Use this radio button to indicate that ‘hexadecimal’ display of the value (base 16) is 

required, e.g. 1E4F. 
HEX (lowercase) Use this radio button to indicate that ‘hexadecimal’ with lower-case characters display of the 

value (base 16) is required, e.g.1e4f. 
Binary Use this radio button to indicate that ‘binary’ display of the value (base 2) is required, e.g. 

11101111. 
Pad with Leading Zeroes 
 Use this checkbox to indicate that zeroes will automatically be inserted in front of the 

displayed number, to completely fill any spare character spaces in the field, e.g. for a 6-
character field width, the decimal display might be 000239. 

13.26.4   OK 
Accepts the parameter changes and closes the dialogue. 

13.26.5   Apply 
Accepts the changes, and allows further configuration. 

13.26.6   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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13.27  GRID SETTINGS DIALOGUE 
Use this dialogue to configure the snap-to points of the User Screen Editor’s grid. 

Tip! 
Turning the Grid on will help when attempting to align Page Items. 

  

NOTE 
A Grid has the same effect when displayed or hidden. 

Access the dialogue by clicking the Grid Settings button in the Placement Bar. The dialogue fields are: 

13.27.1   Major grid settings 
These fields specify the major grid horizontal and vertical spacing. 

13.27.2   Minor grid settings 
The minor grid settings are relative to the top-left corner of each major grid cell (0, 0). 

13.27.3   General grid settings 
Snap to grid Check this to cause the vertices (or bounding-box corners) of Page Item being drawn to 

snap to the grid (whether hidden or not). 
Use minor grid lines for item alignment 
 Check this to make the ‘snap to grid’ (if selected) and ‘nudge items…’ alignment action work 

on the minor grid lines. If left unchecked, only the major grid lines are used. 
Nudge items to nearest grid line 
 Check this to cause highlighted item(s) to jump one grid spacing in the selected direction 

each time a keyboard cursor key is pressed. If unchecked, they jump one pixel only. This 
works even if ‘snap to grid’ is not selected. 

Use dotted lines for grid lines 
 Check this to make the grid lines appear dashed. If unchecked, the grid lines are solid. 

13.27.4   Configure using default font 
Click this button to set the major grid spacing to match the default font cell size -- convenient for laying out 
text. 

13.27.5   OK 
Click to close the dialogue and enable the grid settings. 

13.27.6   Cancel 
Click to close the dialogue without altering the existing grid settings. 
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13.28   LIMITS PROPERTIES PAGE 
Use this dialogue to apply minimum and maximum limits to Page Item Variable. Limits can perform several 
functions: 

They specify high/low ranges for a Page Item (e.g. the 0% and 100% display values on a Bar Chart). 

They set operator input limits for writeable linked Variables. 

They define the three zones for enumerated Instrument Variable (i.e. less than the low limit, on or between the 
limits, greater than the high limit). 

NOTE 

Limits do not affect the linked LIN Database Variables, only their display. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up the 
relevant Page Item Properties dialogue. Then click the ‘Limits’ tab.  The fields are: 

13.28.1   Low Limit 
None Use this radio button if a minimum limit is not required. 
Constant Use this radio button if the minimum limit must be the constant (fixed) value, as entered in 

the adjacent ‘Value’ field. 
LIN Variable Use this radio button if the minimum limit must be equal to a LIN Database Variable. Use 

the standard LIN formats for the variable name, i.e. blockname.fieldname (e.g. TIC001.PV) 
or blockname.bitfield.bit format (e.g. Dig_A.Out.Bit3). Use the ‘Browse…’ button to 
display the LIN Database Browser dialogue, to assist with locating the required Variable. 

 

NOTE 

The Variable type (i.e. boolean) must be the same as that of the linked Variable (i.e. boolean). 
Instrument Variable  

Use this radio button to select to link the Page Item with a Instrument Variable.  Use the 
Browse… button to display the Instrument Browser dialogue, to assist with locating the 
required Variable. 

 

NOTE 

The Editor auto-validates entries, a red cross  indicating an invalid field; a green tick  a valid field. 

13.28.2   Maximum 
Use these fields in the same way as the corresponding ‘Minimum’ fields – see above. 

13.28.3   OK 
Accepts the parameter changes and closes the dialogue. 

13.28.4   Apply 
Accepts the changes, and allows further configuration. 

13.28.5   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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13.29  MISCELLANEOUS PROPERTIES PAGE 
This properties page applies to all Page Items. It is used it to generate an OIFL string, contained in an OIFL file 
(.ofl).  To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up 
the relevant Page Item Properties dialogue. Then click the Miscellaneous tab. The fields are, 

13.29.1   Miscellaneous 
Generate OIFL string for this page 

A ticked check box indicates an OIFL string will be immediately generated for the selected Page Item and 
appended to the OIFL file (that ultimately will be downloaded to the Target Instrument). 

An empty check box indicates an OIFL string is either not generated, or, is deleted if the string for that Page 
Item already exists in the file. 

13.29.2   OK 
Accepts the parameter changes and closes the dialogue. 

13.29.3   Apply 
Accepts the changes, and allows further configuration. 

13.29.4   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

NOTE 
The OIFL for the whole page can be inspected using the Page > Show OIFL Strings drop-down menu. 

13.30 NEW PAGE SET DIALOGUE 
Use this dialogue to create a new Page Set required to store all Pages used by the Target Instrument, defined in 
the Location of DB file for Page Set field.  The fields are: 

13.30.1   Name of new Page Set 
The Name of new Page Set is used within the User Screen Editor to identify the Target Instrument or Project, 
e.g. 'T2900_0f'. This field will automatically include the .uxp extension when saved. 

Beware… 
The Page Set name MUST match the LIN Database (*.dbf) filename so the correct screens are displayed 
when downloaded. 

Failure to ensure this will result in downloading a Page Set to the Target Instrument, which may be 
incorrect. This could cause problems with the operation of the instrument. 

To resolve this problem, 
Rename the Page Set. Select Edit > Properties > Page Set to display the Page Set Properties dialogue. 

13.30.2   Target panel 
Lists all the Target Instrument Panes type currently configured in the Targets directory. 
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13.30.3   Status Pane OIFL file 
This field specifies a path to the .OFL file that is added automatically to User Screen Editor output, to define the 
required Status pane. 

NOTE 
If left in its pre-configured default value (blank) the default Status pane will be specified. 

13.30.4   Location of DB file for Page Set 
Shows the full path and filename of the LIN Database file (*.dbf, control strategy) that Dynamic Page Items in 
the Page Set will be linked to. 

Use the ‘Browse…’ button to help locate the LIN Database file, if required. 

NOTE 
This field can initially be left blank. 

13.30.5   OK 
Accepts and closes the configured Page Set dialogue. An empty Page Set window appears on the worksheet 
entitled with the name entered in the ‘Name of new Page Set’ field. 

NOTE 
A Page Set can also be saved using the Save commands. 

13.30.6   Cancel 
Closes the dialogue without making any changes to the Page Set properties. 

13.31  OIFL PROPERTIES PAGE 
This page applies only to the OIFL Page Item. Use it to directly specify any OIFL (.ofl) (Operator InterFace 
Language, .ofl) code that you want added to the code generated by other objects on the page. This is a way to 
add functionality to the User Screen that is not currently provided by standard User Screen Editor Page Items. It 
is not likely to be required by most developers. 

The added code is inserted in the OIFL output, located by default according to when the OIFL Page Item was 
created. You can alter its position using the layer-ordering tools (Bring to Front, Send to Back, etc.). 

To view the OIFL code generated by the page, in the Editor’s Page menu, select ‘Show OIFL Strings’. The OIFL 
for the current page is displayed in a pop-up window. 

NOTE 

The OIFL Page Item is not shown as an object on the actual Target Screen. 

To access the page, right-click the OIFL Page Item and select ‘Properties…’ from the context menu to pop up 
the Page Item Properties dialogue. Then click the ‘OIFL’ page.  The fields are, 

13.31.1   Display 
Label Enter a suitable identifying legend to appear on the OIFL Page Item. This is not seen in the 

OIFL code or anywhere else. 
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13.31.2   OIFL 
Type in the OIFL code you want added to the output for the page. 
OIFL code syntax is not described in this help file. Contact the manufacturer for further information. 

13.31.3  OK 
Accepts the parameter changes and closes the dialogue. 

13.31.4   Apply 
Accepts the changes, and allows further configuration. 

13.31.5 Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.32   PAGE 

13.32.1   Page Item Actions - Example 

RUN 

This action runs the currently loaded SPP program. 

ACK_ALL,GOTO:4 

This list causes all alarms to be acknowledged, then jumps to the User Screen with an ID of 4. (It could also 
jump to a built-in page if its ID is correctly specified, e.g. the Alarm History page, which has a default ID of 
9010.) 

ST:"[PID1.SL]:=12.34;" 

This ‘Structured Text’ Action sets the function block input PID1.SL to 12.34. 

ST:"[PID1.IN]:=NOT[IN];" 

This ‘Structured Text’ Action creates a Toggle button. It causes a configured Page Item to toggle between the 
Background colour and original appearance when activated. Add this text to the Touch Area page of the Page 
Item Properties dialogue and ensure the Action radio button is defined. 

ENA:"[MTR01.MODEACT.MANACT]" 

This provides an ‘Enable’ instruction, used to enable an action. It causes a configured Page Item to remain 
disabled until a specified condition is achieved. Add this text to the Touch Area page of the Page Item 
Properties dialogue and ensure the Action radio button is defined. 

When entering the 'Action' text, add the ‘Enable’ instruction and ‘Structured Text’ Action, separated with a 
comma (,). The following example shows a motor start button, that will remain disabled unless the motor is in 
manual mode. 

Example 
ENA:"[MTR01.ModeAct.ManAct]",ST:"[MTR01.Demand]:=1;" 
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13.32.2   Page Item Properties dialogue 
The properties of each Page Item differ, i.e. the Touch Area Page Item includes an, Access page, Fill Style page, 
Touch Area page, and a Miscellaneous page, whereas the Rectangle Page Item includes the Access page, 
Appearance page, Fill Style page, Colour Attribute page, Colour Limits page, and Miscellaneous page. 

NOTE 
A Confirmation page appears if an appropriate Target Panel type was selected, e.g. svga v4.0 Auditor 
(Pixel). 

 

13.32.3   Page Properties dialogue - Names page 
Use this dialogue to inspect and edit the ‘name’ properties of an existing Page. To access the dialogue from the 
Page Set window, right-click the Page icon and select ‘Properties…’ from the context menu, or highlight the 
Page icon, then pull down the Edit menu and click Properties > Page… 

Click the ‘Names’ tab to see the Names page of the dialogue.  The fields are: 

PAGE NAME & ID 

Inspect/edit the Page Name. It is used within the User Screen Editor for information only. E.g. it appears in the 
Page Set window as an icon label. 

Inspect/edit the ID number for the page. This must be a positive integer, 1-999. 

'Built-in' pages have IDs > 999. 

The ID is used in the OIFL file to refer to the page, and in other pages, e.g. for a button jumping to this page or 
a built-in page.  The 'home page' is normally assigned an ID of '1'. This is usually the power-up and timeout 
page, and is accessible from the top-level menu. 

PAGE TITLE 

Inspect/edit the title to appear on the instrument display for the page, as a fixed string or a dictionary 
reference. 

Check the Use Dictionary box if you want the title to change if the language is changed. Enter the 
corresponding user-dictionary reference number in the Dictionary Entry No field, e.g. 'U123'. At runtime, the 
current user dictionary is consulted and the string referred to by the specified reference is displayed as the title. 

For a fixed title, simply type the required character string into the Title field. 

NOTE 

User dictionaries have filenames such as _user.uyl (for single-language systems), or _user n.uyl (for 
multilingual systems, where n = 0 to 9). 

 

HA260749U005  Page  113  
Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.30.3  PAGE PROPERTIES DIALOGUE – NAMES PAGE (Cont.) 

LEGEND 

Inspect/edit the page Legend. This is normally a very brief (typically 8 characters max.) description of the page 
that can appear in a displayed selection-menu in the Target Instrument. In use, the operator selects or 'clicks' 
the legend, which may often be displayed as a 'button' marked with the legend, and the page pops up on-
screen. 

Check the Use Dictionary box if you want the legend to change if the language is changed. Enter the 
corresponding user-dictionary reference number in the Dictionary Entry No field, e.g. 'U123'. At runtime, the 
current user dictionary is consulted and the string referred to by the specified reference is displayed as the 
legend. 

For a fixed legend, simply type the required character string into the Legend field. 

ACCESS LEVEL 

Inspect/edit the Access Level for the whole page, by clicking the required radio button: 

Always accessible, (i.e. for any operator level) or 

Accessible if operator level is >= (greater than or equal to). Select an operator level (1 to 4). 

DESCRIPTION 

This is for user-information only as an aid to maintainability, and is not transferred to the runtime system. 

13.32.4  Page Properties dialogue - OSFK page 
Use this dialogue to specify the OSFK pane associated with a particular pane, if more than one OSFK pane is 
configured. To access the dialogue from the Page Set window, 

right-click the Page icon and select ‘Properties…’ from the context menu, or 

highlight the Page icon, then pull down the Edit menu and click Properties > Page… 

 

NOTE 
The Off Screen Function Key (OSFK) pane is only available if the Target Screen type supports Off Screen 
Function Keys. 

Click the ‘OSFK’ tab to see the OSFK page of the dialogue. 

13.32.5 OSFK Pane list 
Use the list to select the required OSFK pane. The selected OSFK Pane is then associated with this Page. 

Page 114 HA260749U005 
 Issue 7  Dec 14 



USER SCREEN EDITOR HELP MANUAL 

13.32.6   Page Properties dialogue - Target page 
Use this dialogue to inspect the target associated with an existing Page. To access the dialogue from the Page 
Set window right-click the Page icon and select Properties… from the context menu, or highlight the Page icon, 
then pull down the Edit menu and click Properties > Page…  Click the ‘Target’ tab to see the ‘Target’ page of the 
dialogue.  The (read-only) fields are: 

  TARGET PANEL 

This field shows the target panel associated with the current Page Set, which was selected via the ‘New Page 
Set’ dialogue when the Page Set was created. 

  PANE 

This field shows the type of pane selected for this Page. If a Pop-up Pane was selected, the Width and Height 
of the pane are also displayed. 

  WIDTH AND HEIGHT 

These fields show the dimensions of the selected Pane. 

13.33  PAGE SET PROPERTIES DIALOGUE 
Use this dialogue to inspect and edit the properties of an existing Page Set. You can access the dialogue from 
the Edit menu by clicking Properties > Page Set….  The fields are: 

13.33.1   Name of Page Set 
The Name of new Page Set is used within the User Screen Editor to identify the Target Instrument or Project, 
e.g. 'T2900_0f'. This field will automatically include the Page Set file (.uxp) extension when saved. 

Beware… 
The Page Set name MUST match the LIN Database (*.dbf) filename so the correct screens are displayed 
when downloaded.  Failure to ensure this may result in downloading a Page Set to the Target Instrument, 
which may be incorrect. This could cause problems with the operation of the instrument. 

To resolve this problem rename the Page Set: Select Edit > Properties > Page Set to display the Page Set 
Properties dialogue. 

13.33.2   Location of DB file for Page Set 
Shows the full path and filename of the LIN Database file (*.dbf, control strategy) that Dynamic Page Items in 
the Page Set will be linked to. 
Use the ‘Browse…’ button to help locate the LIN Database file, if required. 

NOTE 
This field can initially be left blank. 

13.33.3   Status Pane OIFL file 
This field specifies a path to the .ofl file that is added automatically to User Screen Editor output to define the 
required Status pane. 

NOTE 
If left in its pre-configured default value (blank) the default Status pane will be specified. 
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13.33.4   Target panel 
Lists all the Target Instrument Panes type currently configured in the Targets directory. 

13.33.5   OK 
Accepts and closes the configured Page Set dialogue. An empty Page Set window appears on the worksheet 
entitled with the name entered in the Name of new Page Set field. 

NOTE 
A Page Set can also be saved using the Save commands. 

13.33.6   Cancel 
Closes the dialogue without making any changes to the Page Set properties. 

13.34   PANE SETUP DIALOGUE 
This dialogue permits the Pane setup for the current Target Screen type. 

13.34.1   Default Pane 
Default Pane Use this list to select the required default Pane. 

13.35   PASSWORD PROTECTION 
This password can be used to prevent unauthorised personnel from viewing or editing Target definitions. To 
change (or disable) the password, click 'Set Password' in the Target Panels dialogue, to pop-up the Change 
Password dialogue. Type the new password into both fields and click 'OK' to effect the change. 

To disable the password, simply leave both fields completely blank before hitting 'OK'. 

NOTE 
Space characters are valid password characters. 
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13.36 PROGRAM PROFILE PROPERTIES PAGE 
The Properties page allows a 'PROGCTRL' block to be assigned to the item.  The page is accessed by: 

1. Double clicking on the Program profile.  

2. Right-clicking on the item and selecting 'Properties...' in the resulting pop-up (context) menu, 

3.  Via the Properties/Page item... in the Edit menu 

4.  Using the shortcut <Alt> + <Enter>. 

 
Access.  See separate topic 'Access Properties page'. 

Appearance.  See separate topic 'Appearance Properties page'. 

Colour attribute  See separate topic 'Colour attribute Properties page'. 

Colour limits.  See separate topic 'Colour limits Properties page'. 

Miscellaneous. See separate topic 'Miscellaneous Properties page'. 

13.36.1 Program profile 

VARIABLE 

This tab allows the user to browse the associated database and to select that profile block which is to appear 
on the screen. 

TREND TYPE 

Preview  Shows the program profile as a static profile. 

Monitor   As Preview (above) but with a moving indicator showing which segment is currently running. 

13.36.2 Program Profile appearance 
The Program Profile window is drawn on the User Screen Editor page containing a question mark until a 
'PROGCTRL' block has been assigned to it using the properties page. 

Once such a block has been assigned, the question mark disappears.  
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13.37 TARGET INSTRUMENT DIALOGUE 
This dialogue permits the user to permanently include a defined Instrument Type and Version in this Page Set. 

13.37.1   Instrument 
Type Enter the required Instrument type name, i.e. T800, T820, T940, etc., used in the system. 
Version Enter the Version of the Instrument type specified in the Type field, i.e. v4.7, v4.8, etc., used 

in the system. 
 

Tip! 
Use existing table entries as a guide to clarifying the Instrument Type and Version. 

 

13.38 TARGET PANEL DIALOGUE 
Use this dialogue to create or edit, either Pixel-based Target Screen types or Character-based Target Screen 
types. To access the dialogue, from the Editor window pull down the File menu and click ‘Target Definitions’. 
The fields are: 

13.38.1   Currently defined Target Panels 
Select the required Target Screen type from the list. This is a list of all the Target Screen types currently 
configured in the Targets directory. 

13.38.2   New 
Initiates the Target Panel wizard. This wizard makes creating a Target Screen type easy. 

NOTE 
Customised Target Screen types can be created. This is not recommended as each file (.uxt) contains the 
unique default configuration of the selected Target Screen type. 

13.38.3   Edit 
Displays the Target Panel dialogue after selecting the Target Screen type that requires editing. 

13.38.4   Remove 
Deletes the selected Target Screen type. 

13.38.5   OK 
Stores the new Target Screen type specifications and closes the dialogue. 

13.38.6   Cancel 
Closes the dialogue without making any changes to the Page Set properties. 

13.38.7   Set Password 
Click this button to display the Change Password dialogue. This allows a password to be configured that will 
restrict access to the Target Panels dialogue. 

NOTE 
Use the Set Password button to restrict access to the Target Panels dialogue. Any attempt to open this 
dialogue will request a password to continue. 
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13.39 TEXT PROPERTIES PAGE 
This dialogue is available for non-variable Text-based Page Items (buttons and text). It allows the User to specify 
the characteristics of the text, and a dictionary entry number for international text languages. 

To access the dialogue, right-click the object and select ‘Properties…’ from the context menu to pop-up the 
relevant Page Item Properties dialogue. Then click the ‘Text’ tab.  The fields are: 

13.39.1   Font 
Use Windows Fonts Use this checkbox to indicate that the defined Target Screen type supports Windows Fonts, 

installed in the Fonts directory. 
Font name Use this list to specify a required Font type for the specified Target Screen type. 
Flashing Use this checkbox to specify a flashing text is required. Predetermined colour-pairs in the 

instrument palette provide the flashing. The Editor shows only one of an alternating pair of 
colours, i.e. does not flash. 

Highlighting Use this checkbox to specify a highlighting text is required. 
Select Font Shows the Font dialogue. This dialogue permits the selection of a specific Font already 

installed in the Fonts directory. 

13.39.2   Alignment & Underlining 
Alignment Use this list to align the selected Text to the nearest character width. 
 

NOTE 
‘Left Centre’ and ‘Right Centre’ bias the alignment one character-width in the specified direction when the 
string cannot be positioned in the exact centre. 

 
Underlining… Click this button to access the target’s underline options. (Only for targets supporting 

underlining.) 

13.39.3   Text 
Use Dictionary Use this checkbox if you want the text to change if the language is changed. 
Dictionary Entry No Enter the correct user-dictionary reference number in this field, e.g. 'U123'. At runtime, the 

current user-dictionary is consulted and the string referred to by the specified reference 
number is displayed as the text. 

 

NOTE 

User dictionaries have filenames such as _user.uyl (for single-language systems), or _user n.uyl (for 
multilingual systems, where n = 0 to 9). 

13.39.4   OK 
Accepts the parameter changes and closes the dialogue. 

13.39.5   Apply 
Accepts the changes, and allows further configuration. 

13.39.6   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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13.40   TEXT VARIABLE PROPERTIES PAGE 

 
The Properties page  is accessed by: 

1. Double clicking on the relevant page item  

2. Right-clicking on the item and selecting 'Properties...' in the resulting pop-up (context) menu, 

3. Via Properties/Page item... in the Edit menu 

4  Using the shortcut <Alt> + <Enter>. 

13.40.1 Text Tab 
This is available for Text Variable page items and is used to specify the font, alignment, and underlining 
characteristics of the text. 

FONT 
Font name Select a font from the list of fonts (specified for the target). 
Flashing Tick the checkbox to specify ‘flashing’ text.  If the box is disabled, the instrument does not 

support flashing text. 
Highlighting Tick the checkbox to specify ‘highlighting’ text. If the box is disabled, the instrument does 

not support highlighting text. 

ALIGNMENT & UNDERLINING 
Alignment Select a horizontal alignment from the list. (Text is aligned to the nearest character width. 

‘Left Centre’ and ‘Right Centre’ bias the alignment one character-width in the specified 
direction when the string cannot be positioned in the exact centre.) 

Underlining… Click this button to select an underline option.  If the box is disabled, the instrument does 
not support  text underlining. 

13.40.2   OK 
Accepts the parameter changes and closes the dialogue. 

13.40.3   Apply 
Accepts the changes, and allows further configuration. 

13.40.4   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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13.41   TOUCH AREA PROPERTIES PAGE 
This is a defined area on a touch-sensitive screen that responds to pressure in a specific way, e.g. by screening a 
new Page.  Touch areas created with the Touch Area tool are invisible, but can be identified to the operator by 
overlapping them with suitable graphics. 

Alternatively the ‘Touch Area Properties’ page of several other page objects (rectangles, ellipses, bitmaps, and 
buttons) can be configured to make them touch-sensitive. 

To access this Properties page, right-click the object and select ‘Properties…’, from the context menu. This 
displays the relevant Page Item Properties page. Then click the ‘Touch Area’ page.  The fields are: 

13.41.1   Touch Area Type 
No Touch Click this radio button to disable the touch-sensitivity of the object. 
Go to page Click this button to cause the specified destination agent display (see below) to appear when 

the object is touched, with no return to the original page via the <Escape> or <Exit> button 
being available automatically. 

Go to page with EXIT  
Click this button to cause the specified destination agent display to appear on touch, and to 
give the operator the ability to return to the original page via a target-specific <Escape> or 
<Exit> button, e.g. on a keypad. 

Action Click this button to allow a User Screen Action to be configured in the Action box (see 
below). 

13.41.2   Destination Page ID & Name 
Destination ID Enter the ID number of the required ‘go to’ destination Agent, or use the ‘Browse…’ button 

(see below). 
Name Enter the name of the ‘go to’ destination agent, or use the Browse… button. 
Browse… Click this button to pop up a Display Page IDs dialogue. This lists the IDs and Names of all 

the pages you have configured in the current Page Set. Click the required ID number and hit 
the dialogue’s ‘OK’ button to select that Page. Its details appear in the properties dialogue. 

13.41.3   Action 
In this edit box, type a comma-separated list of User Screen Actions to be executed when the object is 
activated. Up to 200 characters may be entered. 

Typical user screen actions might include, setting a function block field to a specified value, acknowledging 
alarms, and changing the programmer state. 

13.41.4   OK 
Accepts the parameter changes and closes the dialogue. 

13.41.5   Apply 
Accepts the changes, and allows further configuration. 

13.41.6   Cancel 
Closes the dialogue without making any changes to the Page Item Properties 
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13.42   TREND GRAPH PROPERTIES PAGE 
This properties page applies to the Trend Graph Page Item only, and lets you specify the growth direction of 
the trended value.  

To access the dialogue, right-click the trend graph object and select ‘Properties…’ from the context menu to 
display the Trend Graph Page Item Properties page. Then click the ‘Trend Graph’ tab.  The fields are: 

13.42.1   Growth direction 
Horizontal Value (Vertical Scroll) 
 Click this radio button to make values grow horizontally in a rightwards direction, with the 

trend 'paper' scrolling down the display (like a conventional chart recorder). 
Vertical Value (Horizontal Scroll) 
 Click this button to make values grow vertically upwards, with the trend 'paper' scrolling 

leftwards across the display. 

13.42.2   OK 
Accepts the parameter changes and closes the dialogue. 

13.42.3   Apply 
Accepts the changes, and allows further configuration. 

13.42.4   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.43   TREND GRAPH VARIABLE PROPERTIES PAGE 
This properties page applies to the Trend Graph Page Item only. Use it to assign up to six LIN Database points 
for trending on the Trend Graph.  For LIN Databases, points to be trended must each be allocated a channel 
number (from 1-16) within a single GROUP LIN function block. This LIN function block type is in the ORGANISE 
category of LIN function blocks. 

To access the dialogue, right-click the trend graph object and select ‘Properties…’ from the context menu to 
pop up the Trend Graph Item Properties dialogue. Then click the ‘Trend Graph Variable’ tab.  The fields are: 

13.43.1   Variable 
Group FB Name Enter the tagname of the relevant GROUP LIN function block in this box, or click the 

'Browse…' button to locate the LIN function block name in the associated LIN Database if 
needed (see next). 

 

NOTE 

The Editor auto-validates entries, a red cross  indicating an invalid field; a green tick  a valid field. 
 
Browse… Click this button to pop up a LIN Database Browser window.  This lets you to select the 

required GROUP LIN function block tagname from the LIN Database associated with the 
Page Set (via the Page Set Properties dialogue), or the New Page Set dialogue.) 

13.43.2   Channel selection 
Channel In this box, enter up to six valid channel numbers separated by commas (no spaces) – e.g. 

1,3,4,5,7,16. These channels will be trended at runtime in the selected item. 

13.43.3   OK 
Accepts the parameter changes and closes the dialogue. 

13.43.4   Apply 
Accepts the changes, and allows further configuration.   
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13.43.5   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 

13.44   VARIABLE 
The types of Variable that can be used are:  

LIN Database field names. Example:  PIC_004.PV 

LIN Database Bitfields. Example:  Dig_A.Out; 

Aliases. Example:  Dig_A.Out; 

LIN Sequence step variables. Example:  END_STEP.X 

13.44.1   Variable Properties page 

 
The Properties page  is accessed by: 

1. Double clicking on the relevant page item  

2. Right-clicking on the item and selecting 'Properties...' in the resulting pop-up (context) menu, 

3. Via Properties/Page item... in the Edit menu 

4  Using the shortcut <Alt> + <Enter>. 
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13.44.2   Variable Tab 
This allows the user to select a link between a LIN Database, or Instrument  Variable and the selected Page 
Item, so that it can be displayed dynamically (that is, the item reacts in real-time to the value of the variable). 

The fields are, 

VARIABLE 
LIN Variable This radio button is used to link the Page Item to a LIN Database Variable.  The 'Browse…' 

button can be used to display the LIN Database Browser to assist in locating the required 
Variable. 

Instrument Variable  
This radio button is used to link the Page Item to an Instrument Variable. 

Name This field is used to identify the name of the Variable to be linked. The Variable Type (e.g. 
Integer) is automatically entered from the list to the right of the ‘Name’ box. Standard LIN 
formats should be used for the Variable name, i.e.' blockname.fieldname' (e.g. TIC001.PV) or 
'blockname.bitfield.bit' (e.g. Dig_A.Out.Bit3). 

Browse... Clicking on this button opens the LIN database browser as an aid to locating the relevant 
variable. 

NOTE 

The Editor auto-validates entries, a red cross  indicating an invalid field; a green tick  a valid field. 

  

DATA ENTRY 

For those instruments which support the facility, if a variable is selected which takes a file name as its value, the 
'Data Entry' configuration area appears. 
Offer file picklist when editing this variable 
 If this is enabled (ticked), then all the files on the instrument which match the search string 

defined in the 'Filter' field (below), appear in a drop-down list at the instrument's operator 
interface, when the associated text is touched.  

Filter Allows the user to define the types of file which are to appear in the drop-down list on the 
user screen. Multiple filters can be specified separated by commas.  The '?' and '*' wildcards 
can be used in the filter. 

13.44.3   OK 
Accepts the parameter changes and closes the dialogue. 

13.44.4   Apply 
Accepts the changes, and allows further configuration. 

13.44.5   Cancel 
Closes the dialogue without making any changes to the Page Item Properties. 
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14 DEFAULT PASSWORD 

The default Password is, 

kjsneckjn 
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